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Understanding Detailed Object Functions

You can use the Cisco Mobile Wireless Transport Manager (MWTM) to view detailed information about 
any discovered MWTM object, including its associated objects, status, notes, alarms and events, and so 
on.

To display detailed information for an object:

Step 1 In the navigation tree of the MWTM main window, click the turner  beside a view.

Step 2 Click a node. The Details tab appears in the content pane (see Viewing Details, page 8-12).

This chapter contains:

• Viewing the Right-Click Menu for an Object, page 8-3

• Deploying a File Associated with an ITP Node or Signaling Point, page 8-9

• Viewing Management Interfaces and Physical Folders, page 8-9

• Viewing Status Contributors, page 8-10

• Viewing Details, page 8-12

• Viewing Troubleshooting, page 8-43

• Viewing Alarms and Recent Events, page 8-45

• Using Provisioning, page 8-46

• Editing SNMP IP Addresses for a Node, page 8-51

• Polling a Node, page 8-53

• Allowing and Disallowing Trap Processing for a Node, page 8-56

• Viewing Real-Time Data, page 8-56

• Viewing ITP Linkset Access Lists, page 8-123

• Viewing Data Specific for ITP Signaling Points, page 8-123

• Viewing RAN Shorthauls, page 8-140

• Creating Virtual RAN Backhauls, page 8-140

Note For details on viewing notes, see Viewing Notes, page 6-39.
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The MWTM displays detailed tabular information in the content area for the chosen object. Tabs will 
vary depending on the chosen object.

For example, if you choose an ITP node, the ITP Node table for that node displays as shown in 
Figure 8-1. 

Figure 8-1 Example—ITP Node Tabs

Note The tabs automatically reflect updates for the object from the MWTM server.
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Viewing the Right-Click Menu for an Object
Right-clicking on any object in an MWTM view, summary list, or topology map provides you with 
numerous menu options.

Example:

To see the right-click menu for a node, select a node in the navigation tree and right-click the mouse 
button. 

These right-click menu options might be available on a given MWTM object:

Menu Command Description

Show In New Window Opens the Details window for the chosen object in a new 
window.

Edit > Properties Opens the Edit Properties dialog box for the chosen node 
or ITP signaling point.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level Power 
User (level 2) and higher.

Edit > Notes Opens the Edit Notes dialog box for the chosen object.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level Power 
User (level 2) and higher.

Edit > SNMP IP Addresses Opens the Edit SNMP IP Addresses dialog box for the 
chosen node.

This option is dimmed if the chosen node has no associated 
SNMP IP addresses.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level 
Network Administrator (level 4) and higher.

Edit > Route Table 
(ITP signaling points only)

Opens the Route Table dialog box, using a route table from 
the signaling point.

This option is not available if the node associated with 
chosen signaling point is in Unknown or Unmanaged 
status.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level 
Network Administrator (level 4) and higher.

Clear Event Icon Deletes the event icon from MWTM displays for the 
chosen object, for this MWTM client only. The MWTM 
does not delete the actual events, but deletes only the event 
icon for the chosen object for this MWTM client.

This option is dimmed if the chosen object has no 
associated event icon.
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Delete Deletes the currently chosen object from the MWTM 
database. The MWTM displays the Confirm Deletion 
dialog box. To:

• Delete the chosen object, click Yes. The MWTM 
deletes the object from the MWTM database and 
closes the Confirm Deletion dialog box.

• Retain the chosen object, click No. The MWTM 
retains the object in the MWTM database and closes 
the Confirm Deletion dialog box.

Note (ITP only) If you delete all linksets to an 
Unmanaged node, the MWTM does not 
automatically delete the node. Instead, you must 
manually delete the node. See Deleting Objects, 
page 6-40 for more information.

• Prevent the MWTM from displaying the Confirm 
Deletion dialog box, check the Do not show this again 
check box.

Note If you check the Do not show this again check box, 
and later you decide you want the MWTM to begin 
displaying the Confirm Deletion dialog box again, 
you must check the Confirm Deletions check box in 
the General GUI settings in the Preferences 
window. For more information, see the description 
of the Confirm Deletions check box in Startup/Exit 
Settings, page 5-4.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level 
Network Administrator (level 4) and higher.

Go to > Object Navigates to the parent or peer (if applicable) window(s) 
for the chosen object.

Back > List of windows Navigates back to a window viewed in this session.

The MWTM maintains a list of up to 10 Back windows.

Forward > List of windows Navigates forward to a window viewed in this session.

The MWTM maintains a list of up to 10 Forward windows.

Show Peer (only for RAN Backhauls and 
RAN Shorthauls)

Shows the peer of the RAN backhaul or shorthaul that you 
select in the right pane. 

View > Status Contributors Displays the Status Contributors pane for the chosen 
object. Objects in this pane contribute to the status of the 
chosen object.

View > Details Displays the Details pane for the chosen object.

View > Notes Displays the Notes pane for the chosen object.

If no notes are associated with the chosen object, this 
option is dimmed.

Menu Command Description
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View > Troubleshooting Displays the Troubleshooting pane for the chosen object. 

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level 
Network Operator (level 3) and higher.

View > Recent Events Displays the Recent Events pane for the chosen object and 
any associated network objects.

View > Alarms Displays the Alarms pane for the chosen view.

View > Real-Time Data and Charts Displays the MWTM Real-Time Statistics window for the 
chosen object.

This option is not available if the object has no real-time 
charts or if the object status is Unknown or Unmanaged.

View > Center in Topo Opens the topology window and displays the object in the 
center of the topology map.

View > Advanced Details (Web) Opens the MWTM web client to display the Statistics tab 
for the selected object. This option appears only for those 
objects that have advanced details.

Archived Events > Status Changes Displays the archived status changes in a web browser. 

Archived Events > SNMP Traps Displays the archived SNMP traps in a web browser.

Archived Events > Status Changes and 
SNMP Traps

Displays both the archived status changes and archived 
SNMP traps in a web browser.

Ignore Ignores the chosen object at the next polling cycle.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level Power 
User (level 2) and higher.

Unignore Stops ignoring the chosen object at the next polling cycle.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level Power 
User (level 2) and higher.

Performance History

(RAN-O backhauls and shorthauls only)

Displays historical performance charts for the chosen 
RAN-O backhaul or shorthaul in a web browser.

Error History

(RAN-O backhauls and shorthauls only)

Displays historical error charts for the chosen RAN-O 
backhaul or shorthaul in a web browser.

Create Virtual RAN Backhaul

(RAN-O backhauls only)

Opens the Virtual RAN Backhaul Editor. For details, see 
Creating Virtual RAN Backhauls, page 8-140.

Drill-Down > List of windows Opens a specific tab for the chosen object. Tabs listed start 
a poller.

This option is not available if the node is in Unknown or 
Unmanaged status.

Menu Command Description
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Latest Reports Opens the latest reports for the object in a Web browser. 
For details on reports, see Chapter 12, “Managing 
Reports.”

This option is not available if the node is in Unknown or 
Unmanaged status.

Provision Opens the web interface to the Provision tab of the chosen 
object (see Using the Provisioning Wizard, page 8-50). 

Launch Use it to launch:

• CiscoView

• Device Center

Note You must first integrate these applications with the 
MWTM. See Integrating the MWTM with 
CiscoWorks, page 5-39.

Menu Command Description
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These menu options are available on nodes or ITP signaling points:

Node > Home Page Displays the home page of the node in a new web browser 
window. 

This option does not appear in the right-click menu for 
Cisco Optical Networking System (ONS) nodes or nodes 
that are unknown.

For a Cisco Data for Telecommunications (CDT) node, this 
option launches the CDT login web page.

Node > Launch CTC (ONS nodes only) Launches the Cisco Transport Controller (CTC) for 
managing ONS nodes. For more information about using 
the CTC, refer to the CTC Launcher Application Guide 
(http://www.cisco.com/en/US/products/hw/optical/ps2006
/prod_configuration_guide09186a008051ea52.html).

This option appears only for ONS nodes.

Node > Connect To Links to the node. 

This option is dimmed if the chosen node has no IP 
addresses.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level 
Network Operator (level 3) and higher.

Poll Node > Normal Poll Polls all chosen nodes or ITP signaling points, retaining all 
currently known objects.

Normal Poll retains all objects associated with polled 
nodes or signaling points, even objects that have been 
deleted and are, therefore, in Unknown status.

This option is dimmed if the chosen node has no IP 
addresses.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level 
Network Operator (level 3) and higher.

Poll Node > Clean Poll Polls all chosen nodes or ITP signaling points and removes 
any Unknown network objects after the completion of the 
poll.

Clean Poll removes all network objects from the node or 
signaling point at the completion of the poll.

This option is dimmed if the chosen node has no IP 
addresses.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level 
Network Operator (level 3) and higher.

Menu Command Description
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Allow Trap Processing Enables the MWTM to process traps from the chosen node. 
This is the default setting.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level Power 
User (level 4) and higher.

Disallow Trap Processing Prevents the MWTM from processing traps from the 
chosen node.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level Power 
User (level 4) and higher.

Unmanage Labels the chosen node or signaling point Unmanaged.

Note If you change a node to the Unmanaged status, the 
MWTM removes adjacent legacy nodes from the 
topology map.

You cannot label a node or signaling point Unmanaged if it 
has a Node Type of Unknown. If you select a node or 
signaling point with a Node Type of Unknown, then this 
menu option is dimmed and cannot be chosen.

This option is dimmed if the chosen node has no IP 
addresses.

Events for unmanaged objects will continue to appear in 
the Events window. To suppress events for unmanaged 
objects, set this option using an event filter (Setting an 
Alarm or Event Filter, page 9-18).

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level 
Network Administrator (level 4) and higher.

Manage Removes the Unmanaged status from the chosen node or 
signaling point.

Note If you change a node to the Managed status, the 
MWTM adds adjacent legacy nodes back to the 
topology map.

You cannot remove the Unmanaged status from a node with 
a Node Type of Unknown. If you select a node with a Node 
Type of Unknown, then this menu option is dimmed.

This option is dimmed if the chosen node has no IP 
addresses.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level 
Network Administrator (level 4) and higher.

Menu Command Description
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Deploying a File Associated with an ITP Node or Signaling Point
You use the MWTM to deploy a GTT file or route table file associated with an ITP node or signaling 
point. To do so, right-click the ITP node or signaling point in a window, then choose Deploy Object > 
From Archive or From File in the right-click menu. The MWTM launches the Deployment Wizard for 
the chosen ITP node or signaling point. See Deploying a Route Table File, page 13-13 and Deploying a 
GTT File, page 14-37 for more information.

Viewing Management Interfaces and Physical Folders
ITP, IPRAN, and mSEF nodes can contain: 

– Management Interfaces—A folder that contains a list of interfaces that the MWTM uses to 
manage the node.

– Physical—A folder that contains a list of the physical interfaces and ONS cards that belong to 
the node. Slot numbers precede ONS card objects (for example, 15 - RAN_SVC or 02 - E1-42).

Figure 8-2 Management Interfaces and Physical Folders

All objects in the Physical folder are ignored unless they also appear outside of the Physical folder. The 
status of Physical folder-only objects do not contribute to the status of the parent node. These objects 
also do not appear in the Active Alarms list, but they do appear in the Event History. You can un-ignore 
the Physical folder, then re-ignore the objects you do not want to monitor. For more information, see 
Why are objects in the Physical folder ignored?, page C-8).

Exclude from View Excludes the chosen node or signaling point from the 
current view. See Creating a New View, page 7-8 for more 
information about excluding objects.

The MWTM removes excluded objects and their associated 
objects from the topology map (see Excluded Objects Tab, 
page 10-10).

Deploy Object > From Archive 
(ITP only)

Launches the Deployment Wizard for the chosen node or 
ITP signaling point. See Deploying a File Associated with 
an ITP Node or Signaling Point, page 8-9 for more 
information about deploying to nodes or ITP signaling 
points.

Deploy Object > From File 
(ITP only)

Launches the Deployment Wizard for the chosen node or 
ITP signaling point. See Deploying a File Associated with 
an ITP Node or Signaling Point, page 8-9 for more 
information about deploying to nodes or ITP signaling 
points.

Menu Command Description
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Viewing Status Contributors
The Status Contributors section displays information about conditions that contribute to the overall 
status of the chosen object. To view the Status Contributors section, select an object in the navigation 
tree and click the Status Contributors tab in the right pane.

The content pane lists all objects contributing to the status of the object you have chosen in the 
navigation tree. A tooltip in the content pane lists the fully qualified domain name (FQDN) for the 
object.

To see which object types pertain to the Status Contributors tab, see Appendix A, “Client Object Map 
Reference.” If the object does not have any associated objects, the Status Contributors tab will not 
appear.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns except Internal ID.

For detailed information on working in tables, see Navigating Table Columns, page 5-24.

The Status Contributors table contains:

Column Description

Internal ID Internal ID of the object. The internal ID is a unique ID for every object, 
assigned by the MWTM for its own internal use. It can also be useful when 
the TAC is debugging problems.

Name Name of the object.

Object Type Type of network object.

Ignored Indicates whether the object should be included when aggregating and 
displaying MWTM status information:

• Uncheck the check box to include the object. This is the default setting.

• Check the check box to exclude the object.

This field can be edited by users with authentication level Power User 
(level 2) and higher.

Notes Indicates whether a note is associated with the object.

Events Indicates whether the object has an associated recent event. (Even if the 
server purges all of the events associated with the object, the MWTM 
continues to display the event icon in this field.) To:

• Delete the event icon (orange triangle) from MWTM displays for a 
specific object, select the object and click the icon.

• Delete the event icon from MWTM displays for all objects, choose Edit 
> Clear All Events from the MWTM main menu.

Note During Discovery, the MWTM might flag objects with an event icon. 
If the event icons are too distracting, use the Edit > Clear All Events 
menu option to remove them.

Last Status Change Date and time that the status of the object last changed.

Alarm Severity Indicates the alarm severity of the object. See Chapter 9, “Managing Alarms 
and Events.”
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Status Current status of the object. Possible values are:

Active

Blocked

Discovering

Down 

Failed 

Inactive 

Inhibited

InhibitLoc 

InhibitRem 

None 

Not Present

Column Description
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Viewing Details
The Details section displays information such as naming and status details for the chosen object.

To view the Details section, select a view in the navigation tree, select an object, then click the Details 
tab in the right pane. 

Note If the chosen object is a link, linkset, signaling gateway-mated pair, RAN-O backhaul or shorthaul, the 
Details tab displays both peers of the chosen object in adjacent panes for easy comparison.

The Details tab contains these sections (in alphabetical order):

Status (continued) Old Unmanaged 

Pending 

Polling 

Shutdown

Unavailable 

Unknown 

Unmanaged 

Waiting 

Warning 

For detailed definitions of each status, see Status Definitions for Signaling 
Gateway Mated Pairs, page E-7.

Status Reason Reason for the current status of the object.

For a full list of possible reasons, see the stateReasons.html file. If:

• You installed the MWTM in the default directory, /opt, then the file is 
located at /opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• You installed the MWTM in a different directory, then the help directory 
and file are in that directory.

If the cell is too small to show all of the status reason, place the cursor over 
the cell to see the full text in a tooltip.

The MWTM lists status reasons in order of decreasing magnitude. If two or 
more reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network 
data and begin a discovery of the network. If the status reason remains 
Unsupported Configuration, enter the mwtm clean command to restore the 
MWTM server to a state that would exist after a new installation of the 
MWTM, excluding the log files, which the MWTM retains. To also remove 
the log files, enter the mwtm cleanall command. For more information on 
the use of these commands, see the Command Reference, page B-1.

Column Description
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Tip If the pair of a link, linkset, or signaling gateway-mated pair is Unknown, and if the peer of a backhaul 
or shorthaul is Unknown, Unknown appears for the pair or peer fields in the Details tab.

Section Applicable Object(s) Applicable Network Type(s)

Address Information Interfaces All networks

Advanced Details (Web) Nodes BWG, CSG2, HA, and GGSNs 
on card

Association Information Application Servers ITP only

Bandwidth Information Backhauls RAN-O only

Capability Point Code Signaling Points ITP only

Description Linksets, Signaling Points

Descriptive Information Cards, Nodes All networks

General Information Application Servers, Application 
Server Process Associations, 
Interfaces, Linksets, Shorthauls

Interface Information Links, Signaling Gateway Mated 
Pairs

ITP only

IP Addresses for SNMP
or
IP Addresses Not for SNMP

Nodes All networks

Links Information Linksets ITP only

Local IP Address Information Application Server Processes, 
Application Server Process 
Associations, Links, Signaling 
Gateway Mated Pairs

Naming Information All objects All networks

Point Code Signaling Points ITP only

Polling Information Nodes All networks

Protection Information Cards, ONS Nodes RAN-O only

QoS Information Signaling Points ITP only

RAN Information Interfaces, Shorthauls RAN-O only

Remote IP Address Information Application Server Process 
Associations, Links, Signaling 
Gateway Mated Pairs

ITP only

Status Information All objects All networks

Threshold Information (RAN-O 
Only)

Backhauls, Nodes RAN-O only

Uptime Information Nodes All networks
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Address Information
The Address Information section for interfaces contains:

Advanced Details (Web)
The Advanced Details (Web) link appears in the MWTM client and launches the MWTM web interface 
to display the Statistics tab for the selected node. The Advanced Details (Web) link enables you to access 
advanced statistics that are available only for these nodes:

• CSG2 (see Displaying CSG2 Real-Time Statistics, page 11-44)

• BWG (see Displaying BWG Real-Time Statistics, page 11-49)

• HA (see Displaying HA Real-Time Statistics, page 11-62)

• GGSN on a SAMI card (see Displaying GGSN Real-Time Statistics, page 11-65)

Association Information
The Association Information section for ITP application servers contains:

Field Description

IP Address List of IP addresses that are assigned to the interface.

Field Description

Number of ASPAs Number of application server process associations that are associated 
with this application server.

Number of Active ASPAs Number of active application server process associations that are 
associated with this application server.
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Bandwidth Information
The Bandwidth Information section for RAN-O backhauls (and virtual backhauls) contains:

Capability Point Code
The Capability Point Code section for ITP signaling points contains:

Field Description

User Send Bandwidth 
(bits/sec)

User Receive Bandwidth 
(bits/sec)

Bandwidth that the user specifies for the backhaul. Send and receive 
bandwidth values will be different if the interface is asymmetrical. By 
default, the user bandwidth is the same as the system bandwidth.

Note When you change the User Bandwidth (see Editing Properties 
for a RAN-O Backhaul, page 6-36), you are changing the scale 
of the Y axis of the backhaul real-time chart in the Performance 
tab (see Viewing Backhaul Performance Data, page 8-111). The 
X and Y values of the data do not change. The threshold ranges 
resize because they are percentages of User Bandwidth.

System Send Bandwidth 
(bits/sec)

System Receive Bandwidth 
(bits/sec)

Bandwidth that the system specifies (as defined on the node) for the 
backhaul. Send and receive bandwidth values will be different if the 
interface is asymmetrical. You cannot edit this field.

Column Description

Point Code Capability point code of the signaling point.

Variant SS7 protocol variant. Valid variants are:

• ANSI

• China

• ITU

• NTT

• TTC
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Description
The Description section contains a description of the ITP signaling point or linkset. If the signaling point 
or linkset has no description, this section is blank. If the linkset is unknown, Unknown appears in the 
Description section.

Descriptive Information
The Descriptive Information section for nodes and ONS cards contains:

General Information
The General Information section applies to these objects:

• Interfaces, page 8-17

• ITP Application Servers, page 8-17

• ITP Linksets, page 8-18

Network Indicator Determines the type of call. Valid values are:

• National—National-bound call. The MWTM routes national calls 
through the national network.

• NationalSpare—National-bound call, used in countries in which more 
than one carrier can share a point code. In those countries, the Network 
Indicator differentiates networks.

• International—International-bound call. The MWTM forwards 
international-bound calls to an STP pair that acts as an international 
gateway.

• InternationalSpare—International-bound call, used in countries in 
which more than one carrier can share a point code. In those countries, 
the Network Indicator differentiates networks.

Network Name Name of the network associated with the signaling point.

Column Description

Field Description

Software 
Description

Comprehensive information about the software that is installed on the node.

Software Version Version of software (for example, the ONS package or IOS version) that is 
installed on the node.

Description Full description of the ONS card (for example, RAN_SVC_LINE_CARD).

Hardware Version Version of the hardware of the ONS card (for example, VID=000, HwRev=29).

Firmware Version Version of the firmware on the ONS card, if applicable (for example, 12.2(24)St).
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Interfaces

The General Information section for interfaces contains:

ITP Application Servers

The General Information section for ITP application servers contains:

Field Description

Maximum Packet 
Size

Maximum packet size on the interface in bytes.

Send Speed 
(bits/sec)

Interface send speed in bits per second.

Receive Speed 
(bits/sec)

Interface receive speed in bits per second.

Field Description

Protocol Protocol associated with the application server. Possible values are:

• M3UA—MTP3-User Adaptation.

• SUA—SCCP-User Adaptation.

QoS Quality of service (QoS) class of the application server.

Routing Key Routing key associated with the application server. The routing key is the 
value that determines the routing decisions that the application server makes.

Traffic Mode Method by which the application server forwards requests to its active 
application server processes. Possible values are:

• overRide—One application server process takes over all traffic for the 
application server, possibly overriding any currently active 
application server process in the application server.

• broadcast—Every active application server process receives the same 
message.

• loadBind—Each application server process shares in the traffic 
distribution with every other currently active application server 
process, based on application server process bindings.

• loadRndRobin—Each application server process shares in the traffic 
distribution with every other currently active application server 
process, using a round-robin algorithm.

• undefined—The traffic mode is not defined. The first application 
server process that becomes active defines the traffic mode.
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ITP Linksets

The General Information section for ITP linksets contains:

Interface Information
The Interface Information section for ITP links and application server process associations contains:

Field Description

Linkset Type Type of linkset, which the MWTM determines by examining the links 
defined in the linkset. Possible linkset types are:

• HSL—The links in this linkset use the SS7-over-ATM (Asynchronous 
Transfer Mode) high-speed protocol.

• SCTPIP—The links in this linkset use the Stream Control Transmission 
Protocol (SCTP) IP transport protocol.

• Serial—The links in this linkset use the serial SS7 signaling protocol.

• Mixed—The links in this linkset are of two or more types. (This 
configuration is not recommended.)

• Virtual—The links in this linkset are virtual links, which connect 
signaling point instances running on the same node. The MWTM does 
not poll virtual linksets, nor does it display real-time data or accounting 
statistics for virtual linksets.

Note Prior to IOS release 12.2(23)SW1, the user manually created virtual 
linksets on multi-instance nodes. In and after that release, the system 
automatically creates virtual linksets.

• Other—No links have been defined for this linkset.

Inbound ACL Inbound IP access control list (ACL) number for the linkset.

If no inbound ACL exists for the linkset, this field displays 0.

If the linkset is a Virtual linkset, this field displays N/A.

Outbound ACL Outbound ACL number for the linkset.

If no outbound ACL exists for the linkset, this field displays 0.

If the linkset is a Virtual linkset, this field displays N/A.

Field Description

Interface Name (HSL, Serial, and Virtual links only) Name of the interface.

Interface Index (HSL, Serial, and Virtual links only) Index into the SNMP interface 
table.

QoS (SCTP links only) Quality of service (QoS) class of the link.

Configured Local Port (SCTP links only) Local port for which the link was configured.

Local Port (SCTP links only) If the link is active, local port that the link is currently 
using. If the link is not active, 0 appears.
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IP Addresses for SNMP
The IP Addresses for SNMP section for nodes contains:

If there are no IP addresses defined for the node that are intended for SNMP, this field displays the 
description:

There are no other IP addresses defined for this node.

IP Addresses Not for SNMP
The IP Addresses Not for SNMP section for nodes contains:

If no IP addresses are defined for the node that are not intended for SNMP, this field displays the 
description:

There are no other IP addresses defined for this node.

Configured Remote Port (SCTP links only) Remote port for which the link was configured.

Actual Remote Port (SCTP links only) If the link is active, remote port that the link is 
currently using. If the link is not active, 0 appears.

Protocol Protocol associated with the application server process association. 
Possible values are:

• M3UA—MTP3-User Adaptation.

• SUA—SCCP-User Adaptation.

Field Description

Field Description

IP Address IP addresses associated with this node, including the primary SNMP 
address and all backup IP addresses, that are intended for SNMP.

Last Regular Poll Time Date and time of the last full poll of the node.

If the IP address has never been polled, the MWTM displays the 
description Never Polled.

SNMP Pollable Whether or not the IP address is used for SNMP polling.

Field Description

IP Address IP addresses associated with this node that are not intended for SNMP.
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Links Information
The Links Information section for ITP linksets contains:

Local IP Address Information
The Local IP Address Information section for ITP application server processes, application server 
process associations, SCTP links, and signaling gateway mated pairs contains:

Field Description

Links Total number of links in the linkset.

Active Links Number of links in the linkset that are Active.

Congested Links Number of links in the linkset that are Congested.

Field Description

IP Address Local IP address that the object is using, or the primary IP address that is 
configured for the object, or both.

The primary IP address is the first CS7 local IP address you configure in the 
node. For example, if you configure these IP addresses in the node:

cs7 local-peer 4180
local-ip 128.3.0.77
local-ip 128.3.0.254

then the MWTM uses 128.3.0.77 as the primary IP address. If someone deletes 
this IP address from the node configuration, or adds a new IP address to the 
beginning of the list, the MWTM detects the change and automatically updates 
this field to reflect the new primary IP address.

Interface Name Name of the interface to which the IP address is assigned. If the object has no 
interface name, this field is blank.

Status Current status of the IP address. Possible values are:

Active—The IP address is currently fully functional.

Inactive—The IP address is not currently functional.

Cfg Indicates whether this local IP address was configured for the object. Possible 
values are:

• Yes—This is the configured local IP address, and the object is currently 
using it.

• (blank)—This is not the configured local IP address.

Actual Indicates whether this local IP address is currently being used by the object. 
Possible values are:

• Yes—The object is currently using this IP address.

• (blank)—The object is not using this IP address.
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Naming Information
The Naming Information section applies to these objects:

• Nodes, page 8-21

• Cards, page 8-22

• Interfaces, page 8-22 (including RAN backhauls and shorthauls)

• ITP Application Servers, page 8-23

• ITP Application Server Processes, page 8-23

• ITP Application Server Process Associations, page 8-23

• ITP Links, page 8-23

• ITP Linksets, page 8-24

• ITP Signaling Gateway-Mated Pairs, page 8-24

• ITP Signaling Points, page 8-24

Nodes

The Naming Information section for nodes contains:

Field Description

Display Name Name of the node.

IP Address or 
DNS Hostname

IP address or DNS name of the node, as the MWTM discovered it. However, if you 
modified your preferences to identify nodes by their IP addresses, then this is 
method of node identification in this field. For more information, see Node Name 
Settings, page 5-5.

Node Type Type of node. See Nodes Table, page 6-5, for a list of the available node types.

Feature Primary function performed by the node type. See Nodes Table, page 6-5, for a list 
of the available features.

Chassis Type 
(ONS only)

Description of the chassis hardware type (for example, ONS 15454 SDH ETSI). 

Note This field appears only for the ONS chassis.

Serial Number Serial number of the node.

CLLI Code (ITP 
only)

COMMON LANGUAGE Location Identification Code for the node. A CLLI code 
is a standardized 11-character identifier that uniquely identifies the geographic 
location of the node. If the node has no CLLI code configured, this field is blank.

SNMP Access 
(RAN-O only)

Indicates the type of SNMP access:

• In-band—Access is through the backhaul interface (cell site).

• Out of band—Access is external to the backhaul interface (aggregation site).

• Undefined—Access is not defined.

Location (RAN-O 
only)

The location of the SNMP settings, whether at the cell site (BSC) or the 
aggregation node site (BTS). 1
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Cards

The Naming Information section for ONS cards contains:

Interfaces

The Naming Information section for interfaces (which includes RAN backhaul and shorthaul interfaces) 
contains:

Field Description

Name Name of the card.

Card Type1

1. See the Cisco ONS 15454 Product Overview for information about ONS cards: 
http://www.cisco.com/univercd/cc/td/doc/product/ong/15400/45431po.htm

Type of card. Card types for ONS include:

• TCC—Control

• E1—Ethernet

• STM1—Synchronous Transport Module

• DS1—Digital Signal

• OC3—Optical

• XC—Cross-connect

Card Type 
(continued)

• RAN_SVC—RAN Service

• ALM_PWR—Alarm and Power

• CRFT_TMG—Craft Terminal

• AICI—Alarm Interface Controller

Model Name Model name of the card (for example, PartNum=800-26651-01).

Slot Number Slot number of the card in the ONS chassis.

Serial Number Serial number of the card.

Field Description

Name Name of the interface.

Node Name of the node to which the interface belongs.

Physical Address Physical address of the interface.

Interface Index Interface index number.

Interface Type Interface type.

RAN Connection To RAN connection that is associated with the interface.

Note Not visible for RAN backhauls.

Virtual RAN Backhaul Whether the RAN backhaul is a virtual backhaul. For more information 
about virtual RAN backhauls, see Creating Virtual RAN Backhauls, 
page 8-140.

Note Visible only for RAN backhauls.
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ITP Application Servers

The Naming Information section for ITP application servers contains:

ITP Application Server Processes

The Naming Information section for ITP application server processes contains:

ITP Application Server Process Associations

The Naming Information section for ITP application server process associations contains:

ITP Links

The Naming Information section for ITP links contains:

Field Description

Name Name of the application server.

Node Name of the node associated with the application server.

Signaling Point Name of the signaling point associated with the application server.

Field Description

Name Name of the application server process.

Node Name of the node associated with the application server process.

Local Port Local port number that the application server process is currently using.

Field Description

Name Name of the application server process association.

Node Name of the node associated with the application server process association.

Signaling Point Name of the signaling point associated with the application server process 
association.

Application Server Name of the application server associated with the application server process 
association.

Application Server 
Process

Name of the application server process associated with the application server 
process association.

Field Description

Node Name of the node associated with the link.

Signaling Point Name of the signaling point associated with the link.

Linkset Name of the linkset associated with the link.
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ITP Linksets

The Naming Information section for ITP linksets contains:

ITP Signaling Gateway-Mated Pairs

The Naming Information section for ITP signaling gateway-mated pairs contains:

ITP Signaling Points

The Naming Information section for ITP signaling points contains:

SLC Signaling link code (SLC) ID for the link.

Type Type of link. Possible link types are:

• HSL—The link uses the SS7-over-ATM (Asynchronous Transfer Mode) 
high-speed protocol.

• SCTPIP—The link uses the Stream Control Transmission Protocol (SCTP) IP 
transport protocol.

• Serial—The link uses the serial SS7 signaling protocol.

• Virtual—The link is a virtual link, which connects signaling point instances 
running on the same node. The MWTM does not poll virtual links, nor does it 
display real-time data or accounting statistics for virtual links.

Field Description

Field Description

Name Name of the linkset.

Node Node associated with the linkset.

Signaling Point Signaling point associated with the linkset.

Local Point Code Point code of the primary signaling point for the linkset.

Adj Point Code Point code of the adjacent signaling point for the linkset.

Field Description

Name Name of the signaling gateway-mated pair.

Node Name of the node associated with the signaling gateway-mated pair.

Is Passive Indicates whether the signaling gateway-mated pair can initiate the connection to 
the mate:

• Yes—The signaling gateway-mated pair is passive, and cannot initiate the 
connection to the mate.

• No—The signaling gateway-mated pair is not passive, and can initiate the 
connection to the mate.
8-24
User Guide for the Cisco Mobile Wireless Transport Manager 6.1

OL-9118-01



 

Chapter 8      Understanding Detailed Object Functions
  Viewing Details
Point Code
The Point Code section for ITP signaling points contains:

Column Description

Name Name of the signaling point.

Node Name of the node associated with the signaling point.

Network Name Name of the network associated with the signaling point.

Instance Number Number of the instance associated with the signaling point.

Column Description

Point Code Primary and secondary point codes of the signaling point.

Variant SS7 protocol variant. Valid variants are:

• ANSI

• China

• ITU

• NTT

• TTC

Network Indicator Determines the type of call. Valid values are:

• National—National-bound call. The MWTM routes national calls 
through the national network.

• NationalSpare—National-bound call, used in countries in which more 
than one carrier can share a point code. In those countries, the Network 
Indicator differentiates networks.

• International—International-bound call. The MWTM forwards 
international-bound calls to an STP pair that acts as an international 
gateway.

• InternationalSpare—International-bound call, used in countries in 
which more than one carrier can share a point code. In those countries, 
the Network Indicator differentiates networks

Network Name Name of the network associated with the signaling point.
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Polling Information
The Polling Information section for nodes contains:

Field Description

Process Traps Indicates whether traps are processed. To change this setting, check 
or uncheck the check box in the Process Traps column of the Nodes 
table.

Trap Polling Indicates whether trap polling is enabled or not. 

For IPRAN or mSEF nodes, if you want to:

• Enable trap polling, set ipran-mib snmp-access to outOfBand 
on the node.

• Disable trap polling, set ipran-mib snmp-access to inBand on 
the node.

Note For information about in-band and out-of-band 
management, see RAN-O Specific FAQs, page C-17.

Report Polling Indicates whether report polling is enabled or not. 

For IPRAN or mSEF nodes, if you want to:

• Enable trap polling, set ipran-mib snmp-access to outOfBand 
on the node.

• Disable trap polling, set ipran-mib snmp-access to inBand on 
the node.

Note For information about in-band and out-of-band 
management, see RAN-O Specific FAQs, page C-17.

First Discovered Date and time that the MWTM first discovered the node.

Last Poll IP Address Last IP address that was polled for this node.

For an unmanaged node, this field is blank.

Last Full Poll Time Date and time of the last full poll of the node for node-related MIBs 
(as opposed to a demand poll for just one associated object’s data).

For a node that is not an ITP, IPRAN, or mSEF node, this field is 
blank.

Last MWTM Poll Response 
(secs)

Time, in seconds, taken by this node to respond to the last MWTM 
poll request.

For a node that is not an ITP, IPRAN, or mSEF node, this field is 
blank.

Avg. MWTM Poll Response 
(secs)

Average time, in seconds, taken by this node to respond to MWTM 
poll requests.

For a node that is not an ITP, IPRAN, or mSEF node, this field is 
blank.
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Protection Information
The Protection Information section for ONS nodes and cards contains:

QoS Information
The QoS Information section for ITP signaling points contains:

RAN Information

Note This subsection appears only for configured RAN interfaces (GSM Abis and UMTS Iub interfaces).

The RAN Information section contains:

Column Description

Card Type The type of card.

This column appears only when you select the ONS node in the navigation tree.

Protected Slot Slot number of the protected card, which is configured for protection.1

1. See the Cisco ONS 15454 Product Overview for information about protection schemes for ONS cards: 
http://www.cisco.com/univercd/cc/td/doc/product/ong/15400/45431po.htm

Protecting Slot Slot number of the card that is protecting one or more cards.

Configured State The configured state of the chosen card: Working or Protecting. The card is 
working normally or protecting another card.

Current State The current state of the chosen card: Active or Standby.

Column Description

QoS Quality of service (QoS) class of the signaling point. Valid QoS classes range from 
1 through 7. ALL indicates that the signaling point accepts all QoS classes.

ToS Type of service (ToS) of the signaling point.

DSCP IP differentiated-services-code-point (DSCP) of the signaling point.

Field Description

Protocol Protocol of the interface (GSM-Abis or UMTS-Iub).

Local IP Address IP address of the local node.

Local Port Local port that the interface uses.

Remote IP Address IP address of the remote (peer) node.

Remote Port Remote port that the interface uses.
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Remote IP Address Information
The Remote IP Address Information section for ITP application server process associations, SCTP links, 
and signaling gateway mated pairs contains:

Uptime Information
The Uptime Information section for nodes contains:

Status Information
The Status Information section applies to these objects:

• Nodes, page 8-29

• Interfaces and Cards, page 8-30 (includes RAN backhauls and shorthauls)

Field Description

IP Address Remote IP address associated with the object.

Type Indicates whether this designated primary IP address is for the object (Primary), or is 
the IP address currently being used by the object (Effective), or both (Primary and 
Effective).

Usually, the same IP address is Primary and Effective. However, if the primary IP 
address is down for some reason, the object uses a different IP address and is labeled 
Effective.

Status Current status of the IP address. Possible values are:

Active—The IP address is currently fully functional.

Inactive—The IP address is not currently functional.

Cfg (12.2(4)MB10 and later) Indicates whether this remote IP address was configured for 
the object. Possible values are:

• Yes—This is the configured remote IP address, and the object is currently using it.

• (blank)—This is not the configured remote IP address.

• N/A—The MWTM cannot determine whether this is the configured remote IP 
address.

For Cisco IOS software releases prior to 12.2(4)MB10, this field always displays N/A.

Actual Indicates whether the object is currently using this remote IP address. Possible values 
are:

• Yes—The object is using the IP address.

• (blank)—The object is not using the IP address.

Field Description

Uptime Time the node is up, in days, hours, minutes, and seconds.

Reboot Reason Reason for the last reboot of the node.
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• ITP Application Servers, page 8-34

• ITP Application Server Processes, page 8-35

• ITP Application Server Process Associations, page 8-36

• ITP Links, page 8-38

• ITP Linksets, page 8-39

• ITP Signaling Gateway Mated Pairs, page 8-40

• ITP Signaling Points, page 8-42

Nodes

The Status Information section for nodes contains:

Field Description

Is Ignored Indicates whether the node is Ignored (that is, whether to include the node 
when aggregating and displaying MWTM status information).

Alarm Severity Indicates the alarm severity of the object. See Chapter 9, “Managing Alarms 
and Events.”

MTP3 Offload (ITP 
only)

Indicates whether MTP3 offload is configured for the node. Possible values 
are:

• Main—The MTP3 management function operates only on the main 
processor.

• Offload—The MTP3 management function operates on the main 
processor and on other available processors.

• N/A—MTP3 offload cannot be determined.

NSO Status (ITP 
only)

Current NSO status of the node, with a color-coded background. Possible 
values are:

Local—NSO is configured and the secondary peer is in the appropriate 
status for failover support.

Local—NSO is configured, but the secondary peer is not in the appropriate 
status for failover support.

None—The node and MIB support NSO, but NSO is not configured on the 
ITP.

N/A—The node and MIB do not support NSO, or the MWTM cannot 
determine the NSO status.
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Interfaces and Cards

The Status Information section for interfaces (including RAN backhaul and shorthaul interfaces) and 
cards contains:

Status Current status of the node. Possible values are:

Active

Discovering

Polling

Unknown

Unmanaged

Waiting

Warning

For detailed definitions of each status, see Status Definitions for Signaling 
Gateway Mated Pairs, page E-7.

Last Status Change Date and time that the status of the node last changed.

Status Reason Reason for the current status of the signaling gateway-mated pair.

For a full list of possible reasons, see the stateReasons.html file. If:

• You installed the MWTM in the default directory, /opt, then the file is in 
the /opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• You installed the MWTM in a different directory, then the help directory 
and file are in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network data 
and begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server 
to a state that would exist after a new installation of the MWTM, excluding the 
log files, which the MWTM retains. To also remove the log files, enter the 
mwtm cleanall command. For more information on the use of these 
commands, see the Command Reference, page B-1.

Field Description

Field Description

Is Ignored Indicates whether the interface or card is Ignored (that is, whether the interface 
or card should be included when aggregating and displaying MWTM status 
information).

Alarm Severity Indicates the alarm severity of the object. See Chapter 9, “Managing Alarms 
and Events.”
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Admin Status Displays the administrative status of the interface. Status can be:

Unknown—Unknown administrative status.

Up—Administratively up.

Shutdown—Administratively down.

Testing—Administrator is testing the interface.

Operational Status Displays the operational status of the interface. Status can be:

Unknown—Unknown operational status.

Up—Interface is up.

Down—Interface is down.

Testing—Interface is in test mode.

Dormant—Interface is dormant.

Not Present—An interface component is missing.

Lower Layer Down—An interface is down because of a lower-layer 
interface.

Connect State
(for GSM Abis)

Displays the connection state of a GSM interface. States can be:

Connected—The node is monitoring local and remote alarm status.

Disconnected—The system ignores the local alarm status. The local 
transmitter on the shorthaul is disabled. Capability messages are transmitted to 
the remote describing the provisioning. The system stays disconnected until 
the remote capabilities are known and the peer state is transitioning to 
connected.

Send Connect—One or more attempts have been made to connect to 
remote peer.

Receive Connect—The local-peer has received a connect request from the 
remote-peer.

Connect Rejected—Connection was rejected.

ACK Connect—The initial connect request was sent and acknowledged by 
remote-peer. The local-peer is now waiting for a connect request from the 
remote-peer.

Check Connect—The local peer has reason to believe its remote peer has 
failed. Additional tests are being processed to verify peer's state.

Field Description
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Connect State 
(for UMTS Iub)

Displays the connection state of a UMTS interface. States can be:

Initialized—The connection is starting initialization.

Starting—The shorthaul interface is administratively active, but the 
backhaul interface is down.

Closed—The backhaul interface is active, but the shorthaul is 
administratively closed.

Stopped—Unable to connect to peer in specified time interval. Additional 
attempts will be tried based on peer request or restart timers.

Closing—Connection closed by administration request.

Stopping—Connection shut down by peer's Term-Request. Will transition 
to stopped state. 

Connect Sent—Connection request sent to peer.

ACK Received—Connection request sent and acknowledgement is 
received from peer. Now waiting for peer's connection request.

ACK Sent—Connection request received and acknowledgement is sent to 
peer. Connection request sent and waiting for peer's acknowledgement.

Open—Connection open and available for traffic.

Local Receive Alarm 
State

Local Transmit Alarm 
State

Remote Receive 
Alarm State

Remote Transmit 
Alarm State

(for UMTS Iub)

Displays alarm states for UMTS Iub interface. States can be:

Remote Alarm—Indicates a problem at the remote end. The remote 
interface in the E1/T1 data stream generates and sends the alarm, and no other 
action is required. 

No Alarm—No alarm is present. 

Local Alarm—Indicates local interface problem. The interface has not 
received synchronization from the GSM node. The node stops transmitting 
backhaul samples.

Received Alarm—Indicates receive problem in the local node. The remote 
node stops transmitting backhaul data and indicates a blue alarm.

Alarm State Unavailable—Indicates the alarm state is not available. This 
state only applies to the remote and occurs when the peer connection is 
inactive.

Field Description
8-32
User Guide for the Cisco Mobile Wireless Transport Manager 6.1

OL-9118-01



 

Chapter 8      Understanding Detailed Object Functions
  Viewing Details
Local State

Remote State

(for GSM Abis)

Displays alarm states for GSM Abis interface. States can be:

Remote Alarm—Indicates a problem at the remote end. The remote 
interface in the E1/T1 data stream is generates and sends the alarm, and no 
other action is required. 

No Alarm—No alarm is present. 

Local Alarm—Indicates local interface problem. The interface has not 
received synchronization from the GSM node. The node stops transmitting 
backhaul samples.

Received Alarm—Indicates receive problem in the local node. The remote 
node stops transmitting backhaul data and indicates a blue alarm.

Alarm State Unavailable—Indicates the alarm state is not available. This 
state only applies to the remote and occurs when the peer connection is 
inactive.

Redundancy State Displays information about the GSM Abis or UMTS Iub interface redundancy 
state. States can be:

Active—Active owner of interface.

Standby—Active owner of interface.

Status Current status of the interface or card. Possible values are:

Active

Discovering

Down

Polling

Unknown

Unmanaged

Waiting

Warning

For detailed definitions of each status, see Status Definitions for Signaling 
Gateway Mated Pairs, page E-7.

Field Description
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ITP Application Servers

The Status Information section for ITP application servers contains:

Last Status Change Date and time of last change to status.

Status Reason Reason for the current status of the interface or card.

For a full list of possible reasons, see the stateReasons.html file. If:

• You installed the MWTM in the default directory, /opt, then the file is in 
the /opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• You installed the MWTM in a different directory, then the help directory 
and file are in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network data 
and begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server 
to a state that would exist after a new installation of the MWTM, excluding the 
log files, which the MWTM retains. To also remove the log files, enter the 
mwtm cleanall command. For more information on the use of these 
commands, see the Command Reference, page B-1.

Field Description

Field Description

Is Ignored Indicates whether the application server is Ignored (that is, whether the application 
server should be included when aggregating and displaying MWTM status 
information).

Alarm Severity Indicates the alarm severity of the object. See Chapter 9, “Managing Alarms and 
Events.”

Mate Status Current status of the application server on the signaling gateway mate. Possible 
values are:

Active

Down

Inactive

Pending

Shutdown

Unknown

Warning

For detailed definitions of each status, see Status Definitions for Application 
Servers, page E-4.
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ITP Application Server Processes

The Status Information section for ITP application server processes contains:

Last Status 
Change

Date and time that the status of the application server last changed.

Status Current status of the application server. Possible values are:

Active

Down

Inactive

Pending

Shutdown

Unknown

Warning

For detailed definitions of each status, see Status Definitions for Application 
Servers, page E-4.

Status Reason Reason for the current status of the signaling gateway-mated pair.

For a full list of possible reasons, see the stateReasons.html file.To:

• You installed the MWTM in the default directory, /opt, then the file is in the 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• You installed the MWTM in a different directory, then the help directory and 
file are in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration and 
enter the mwtm cleandiscover command to delete all current network data and 
begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server to a 
state that would exist after a new installation of the MWTM, excluding the log 
files, which the MWTM retains. To also remove the log files, enter the mwtm 
cleanall command. For more information on the use of these commands, see the 
Command Reference, page B-1.

Field Description

Field Description

Is Ignored Indicates whether the application server process is Ignored (that is, whether to 
include the application server process when aggregating and displaying MWTM 
status information).

Alarm Severity Indicates the alarm severity of the object. See Chapter 9, “Managing Alarms and 
Events.”
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ITP Application Server Process Associations

The Status Information section for ITP application server process associations contains:

Last Status 
Change

Date and time that the status of the application server process last changed.

Status Current status of the application server process. Possible values are:

Unknown

Unmanaged

For detailed definitions of each status, see Status Definitions for Application 
Server Processes, page E-4.

Status Reason Reason for the current status of the signaling gateway-mated pair.

For a full list of possible reasons, see the stateReasons.html file. To:

• You installed the MWTM in the default directory, /opt, then the file is in the 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• You installed the MWTM in a different directory, then the help directory and 
file are in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration and 
enter the mwtm cleandiscover command to delete all current network data and 
begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server to a 
state that would exist after a new installation of the MWTM, excluding the log 
files, which the MWTM retains. To also remove the log files, enter the mwtm 
cleanall command. For more information on the use of these commands, see the 
Command Reference, page B-1.

Field Description

Field Description

Is Ignored Indicates whether the application server process association is Ignored (that is, 
whether the application server process association should be included when 
aggregating and displaying MWTM status information).

Alarm Severity Indicates the alarm severity of the object. See Chapter 9, “Managing Alarms and 
Events.”

Congestion Level Indicates the level of congestion on the application server process association. An 
application server process association is congested if it has too many packets 
waiting to be sent. This condition could be caused by the failure of an element in 
your network.

Possible values for the Congestion Level field are None, indicating no congestion, 
and 1 to 7, indicating levels of congestion from very light (1) to very heavy (7).
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Instance Status Current status of the protocol associated with the application server process, with 
a color-coded background. Possible values are:

Active—The protocol is available.

Shutdown—An administrator has forced the protocol to an unavailable state.

Unknown—The MWTM cannot determine the current status of the protocol.

Status Current status of the application server process association. Possible values are:

Active

Blocked

Down

Inactive

Pending

Shutdown

Unknown

Warning

For detailed definitions of each status, see Status Definitions for Application 
Server Process Associations, page E-4.

Last Status 
Change

Date and time that the status of the application server process association last 
changed.

Status Reason Reason for the current status of the signaling gateway-mated pair.

For a full list of possible reasons, see the stateReasons.html file. To:

• You installed the MWTM in the default directory, /opt, then the file is located 
at /opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• You installed the MWTM in a different directory, then the help directory and 
file are located in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration and 
enter the mwtm cleandiscover command to delete all current network data and 
begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server to a 
state that would exist after a new installation of the MWTM, excluding the log 
files, which the MWTM retains. To also remove the log files, enter the mwtm 
cleanall command. For more information on the use of these commands, see the 
Command Reference, page B-1.

Field Description
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ITP Links

The Status Information section for ITP links contains:

Field Description

Is Ignored Indicates whether the link is Ignored (that is, whether the link should be included 
when aggregating and displaying MWTM status information).

Alarm Severity Indicates the alarm severity of the object. See Chapter 9, “Managing Alarms and 
Events.”

Last Status 
Change

Date and time that the status of the link last changed.

Status Current status of the link. Possible values are:

Active

Blocked

Failed

InhibitLoc

InhibitRem

Shutdown

Unknown

Warning

For detailed definitions of each status, see Status Definitions for Links, page E-6.

Status Reason Reason for the current status of the link.

For a full list of possible reasons, see the stateReasons.html file. To:

• You installed the MWTM in the default directory, /opt, then the file is in the 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• You installed the MWTM in a different directory, then the help directory and 
file are in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration and 
enter the mwtm cleandiscover command to delete all current network data and 
begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server to a 
state that would exist after a new installation of the MWTM, excluding the log 
files, which the MWTM retains. To also remove the log files, enter the mwtm 
cleanall command. For more information on the use of these commands, see the 
Command Reference, page B-1.
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ITP Linksets

The Status Information section for ITP linksets contains:

Congestion Level Indicates the level of congestion on the link. A link is congested if it has too many 
packets waiting to be sent. This condition could be caused by the failure of an 
element in your network.

Possible values for the Congestion Level field are None, indicating no congestion, 
and 1 to 7, indicating levels of congestion from very light (1) to very heavy (7).

Receive 
Utilization

Indicates whether, on average, the link is under its configured receive utilization 
threshold (UnderThreshold) or over the threshold (OverThreshold).

Send Utilization Indicates whether, on average, the link is under its configured send utilization 
threshold (UnderThreshold) or over the threshold (OverThreshold).

Field Description

Field Description

Is Ignored Indicates whether the linkset is ignored (that is, whether the linkset should be 
included when aggregating and displaying MWTM status information).

Alarm Severity Indicates the alarm severity of the object. See Chapter 9, “Managing Alarms 
and Events.”

Last Status Change Date and time that the status of the linkset last changed.
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ITP Signaling Gateway Mated Pairs

The Status Information section for ITP signaling gateway mated pairs contains:

Status Current status of the linkset. Possible values are:

Active

Shutdown

Unavailable

Unknown

Warning

For detailed definitions of each status, see Status Definitions for Linksets, 
page E-7.

Status Reason Reason for the current status of the signaling gateway-mated pair.

For a full list of possible reasons, see the stateReasons.html file. To:

• You installed the MWTM in the default directory, /opt, then the file is in 
the /opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• You installed the MWTM in a different directory, then the help directory 
and file are in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons appear(s) in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration and 
enter the mwtm cleandiscover command to delete all current network data and 
begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server to 
a state that would exist after a new installation of the MWTM, excluding the log 
files, which the MWTM retains. To also remove the log files, enter the mwtm 
cleanall command. For more information on the use of these commands, see the 
Command Reference, page B-1.

Field Description

Field Description

Is Ignored Indicates whether the signaling gateway-mated pair is Ignored (that is, whether the 
signaling gateway-mated pair should be included when aggregating and displaying 
MWTM status information).

Alarm Severity Indicates the alarm severity of the object. See Chapter 9, “Managing Alarms and 
Events.”

Congestion Level Indicates the level of congestion on the signaling gateway-mated pair. A signaling 
gateway-mated pair is congested if it has too many packets waiting to be sent. This 
condition could be caused by the failure of an element in your network.

Possible values for the Congestion Level field are None, indicating no congestion, 
and 1 to 7, indicating levels of congestion from very light (1) to very heavy (7).
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Instance Status Current status of the protocol associated with the signaling gateway-mated pair, 
with a color-coded background. Possible values are:

Active—The protocol is available.

Shutdown—An administrator has forced the protocol to an unavailable state.

Unknown—The MWTM cannot determine the current status of the protocol.

Status Current status of the signaling gateway-mated pair. Possible values are:

Active

Blocked

Down

Inactive

Pending

Shutdown

Unknown

Warning

For detailed definitions of each status, see Status Definitions for Application 
Server Process Associations, page E-4.

Last Status 
Change

Date and time that the status of the signaling gateway-mated pair last changed.

Status Reason Reason for the current status of the signaling gateway-mated pair.

For a full list of possible reasons, see the stateReasons.html file. To:

• You installed the MWTM in the default directory, /opt, then the file is in the 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• You installed the MWTM in a different directory, then the help directory and 
file are in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration and 
enter the mwtm cleandiscover command to delete all current network data and 
begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server to a 
state that would exist after a new installation of the MWTM, excluding the log 
files, which the MWTM retains. To also remove the log files, enter the mwtm 
cleanall command. For more information on the use of these commands, see the 
Command Reference, page B-1.

Field Description
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ITP Signaling Points

The Status Information section for ITP signaling points contains:

Column Description

Is Ignored Indicates whether the signaling point is Ignored (that is, whether the 
signaling point should be included when aggregating and displaying MWTM 
status information).

Alarm Severity Indicates the alarm severity of the object. See Chapter 9, “Managing Alarms 
and Events.”

Last Status Change Date and time that the status of the signaling point last changed.

Status Current status of the signaling point. Possible values are:

Active

Unknown

Unmanaged

Warning

For detailed definitions of each status, see Status Definitions for Signaling 
Points, page E-7.

Status Reason Reason for the current status of the signaling point.

For a full list of possible reasons, see the stateReasons.html file. To:

• You installed the MWTM in the default directory, /opt, then the file is in 
the /opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• You installed the MWTM in a different directory, then the help directory 
and file are in that directory.

If the cell is too small to show all of the status reason, place the cursor over 
the cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

Status Reason

(continued)

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network 
data and begin a discovery of the network. If the status reason remains 
Unsupported Configuration, enter the mwtm clean command to restore the 
MWTM server to a state that would exist after a new installation of the 
MWTM, excluding the log files, which the MWTM retains. To also remove 
the log files, enter the mwtm cleanall command. For more information on 
the use of these commands, see the Command Reference, page B-1.
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Threshold Information (RAN-O Only)
The Threshold Information section for RAN-O nodes contains:

Viewing Troubleshooting

Note If you have implemented MWTM User-Based Access, this option is available to users with 
authentication level Network Operator (level 3) and higher.

Tip For more information about troubleshooting, see the OSS Integration Guide for the Cisco Mobile 
Wireless Transport Manager 6.1.

You can run commands and view output in the Troubleshooting section available from the MWTM client 
or MWTM Web interface.

To view the Troubleshooting section, in a view in the navigation tree, select an object, then click on the 
Troubleshooting tab in the right pane.

Note To see which object types pertain to this tab, see Appendix A, “Client Object Map Reference.”

Tip To save the output of all executed commands to a log file, see mwtm tshootlog, page B-77. 

Before you can run commands and view output, you must properly configure credentials. You can 
configure credentials by using the CLI command (see mwtm addcreds, page B-6) or through the MWTM 
client (see Configuring Login Credentials, page 3-20). If credentials are not configured, the output pane 
displays this message:

No credentials are available for this node

Field Description

Acceptable The percentage threshold setting below which the backhaul utilization is considered 
acceptable. The default Acceptable threshold is 60 percent.1

1. To change the default setting, see Editing Properties for a RAN-O Backhaul, page 6-36.

Warning The percentage threshold setting beyond which the backhaul utilization issues a 
warning. Subsequent warnings are issued only if the utilization falls below the 
Acceptable threshold. The default Warning threshold is 70 percent.1

Overloaded The percentage threshold setting beyond which the backhaul utilization is considered 
overloaded. Subsequent overload messages are issued only if the utilization falls 
below the Acceptable threshold. The default Overloaded threshold is 80 percent.1
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Troubleshooting Menu and Toolbar
The Troubleshooting section displays these menus and toolbar buttons for the chosen object:

Menu or Toolbar Button Description

Category A grouping of related commands. The MWTM provides default categories 
that you cannot modify. Additional categories are user-defined. You can 
execute all commands in a category at once by using the Execute Category 
button.

Note To define additional categories and create new commands in 
categories, see Creating New Troubleshooting Categories and 
Commands, page 3-23

Command A command or task within the chosen category. The MWTM provides 
commands for default categories that you cannot modify. You can execute 
a chosen command by using the Execute Command button.

Suffix Filters the output of troubleshooting commands. For example:

• | include—Includes the lines matching the specified regular expression

• | exclude—Excludes the lines matching the specified regular 
expression

• | begin—Starts the printout at the line matching a regular expression

• | section—Outputs only the matching sections of the printout

Note The suffixes allowed here are those supported by the IOS version. 

Execute 
Command

Executes the chosen command only.

Note If you are using Microsoft Internet Explorer, the scroll bar may 
change position. 

Execute 
Category

Executes all commands in the chosen category.

Note If you are using Microsoft Internet Explorer, the scroll bar may 
change position. 

Cancel 
Execution

Stops any execution process.

Save Output Saves output on screen to a file.

Copy Output Copies output on screen to the clipboard.

Print Output Prints output on screen.

Clear Output Clears all output from the screen.

Output Pane Pane where command output appears.
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Commands That Require Additional User Input
After you click the Execute Command or Execute Category button, some commands prompt you for 
additional input. Commands that prompt you for additional input have an ellipsis (...) at the end of the 
command. You must enter valid data, which appears in green as you type. Invalid data appears in red. 
The MWTM will not execute a command with invalid data. Once you have entered the additional input, 
you must click one of these buttons:

Related Topics

• Configuring Login Credentials, page 3-20

• Troubleshooting IOS Commands on the Web, page D-4

• mwtm addcreds, page B-6

• mwtm tshootlog, page B-77

Viewing Alarms and Recent Events
To view alarms for an object, in the navigation tree, select the object (for example, a node), then click 
the Alarms tab in the content area. 

To view recent events for an object, in the navigation tree, select the object (for example, an interface), 
then click the Recent Events tab in the content area.

The table in the content pane displays information about the alarms or recent events associated with the 
chosen object. The content pane also provides tools to perform tasks, such as setting filters and 
acknowledging alarms or events.

Note For managed objects that have peers (RAN backhauls and shorthauls, ITP links and linksets, and 
signaling-gateway mated pairs), the MWTM displays subtabs to distinguish alarms and recent events for 
each peer object.

• For descriptions of the table columns, see Right-click Menus, page 9-16. 

• For descriptions of alarms and events tools, see Toolbar Buttons, page 9-14.

• To understand the difference between alarms and events, see Basic Concepts and Terms, page 9-1.

Button Description

OK Executes the chosen command or category of commands.

Note If you do not provide input but leave the fields blank, and then click 
OK, the MWTM skips the command or commands and this 
message appears:

Skipping command.

The MWTM lists the commands that you skipped, but executes 
other commands for which you provided input.

Clear Removes entered data from all input fields.

Cancel Removes the input fields from the right pane.
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Using Provisioning
This section describes how to provision objects using the MWTM web interface and provides examples. 
For further information, please see the OSS Integration Guide for the Cisco Mobile Wireless Transport 
Manager 6.1.

http://cisco.com/en/US/docs/net_mgmt/mobile_wireless_transport_manager/6.1/developer/guide/
mwtmoss.html

Using provisioning through the MWTM Web interface, you can add, modify, and/or delete ITP, PWE3, 
CSG2, or GGSN objects, as follows: 

ITP Objects Add Modify Delete

Linksets Yes Yes Yes

SCTP Links Yes Yes Yes

MTP2 Links Yes Yes Yes

HSMTP2 Links Yes Yes Yes

HSL Links Yes Yes Yes

Application servers, including m3ua and sua Yes Yes Yes

Application server processes, including m3ua 
and sua

Yes Yes Yes

Local peer objects Yes Yes Yes

m3ua objects Yes Yes Yes

sua objects Yes Yes Yes

Channelized serial interfaces (under T1/E1 
controllers)

Yes Yes Yes

Physical serial interfaces No Yes No

Physical T1/E1 controllers No Yes No

Physical ATM interfaces No Yes No

Physical Ethernet, FastEthernet, or 
GigabitEthernet interfaces

No Yes No
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IPRAN
(PWE3)

Objects Add Modify Delete

ATM Connect Yes Yes Yes

CEM Class Yes Yes Yes

CEM Group Yes Yes Yes

Interface ATM, ATM IMA, ATM Sub Interface 
1

Yes Yes Yes

Interface BITS No Yes No

Interface CEM 1 No Yes No

Interface E1, T1 1 No Yes No

Interface FastEthernet, GigabitEthernet 1 No Yes No

Interface Loopback 1 Yes Yes Yes

Interface Serial 1 Yes Yes Yes

Interface SONET 1 No Yes No

Interface Tunnel 1 Yes Yes Yes

Interface Virtual CEM 1 No Yes No

Module RTM 1 No Yes No

Node 1 No Yes No

PVC 1 Yes Yes Yes

PVP 1 Yes Yes Yes

Pseudowire Class Yes Yes Yes

Recovered Clock 1 Yes Yes Yes

Sonet AU4 Tug 1 No Yes No

Sonet AU4 1 No Yes No

Sonet STS 1 No Yes No

Sonet Tug 1 No Yes No

Sonet VTG 1 No Yes No

Sonet CEM Group Yes Yes Yes

TDM Connect Yes Yes Yes

TDM Group Yes Yes Yes

Virtual CEM Group Yes Yes Yes

CSG2 Objects Add Modify Delete

CSG2 Yes Yes Yes

CSG Map Yes Yes Yes

CSG Policy Yes Yes Yes

CSG Content Yes Yes Yes

CSG Service Yes Yes Yes

CSG Billing Plan Yes Yes Yes
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Note If you have implemented MWTM User-Based Access, this option is available to users with 
authentication level Network Operator (level 3) and higher.

This section contains:

• Prerequisites for Using Provisioning, page 8-49

• Using the Provisioning Wizard, page 8-50

GGSN R8 Objects Add Modify Delete

APN Yes Yes Yes

GPRS Charging Profile Yes Yes Yes

GPRS Charging Profile Defaults Yes Yes Yes

GPRS Global Commands Yes Yes Yes

Service Mode Yes Yes Yes

Test by IMSI Yes Yes Yes

Maximum PDP Contexts Yes Yes Yes

QoS Default Response Requested Yes Yes Yes

VRF 1 Yes Yes Yes

Interface, Loopback 1 Yes Yes Yes

Interface, Tunnel 1 Yes Yes Yes

Interface, GigabitEthernet 1 No Yes No

Supervisor of 
GGSN R8

Objects Add Modify Delete

L2VLAN 2 Yes Yes Yes

VRF 1 Yes Yes Yes

Interface, Loopback 1 Yes Yes Yes

Interface, VLAN 1, 2 Yes Yes Yes

Interface, Tunnel 1 Yes Yes Yes

Interface, GigabitEthernet 1 No Yes No

1. Not all options and/or subcommands are supported. 

2. See bug about VTP Mode Transparent
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Prerequisites for Using Provisioning
Before you can provision an object:

• You must set up:

– Basic IP connectivity

– SNMP community strings

– Credentials

– Telnet or SSH access allowed

– (ITP only) Basic signaling points configured

– (GGSN only) The GPRS service must be enabled in IOS

• MWTM must be able to successfully:

– Discover the object

– Retrieve running configuration from the object

Setting Up the MWTM to Retrieve Running Configuration from the Object

Before you can use the MWTM to provision objects, you must set up the MWTM to retrieve the running 
configuration from the object.

The MWTM inventory has two types of attributes: 

• Monitor attributes—Attributes obtained from SNMP polling and/or status monitoring

• Configuration attributes—Attributes obtained from IOS running configuration.

Setting up the MWTM to retrieve running configuration is a two-step process. You must:

1. Supply credentials for the target node(s). For details, see Configuring Login Credentials, page 3-20.

2. Ensure that the MWTM is getting the IOS running configuration successfully from the object. There 
are two approaches you can use:

– Automatic configuration synchronization—This is the default option. You can verify that the 
option in the System.properties file—look for the AUTO_SYNC_CONFIG field, which should 
be set to true. If you enable this option, the MWTM automatically retrieves the running 
configuration from the object after the MWTM processes a provisioning operation (from the 
GUI or NBAPI). During every status poll, the MWTM checks whether the running 
configuration has changed on the object. If the configuration has changed, the MWTM retrieves 
it.

– Manual configuration synchronization—In certain situations, you may choose to turn off 
automatic configuration synchronization and manage configuration synchronization manually. 
You can request manual configuration synchronization using the NBAPI or the CLI. For details, 
see the OSS Integration Guide for the Cisco Mobile Wireless Transport Manager 6.1.
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Using the Provisioning Wizard

Note Throughout the wizard, you can click Next to continue, Previous to go back, Cancel to exit the wizard 
without saving changes, Refresh to reload the current window, or Submit to complete the provisioning.

To start provisioning by using the MWTM provisioning wizard:

Step 1 From the MWTM client, right-click a node in the navigation tree and choose Provision

or

From the MWTM web interface, click a node in the navigation tree and click the Provision tab in the 
content pane. 

Step 2 Select a Type (and SubType, if applicable). 

Step 3 Click New to create a new item of the chosen Type or select an item in the Provisioned Items list, then 
click Edit or Delete.

The provisioning wizard appears as shown in Figure 8-3.

Figure 8-3 Provisioning Wizard

There are three possible wizard stages: Basic, Features, and Summary. 

Note If you do not initiate activity on an active wizard screen, your session will time out after 60 
seconds, and the MWTM returns to the Provision Choices window.

Step 4 Enter the relevant information at the Basic stage and click Next to continue. 

Step 5 (Optional) Make your selections at the Features stage. Notice that as you enable features, they appear in 
the Wizard Steps pane under Features. Click Next to continue.

Step 6 (Optional) If you have added features, you can choose to configure aspects of each feature. Click Next 
to continue, or click the wizard stage in the left pane to jump between stages.
8-50
User Guide for the Cisco Mobile Wireless Transport Manager 6.1

OL-9118-01



 

Chapter 8      Understanding Detailed Object Functions
  Editing SNMP IP Addresses for a Node
Step 7 The Summary stage appears, showing which IOS commands the MWTM will send to the object. You 
can optionally check the box Write to IOS startup-config, which saves your configuration changes 
permanently to the startup configuration on the object. This process can take time.

Step 8 Click Submit to send the provisioning to the object.

The provisioning wizard provides colored status balls in the Wizard Steps pane, which indicate:

• White—The stage you are in currently

• Red—A problem in the stage

• Yellow—Stage is not yet configured

• Green—Stage is configured successfully

Editing SNMP IP Addresses for a Node
You use the MWTM to determine which IP addresses to use for SNMP polling.

To edit a node’s SNMP IP addresses, right-click a node in a window, choose Edit > SNMP IP Addresses 
in the right-click menu. The MWTM displays the Edit SNMP IP Addresses dialog box.
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The Edit SNMP IP Addresses dialog box contains:

Field or Button Description

Available IP 
Addresses

List of all IP addresses associated with this node that users could not or do not want 
the MWTM to use for SNMP polling. The MWTM does not send SNMP queries to 
IP addresses in this list.

This option appears only for ITP, IPRAN, or mSEF nodes.

IP Addresses for 
SNMP

List of all IP addresses associated with this node that the MWTM can use for SNMP 
polling:

• By default, the MWTM places all discovered IP addresses in this list, in the 
order in which they are discovered. The MWTM uses the IP address at the top 
of the list as the primary SNMP address for the node.

During SNMP polling of the node (status polling and demand polling), the 
MWTM first tries the primary SNMP address. If the primary is unavailable, the 
MWTM tries the other IP addresses, one-by-one, in descending order.

• To assign a new primary SNMP address, or to change the order of the 
secondary IP addresses, click the Raise Priority and Lower Priority buttons 
to move the IP addresses up and down in the list.

• You can also select IP addresses that you do not want the MWTM to use for 
SNMP polling. This feature is useful, for example, to separate management 
traffic from SMS traffic. To remove an IP address from the list, click Remove. 
The MWTM removes the IP address from the IP Addresses for SNMP list, 
places it in the Available IP Addresses list, and no longer uses it for SNMP 
polling.

To enable an IP address for SNMP polling again, select the address in the 
Available IP Addresses list and click Add. The IP address moves back into the 
IP Addresses for SNMP list and is again available for SNMP polling.

If you remove all IP addresses from the IP Addresses for SNMP list, you 
remove the node from the network, and the MWTM automatically labels the 
node Unmanaged in all MWTM windows.

When you click Save, all MWTM windows are updated automatically to reflect the 
changes.

This option appears only for ITP, IPRAN, or mSEF nodes.

Add Enables one or more chosen IP addresses for SNMP polling. All chosen 
IP addresses in the Available IP Addresses list are moved to the IP Addresses for 
SNMP list where the MWTM uses them again for SNMP polling.

Remove Disables one or more chosen IP addresses for SNMP polling. All chosen 
IP addresses in the IP Addresses for SNMP list are moved to the Available 
IP Addresses list, and are no longer used by the MWTM for SNMP polling.

Raise Priority Moves the chosen IP addresses up in the IP Addresses for SNMP list. If you move 
an IP address to the top of the list, the MWTM uses that IP address as the new 
primary SNMP address for the node.

Lower Priority Moves the chosen IP addresses down in the IP Addresses for SNMP list. If you 
remove an IP address from the top of the list, the MWTM no longer uses that IP 
address as the primary SNMP address for the node.
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Polling a Node
The MWTM automatically polls nodes at specified intervals. However, you can also request an 
immediate poll for a node. This section describes:

• Polling from the Discovery Dialog, page 8-53

• Performing a Normal Poll, page 8-54

• Performing a Clean Poll, page 8-55

Polling from the Discovery Dialog

To poll a node from the Discovery dialog box:

Step 1 Choose Network > Network Discovery from the MWTM main menu. 

The MWTM displays the Discovery dialog box.

Step 2 Select the Discovery tab. 

The MWTM displays the Discovery pane. The Discovered Nodes section of the Discovery pane lists all 
discovered nodes (all nodes, including new and excluded nodes, not just the nodes in the current view).

Step 3 Select one or more nodes. 

Note You cannot poll a node with a Primary SNMP Address of N/A. If you select a node with a 
Primary SNMP Address of N/A, then the Poll Node button is dimmed and cannot be chosen.
If you select more than one node, and even one of them has a Primary SNMP Address of N/A, 
then the Poll Node button is dimmed and cannot be clicked.

Step 4 Click Poll Node. 

The MWTM begins a poll of the chosen nodes. During polling, the Poll Node button is dimmed, the 
Selected nodes are being polled message appears at the bottom of the Discovery dialog box, and 
individual nodes might display the polling status.

Note If the node has only one IP address for the MWTM to poll, and the poll fails or times out, the 
MWTM issues an error message. If the node has more than one IP address for the MWTM to 
poll, and the polls of one or more IP addresses fail or time out, the MWTM issues warning 
messages. If all polls fail or time out, the MWTM issues an error message.

Save Saves changes that you made to the node information and exits the dialog box.

When you are satisfied with your changes, click Save. The MWTM saves your 
changes and updates all MWTM windows to reflect your changes.

Cancel Exits the dialog box without saving any changes.

At any time, you can click Cancel to exit the dialog box without saving any 
changes.

Help Displays online help for the dialog box.

Field or Button Description
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When the Selected nodes are being polled message disappears and no nodes are in polling status, 
polling is complete. The MWTM database immediately reflects any new or changed data for the chosen 
nodes.

Performing a Normal Poll

A normal poll retains all objects associated with polled nodes, even objects that have been deleted and 
are therefore in Unknown status.

To poll one or more nodes, retaining all associated components in the MWTM database, use one of these 
procedures:

From a View in the Main Window

Step 1 Select a view in the navigation tree.

Step 2 Select one or more nodes in the navigation tree.

Step 3 Choose Network > Poll Nodes > Normal Poll. 

The MWTM polls all chosen objects.

From Summary Lists

Step 1 Click Nodes under Summary Lists in the navigation tree.

Step 2 Select a node or adjacent node in the node table in the right pane.

Step 3 Choose Network > Poll Nodes > Normal Poll. 

The MWTM polls that node.

From Rick-click Menu in a View

Step 1 Select a view in the navigation tree.

Step 2 Right-click a node in the navigation tree.

Step 3 Choose Poll Node > Normal Poll from the right-click menu. 

The MWTM polls the node.
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Performing a Clean Poll

A clean poll removes all network objects from the node at the completion of the poll.

To poll one or more nodes, removing and then rediscovering all associated components, use one of these 
procedures:

From a View in the Main Window

Step 1 Select a view in the navigation tree.

Step 2 Select one or more nodes in the navigation tree.

Step 3 Choose Network > Poll Nodes > Clean Poll. 

The MWTM polls all chosen nodes.

From Summary Lists

Step 1 Click Nodes under Summary Lists in the navigation tree.

Step 2 Select a node or adjacent node in the node table in the right pane.

Step 3 Choose Network > Poll Nodes > Clean Poll. 

The MWTM polls that node.

From Rick-click Menu in a View

Step 1 Select a view in the navigation tree.

Step 2 Right-click a node in the navigation tree.

Step 3 Choose Poll Node > Clean Poll from the right-click menu. 

The MWTM polls the node.

Clean Node for ITP Objects

Step 1 Select a view in the navigation tree.

Step 2 Select an application server, application server process, link, or linkset in the navigation tree or in the 
Summary Lists tables.

Step 3 Choose Network > Poll Nodes > Clean Poll. 

The MWTM polls all ITP nodes and adjacent nodes associated with the object.
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Allowing and Disallowing Trap Processing for a Node
By default, the MWTM processes traps from all discovered nodes. However, you can prevent the 
MWTM from processing traps from one or more nodes. For example, if a node is experiencing many link 
changes and generating too many traps, you can disallow traps from that node until the situation 
stabilizes.

Note If you prevent the MWTM from processing traps from a node, all MWTM clients and views connected 
to that MWTM server are prevented from processing traps from that node.

Also, if you prevent the MWTM from processing traps from a node, make a note of the change, and 
remember to reset the node when the problem is corrected or the maintenance is complete.

To prevent the MWTM from processing traps from a node, use one of these procedures:

• Uncheck the Process Traps check box for the node in the Node table.

Note By default, the Process Traps column is hidden. To display the Process Traps column, right-click 
in the table heading and select the Process Traps check box.

• Right-click the node in the navigation tree, then choose Disallow Trap Processing.

To allow the MWTM to process traps from a node, use one of these procedures:

• Check the Process Traps check box for the node in the Node table.

• Right-click the node in the navigation tree, then choose Allow Trap Processing.

Viewing Real-Time Data
You can use the MWTM to view real-time data for chosen objects in the navigation tree. The real-time 
statistics for some objects (CSG2, BWG, HA, and GGSNs on SAMI cards) appear only in the MWTM 
web interface (see Chapter 11, “Accessing Data from the Web Interface” to view these statistics).

Note In the MWTM client, the real-time icon  appears in some tabs in the right pane. This icon indicates 
that polling will periodically occur while this window is open. To prevent unnecessary traffic on your 
network, close this window when you no longer need to refer to it.

For more information on viewing real-time data, see:

• Viewing the Syslog, page 8-57

• Viewing CPU Performance, page 8-58

• Viewing Trap Settings, page 8-62

• Viewing Data for Interfaces, page 8-63

• Viewing Data for ITP Objects, page 8-66

• Viewing ITP MTP3 Errors, page 8-93

• Viewing ITP MSU Rates, page 8-94

• Viewing ITP Non-Stop Operation, page 8-95
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• Viewing TDM Statistics, page 8-103

• Viewing RAN-O Performance Data, page 8-107

• Viewing RAN-O Error Data, page 8-115

• Viewing PWE3 Statistics, page 8-121

Viewing the Syslog
The Syslog section displays all messages in the system log for the chosen node.

Note In the MWTM client, the real-time icon  appears in the tab. This icon indicates that polling will 
periodically occur while this window is open. To prevent unnecessary traffic on your network, close this 
window when you no longer need to refer to it.

To view the Syslog section, in a view in the navigation tree, select a node, then click the Syslog tab in 
the content area.

The Syslog section displays these columns for the chosen node:

Column Description

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first polling 
cycle, the MWTM populates this field with the actual time of the last poll.

Timestamp Date and time of the syslog message from the node.

Severity Severity of the syslog message. Possible values are:

• Alert—Conditions that require immediate action.

• Critical—Critical conditions.

• Debug—Debug conditions, log FTP commands, and WWW URLs.

• Emergency—System unusable conditions.

• Error—Error conditions.

• Info—Information conditions.

• Notice—Normal but significant conditions.

• Warning—Warning conditions.

Facility Name of the facility that generated the syslog message, such as SYS, SNMP, 
CS7MTP3, or CS7PING.

Name Short text identifier for the message type. A facility name in conjunction with a 
message name uniquely identifies a syslog message type.

Message Text of the syslog message.
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Viewing CPU Performance
The Performance tab provides real-time chart and table statistics about:

• CPU Processes, page 8-58

• CPU Utilization, page 8-59

• Memory Utilization, page 8-60

Note In the MWTM client, the real-time icon  appears in the tab. This icon indicates that polling will 
periodically occur while this window is open. To prevent unnecessary traffic on your network, close this 
window when you no longer need to refer to it.

To view real-time CPU performance statistics, in a view in the navigation tree, select a node, then click 
the Performance tab in the content area. The Performance tab appears in the right pane when you select 
any of these nodes: CSG1, CSG2, GGSN, BWG, CSR, HA, RAN-SVC, ITP.

Note In some cases, users can notice a difference in the number of CPUs reported by the CPU Utilization, 
CPU Processes, and Memory Utilization selections. The CPU MIBs do not report statistics for cards that 
are in standby mode (for example, supervisor cards). However, the memory MIB does report memory 
utilization for standby cards. Because of this difference, the Memory Utilization selection can display a 
greater number of CPUs than the CPU Utilization and CPU Processes selections.

Also, because the information for memory and CPU statistics comes from different MIBs, the CPU 
descriptions can vary. Users can correlate the information by comparing the descriptions available 
among the CPU Utilization, CPU Processes, and Memory Utilization selections. Devices that support 
the CISCO-MEMORY-POOL-MIB show only the description of the main processor.

CPU Processes

To view real-time CPU processes for the node, click the View drop-down arrow in the MWTM client or 
MWTM web interface, and select CPU Processes.

The MWTM client displays information about CPU processes in a table with slot- and CPU-specific 
tabs. When you click the tabs for a specific slot and CPU, the MWTM shows CPU process information 
for the selected CPU. If only a single CPU exists, no tabs for slots or CPUs appear. The MWTM displays 
information for the CPU in the right pane.

For detailed information on working in tables, see Navigating Table Columns, page 5-24.

Each table contains:

Field or Column Description

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first 
polling cycle, the MWTM populates this field with the actual time of the last 
poll.

PID Process identifier.
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CPU Utilization

To view real-time CPU utilization for the node, click the View drop-down arrow in the MWTM client, 
and select CPU Utilization.

The MWTM client displays a CPU utilization chart with:

• A Summary tab that shows the combined utilization of all CPUs on the node

• Slot- and CPU-specific tabs that show utilization for a selected CPU

Note The MWTM web interface displays this data in tabular, instead of chart, format. To view the tabular data 
in its raw format, in the Server.properties file, set the WEB_DEBUG parameter to true. 

The CPU summary chart displays a vertical band whenever at least one its CPUs is above the normal 
threshold. Status balls on the CPU-specific tabs indicate the highest threshold status of all data series for 
the CPU for the last polling interval.

The CPU-specific charts display horizontal bands to show overloaded, warning, and acceptable 
thresholds; you must configure the CPU rising and falling thresholds on the device to display these bands 
in the MWTM. The falling threshold corresponds to the boundary between the acceptable and warning 
bands. The rising threshold corresponds to the boundary between the warning and overloaded bands. For 
multi-CPU devices, these thresholds apply only to the main CPU.

Name Name of the process.

Time Created Total time since the process was created.

Total Runtime CPU time the process has used.

Times Invoked Number of times the process was invoked.

Average Runtime Average CPU time for each process invocation.

5 Sec % Average CPU utilization percentage for the node over the last 5 seconds.

1 Min % Average CPU utilization percentage for the node over the last minute.

5 Min % Average CPU utilization percentage for the node over the last 5 minutes.

Priority Process queue priority. Possible values are:

• Low

• Normal

• High

• Critical

Field or Column Description

GUI Elements Description

Change Poller Button that opens the Poller Settings dialog box. See Change Poller, page 8-110.

Poll Interval Label that shows the current poll interval in seconds.

Percentage Y-axis label that shows percentage of CPU utilization over time.
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Memory Utilization

To view CPU memory utilization for the node, click the View drop-down menu in the MWTM client or 
MWTM web interface, and select Memory Utilization.

The MWTM client displays memory utilization in a table with:

• A Summary tab that shows the combined memory utilization of all CPUs on the node

• Slot- and CPU-specific tabs that show memory utilization for a selected CPU

Note Depending on the device, memory utilization statistics may not be available from the management 
information base (MIB). Devices that support the CISCO-ENHANCED-MEMORY-POOL-MIB have 
detailed memory information for each CPU. Devices that support the CISCO-MEMORY-POOL-MIB 
have memory information only for the CPU of the main processor. For these devices, the memory 
utilization table shows only one entry even though these devices can have multiple CPUs. In these cases, 
the CPU Description column indicates CPU of main processor.

Summary Tab

The Summary tab displays a tabular overview of all CPUs in the chosen node to enable users to easily 
observe problem areas.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Summary table.

For detailed information on working in tables, see Navigating Table Columns, page 5-24.

Time X-axis label that displays a real-time scale and the server time zone.

Legend Identifies the data series currently showing in the chart. 

• 5 sec—Average CPU utilization percentage for the node over the last 5 
seconds.

• 1 min—Average CPU utilization percentage for the node over the last minute.

• 5 min—Average CPU utilization percentage for the node over the last 5 
minutes.

• No Data—Color-coded value that indicates no data is available to display.

• CPU Threshold Crossed—In the Summary-tab chart, color-coded value that 
indicates when CPU utilization is above normal.

• Overloaded—In a CPU-tab chart, color-coded value that indicates when CPU 
utilization is in the overloaded zone.

• Warning—In a CPU-tab chart, color-coded value that indicates when CPU 
utilization is in the warning zone.

• Acceptable—In a CPU-tab chart, color-coded value that indicates when CPU 
utilization is in the acceptable zone.

GUI Elements Description
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The Summary table contains:

CPU-specific Tabs

The CPU-specific tabs display tabular information for the selected slot and CPU. If only a single CPU 
exists, no slot or CPU tabs appear and the MWTM displays the information for the CPU in the right pane.

For detailed information on working in tables, see Navigating Table Columns, page 5-24.

Each CPU-specific table contains:

Field or Column Description

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first 
polling cycle, the MWTM populates this field with the actual time of the last 
poll.

CPU Slot number (if known) and CPU number.

CPU Description Type of CPU.

Processor Memory Percentage of available processor memory in use.

I/O Memory Percentage of available I/O memory in use.

Field or Column Description

Poll Interval Poll interval used to collect data for the table.

Note Polling for memory statistics takes longer than for CPU statistics. If 
excessive timeouts occur for memory polling, you can increase the 
number of milliseconds for the timeout by changing the 
MEMORY_POLLER_TIMEOUT_INCREMENT in the 
Server.properties file. 

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first 
polling cycle, the MWTM populates this field with the actual time of the last 
poll.

Memory Type The type of memory, either processor memory or I/O memory.

Utilization Percentage of utilization for each type of memory.

Total Total amount of memory for each memory type.

Used Amount of memory that is used for each memory type.

Free Amount of free (unused) memory for each memory type.

Largest Free1

1. This column is hidden by default. Right-click in the column header and check the check box next to the heading label to 
display it.

The largest available memory unit.

Valid1 Whether or not the memory is valid for use.
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Viewing Trap Settings
The Trap Settings section displays all trap settings for the chosen node, as well as all hosts and port 
numbers to which the node sends traps.

If you have implemented MWTM User-Based Access, this option is available to users with 
authentication level 5 (System Administrator).

Note In the MWTM client, the real-time icon  appears in the tab. This icon indicates that polling will 
periodically occur while this window is open. To prevent unnecessary traffic on your network, close this 
window when you no longer need to refer to it.

To view the Trap Settings section, in a view in the navigation tree, select a node, then click on the Trap 
Settings tab in the content area.

The Trap Settings section displays these columns for the chosen node:

Column Description

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first 
polling cycle, the MWTM populates this field with the actual time of the last 
poll.

Release 2 Trap 
Settings (ITP only)

Indicates whether these ITP release 12.2(4)MB4 trap settings are enabled:

• SCTP Remote Address Change

• Linkset State Change

• Link State Change

• Link Congestion State Change

• Link Receive Utilization Change

• Link Send Utilization Change

• Route State Change

• GTT MAP State Change

Release 3 Trap 
Settings (ITP only)

Indicates whether these ITP release 12.2(4)MB5 through 12.2(4)MB9a trap 
settings are enabled:

• ASP State Change

• AS State Change

• SGMP State Change

This column might not be visible if the ITP does not support ITP release 
12.2(4)MB5 through 12.2(4)MB9a traps.
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Viewing Data for Interfaces

Note The MWTM client provides charts and tables to display the performance and error information for the 
chosen interface. The MWTM web interface displays the same information in a tabular format.

For most interfaces, the MWTM displays interface performance and error information in separate tabs 
in the right pane. However, depending on variables such as node type, card type, interface type, IOS 
software image, and the running configuration on the node itself, performance and error statistics may 
not be available for the chosen interface.

Release 4 Trap 
Settings (ITP only)

Indicates whether these ITP release 12.2(4)MB10 through 12.2(20)SW trap 
settings are enabled:

• Linkset State Change

• Link State Change

• Link Congestion State Change

• Link Receive Utilization Change

• Link Send Utilization Change

• Route Destination State Change

• Route Mgmt. State Change

• Route Table Load

• GTT MAP State Change

• GTT Table Load

• ASP Congestion Change

• SNMP Congestion Change

This column might not be visible if the ITP does not support ITP release 
12.2(4)MB10 through 12.2(20)SW traps.

Release 6 Trap 
Settings (ITP only)

Indicates whether the following ITP release 12.2(25)SW3 trap setting is 
enabled:

• MLR Load Table

This column might not be visible if the ITP does not support ITP release 
12.2(25)SW3 traps.

RAN Trap Settings 
(RAN-O only)

Trap settings for the node. These settings include:

• GSM State Change

• UMTS State Change

Local IP Address IP address of a local host to which the node sends traps.

Port Port to which the node sends traps.

Trap Version Trap version sent to this IP address and port.

Community String SNMP community name used by the node for read access to the information 
maintained by the SNMP agent on the node.

Column Description
8-63
User Guide for the Cisco Mobile Wireless Transport Manager 6.1

OL-9118-01



 

Chapter 8      Understanding Detailed Object Functions
  Viewing Real-Time Data
Note • Interface performance and error statistics are not available for T1, E1, Synchronous Digital 
Hierarchy (SDH), or RAN-O shorthaul interfaces. 

• Statistics are also unavailable for these ATM interface types: ATM subinterface and ATM layer.

For the chosen interface, you can view:

• Real-Time Interface Performance, page 8-64

• Real-Time Interface Errors, page 8-65

Real-Time Interface Performance

To view real-time interface performance, select the interface in the navigation tree, then click the 
Interface Performance tab. 

Note In the MWTM client, the real-time icon  appears in the tab. This icon indicates that polling will 
periodically occur while this window is open. To prevent unnecessary traffic on your network, close this 
window (for example, by clicking a different tab) when you no longer need to view the real-time data.

You may be prompted to start an in-band poller if polling cannot be done out of band. 

The Interface Performance tab contains: 

GUI Element1 Description

Change Poller Button that opens the Poller Settings dialog box. See Change Poller, 
page 8-110. 

Poll Interval Label that shows the current poll interval in seconds.

Last Poll Label that identifies when the last poll occurred.

Bits or Bytes/Sec 
(MWTM client) or 
Current Rate (MWTM 
web interface)

MWTM client:

The MWTM displays separate charts for send (out) and receive (in) traffic on 
the chosen interface.

The Y-axis label that displays the interface traffic rate in bits or bytes per 
second. The default is bits per second. To change the charts to show bytes per 
second, uncheck the Show Details in Bits instead of Bytes check box in the 
Preferences window (General Display Settings, page 5-4).

The Y axis automatically scales to the interface speed. 

MWTM web interface:

Displays the interface traffic rate in bits or bytes per second.

% Utilization For interface speeds greater than zero, the right side of the Y axis displays the 
percent utilization of the interface, on a scale from 0 to 100%.

Time X-axis label that displays a real-time scale and the server time zone.
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Real-Time Interface Errors

To view real-time interface errors, select the interface in the navigation tree, then click the Interface 
Errors tab. 

Note In the MWTM client, the real-time icon  appears in the tab. This icon indicates that polling will 
periodically occur while this window is open. To prevent unnecessary traffic on your network, close this 
window (for example, by clicking a different tab) when you no longer need to view the real-time data.

You may be prompted to start an in-band poller if polling cannot be done out of band. 

The Interface Errors tab contains: 

Legend Identifies the data series currently showing in the chart. 

• Out—Shows the outgoing (transmit) traffic rate of the chosen interface.

• In—Shows the incoming (receive) traffic rate of the chosen interface.

• No Data—Data is not available. A vertical bar appears in the chart.

Show/hide right-click 
menu

Provides options to show or hide one or more parts of a data series. See 
Right-click Menu, page 8-95, for descriptions of the options.

(MWTM Web only) 
Total Count Since 
Reboot (bits) 

Total number of bits since reboot.

(MWTM Web only) 
Interface Speed 
(bits/sec)

Interface send and receive speed in bits per second.

1. The MWTM web interface displays the same information in tabular, not chart, format.

GUI Element1 Description

GUI Element Description

Change Poller Button that opens the Poller Settings dialog box. See Change Poller, 
page 8-110. 

Reset Counters Opens the Reset Counters dialog box to configure the method of polling. See 
Changing Real-Time Poller and Counter Settings, page 5-21.

Poller Counter Mode Label that displays the polling mode that you configure in the Reset Counters 
dialog box.

Poll Interval Label that shows the current poll interval in seconds.

Last Poll Label that identifies when the last poll occurred.
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Viewing Data for ITP Objects
You use the MWTM to view detailed statistics for any of these ITP objects:

• Application Servers

• Application Server Process Associations

• Links

• Linksets

• Signaling Gateway Mated Pairs

To display detailed statistics for an object:

• In the MWTM client—In a view in the navigation tree, right-click an object, then choose 
View > Real-Time Data and Charts. The MWTM displays the Statistics Details window for the 
object.

Interface Errors Table that shows this information for the chosen interface:

• Data Type:

– In Errors—Incoming (receive) errors.

– Out Errors—Outgoing (transmit) errors.

– In Discards—Incoming, discarded packets.

– Out Discards—Outgoing, discarded packets.

– Unknown Protocol Packets Received—For packet-oriented 
interfaces, the number of received packets that were discarded 
because of an unknown or unsupported protocol. For 
character-oriented or fixed-length interfaces that support protocol 
multiplexing, the number of received transmission units that were 
discarded because of an unknown or unsupported protocol. For 
interfaces that do not support protocol multiplexing, the count will 
always be 0.

• Counts—Error counts since the last reboot.

• Rates (per sec)—Error rates since the last reboot.

Output Queue Size The length of the output packet queue (in packets). 

When a router receives a packet, it typically forwards it to another interface. 
The packet enters a queue on the output interface before it is actually sent. The 
interface typically has a buffer that can hold a fixed number of packets in the 
queue. When the output queue overflows, the router begins to discard packets.

Interface Errors / Sec Chart that shows interface errors per second for the chosen interface. The Y 
axis shows errors per second. The X axis shows a real-time scale and the server 
time zone. A legend provides color-coded descriptions of the error types for 
the incoming and outgoing traffic.

Note This chart is only available in the MWTM client interface. The 
MWTM web interface shows the same data in tabular format.

GUI Element Description
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Note The MWTM server automatically reflects updates for the objects received in this window.

Changes you make in this window might not be reflected throughout the MWTM until the next 
poll (by default, every 15 seconds). For information about changing the poll interval, see Poll 
Settings, page 8-75.

• In the web interface—Click on the relevant object (Application Server, Linkset, and so on) in the 
navigation tree and choose the relevant tab in the content pane.

The Statistics Details window in the MWTM client has a navigation tree, which contains:

The Statistics Details window and the MWTM web interface may contain these tabs in the content pane:

Component Applicable To Content Links

Poll Settings All objects Poll Settings

Right-click menu Links Right-Click Menu

Tab Applicable To Content Links

Alarms All objects Viewing Alarms and Recent Events

Charts (MWTM client 
only)

• Application servers 

• Application server process 
associations

• Links 

• Linksets

Charts: Application Servers and 
Application Server Process 
Associations

Charts: Links and Linksets

Details All objects Viewing Details

Interface Details • Application Server Process 
Associations

• Links

• Signaling Gateway Mated Pairs

Interface Details

Linkset Access Lists Linksets Viewing ITP Linkset Access Lists

Notes All objects Viewing Notes

Q.752 Measurements Links Q.752 Measurements

Recent Events (MWTM 
client only)

All objects Viewing Alarms and Recent Events

SCTP Association 
Configuration Details

• Application Server Process 
Associations

• Links

• Signaling Gateway Mated Pairs

SCTP Association Configuration 
Details
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Charts: Application Servers and Application Server Process Associations

You use the MWTM to view real-time MTP3 and ASP packet rate information for the chosen application 
server or application server process association. To do so, click the Charts tab in the Statistics Details 
window for an application server or application server process association, then click the relevant tab 
and the chosen chart appears.

The Statistics Details: Charts section for application servers and application server process associations 
contains:

SCTP Association 
Statistics Details

• Application Server Process 
Associations

• Links

• Signaling Gateway Mated Pairs

SCTP Association Statistics 
Details

Statistics • Application Servers

• Application Server Process 
Associations

• Links

• Linksets

Statistics: Application Servers

Statistics: Application Server 
Process Associations

Statistics: Links and Linksets

Status Contributors Application Servers Viewing Status Contributors

Status Details Links Status Details

Troubleshooting • Application Servers

• Application Server Process 
Associations

• Links

• Linksets

• Signaling Gateway Mated Pairs

Viewing Troubleshooting

Tab Applicable To Content Links

Tab Description Applicable To

MTP3 Packet Rate Displays MTP3 packet rate information for a chosen 
application server.

Application servers

ASP Packet Rate Displays real-time application server process packet 
rate information for a chosen application server.

Application servers

Packets From ASP Rate Displays real-time rate information for packets 
received by the application server process for the 
chosen application server or application server 
process association.

Application servers 
and application 
server process 
associations

Packets To ASP Rate Displays real-time rate information for packets sent to 
the application server process by the chosen 
application server or application server process 
association.

Application servers 
and application 
server process 
associations
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The tabs in the Statistics Details: Charts section for application servers and application server process 
associations contain:

Packets From MTP3 Rate Displays real-time rate information for packets 
received by the chosen application server or 
application server process association, from the 
MTP3 layer.

Application servers 
and application 
server process 
associations

Packets To MTP3 Rate Displays real-time rate information for packets sent to 
the MTP3 layer from the chosen application server or 
application server process association.

Application servers 
and application 
server process 
associations

Tab Description Applicable To

Field or Button Description

Time window (mins) Drop-down list box used to specify the length of time appear in the chosen 
chart.

Valid selections are 1, 2, 5, 10, 20, 40, or 60 minutes. The default selection is 
5 minutes.

<Type> Rate Chart Displays one of these rate charts for the chosen application server or 
application server process association as a function of time:

• MTP3 Packet Rate Chart

• ASP Packet Rate Chart

• Packets From ASP Rate Chart

• Packets To ASP Rate Chart

• Packets From MTP3 Rate Chart

• Packets To MTP3 Rate Chart

<Type> Rate Chart

(continued)

To see the exact time and data coordinates for a data point, left-click the data 
point. The coordinates appear in the format (hh:mm:ss, dd.dd), where:

• hh:mm:ss is the time for that data point in hours, minutes, and seconds.

• dd.dd is the MTP3 packet rate for that data point.

The Time window (mins) field specifies the total visible time in the chart.

New data points are added to the right side of the chart. When the chart 
reaches the end of the time window (for example, after 5 minutes, if the Time 
window (mins) field is set to 5), new data points continue to be added to the 
right side of the chart, while old data points drop off the left side of the chart.

If a poll is missed (for example, as a result of an SNMP timeout), the MWTM 
ignores the missing data point, stops drawing the line, and waits for the next 
valid data point to begin drawing the line again.

To scroll left, right, up, or down in the chart, drag the cursor while holding 
down Ctrl and the left mouse button.

To zoom in on a section of the chart, drag the cursor while pressing Shift and 
the left mouse button.

To reset the chart to the default view and scaling, click Reset.
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Charts: Links and Linksets

You use the MWTM to view real-time received, sent, and dropped information for the chosen link or 
linkset. To do so, click the Charts tab in the Statistics Details window for a link or linkset, then click the 
relevant tab and the chosen chart appears.

The Statistics Details: Charts section for links and linksets contains:

AS or ASPA Displays color-coded icons for the application server process associations 
associated with the application server, or for the application server process 
association.

To add the data for an application server process association to the chart, click 
the icon in this field. To remove the data from the chart, click the icon again.

You use the MWTM to customize the symbols, line styles, and colors 
assigned to data points in real-time data charts. For more information, see 
Changing Charts Settings, page 5-11.

Reset If you scrolled or zoomed the chart, resets the chart to the default view and 
scaling.

Grid On Superimposes a graphic grid on the chart. The grid can make the data easier 
to read.

Grid Off Removes the graphic grid from the chart.

Help Displays online help for the current window.

Field or Button Description

Tab Description

ReceivedUtilization Displays real-time ReceivedUtilization information for the 
chosen link or linkset.

SendUtilization Displays real-time SendUtilization information for the chosen 
link or linkset.

PktsRcvdPerSec Displays real-time packets-received-per-second information 
for the chosen link or linkset.

PktsSentPerSec Displays real-time packets-sent-per-second information for 
the chosen link or linkset.

BitsRcvdPerSec or BytesRcvdPerSec Displays real-time bits-received-per-second information for 
the chosen link or linkset (or bytes-received-per-second 
information, if you unchecked the Show Details in Bits 
Instead of Bytes check box in the Preferences window).

BitsSentPerSec or BytesSentPerSec Displays real-time bits-sent-per-second information for the 
chosen link or linkset (or bytes-sent-per-second information, 
if you unchecked the Show Details in Bits Instead of Bytes 
check box in the Preferences window).

Drops Displays drops information for the chosen link or linkset.
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The tabs in the Statistics Details: Charts section for links and linksets contain:

Field or Button Description

Linkset Drop-down list box used to select the linkset from whose perspective data 
should be visible.

By default, data appears from the perspective of the chosen linkset. To display 
data from the perspective of the adjacent linkset, select it in this list box.

Time window (mins) Drop-down list box used to specify the length of time visible in the chosen 
chart.

Valid selections are 1, 2, 5, 10, 20, 40, or 60 minutes. The default selection is 
5 minutes.

<Type> Chart Displays one of these charts for the chosen link (and all links on the linkset) 
or linkset (up to 16 links) as a function of time:

• Received Utilization Chart

• Send Utilization Chart

• Packets Received Chart

• Packets Sent Chart

• Bits or Bytes Received Chart

• Bits or Bytes Sent Chart

• Drops Chart

To see the exact time and data coordinates for a data point, left-click the data 
point. The coordinates are visible in the format (hh:mm:ss, dd.dd), where:

• hh:mm:ss is the time for that data point in hours, minutes, and seconds.

• dd.dd is the receive utilization percentage for that data point.

Note (For ReceivedUtilization and SendUtilization only) For serial and 
HSL links on Cisco 7507 and 7513 series routers, the visible 
utilization data can vary by up to 5% from the actual utilization—the 
MWTM might even display utilization data of more than 100%. This 
variance results from the synchronization of Layer 2 counters 
between the Versatile Interface Processor (VIP) CPU and the Route 
Switch Processor (RSP) CPU on 7500 series routers. This variance 
does not occur for links on Cisco 2600, 7200, or 7300 series routers.
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<Type> Chart

(continued)

If more than one link appears in the SLC field, you can compare the visible 
data to that of one or more of the other links by clicking the color-coded icons. 
To remove the data for the additional links, click the icons again.

The Time window (mins) field specifies the total visible time in the chart.

New data points are added to the right side of the chart. When the chart 
reaches the end of the time window (for example, after 5 minutes, if the Time 
window (mins) field is set to 5), new data points continue to be added to the 
right side of the chart, while old data points “drop off” the left side of the 
chart.

If a poll is missed (for example, as a result of an SNMP timeout), the MWTM 
ignores the missing data point, stops drawing the line, and waits for the next 
valid data point to begin drawing the line again.

To scroll left, right, up, or down in the chart, drag the cursor while holding 
down Ctrl and the left mouse button.

To zoom in on a section of the chart, drag the cursor while pressing Shift and 
the left mouse button.

To reset the chart to the default view and scaling, click Reset.

SLC Displays up to 17 color-coded icons. One for:

• Each link (SLC) in the chosen chart, up to 16 total links.

• The average of all SLCs.

To add the data for a link or for the average to the chart, click the icon in this 
field. To remove the data from the chart, click the icon again.

You use the MWTM to customize the symbols, line styles, and colors 
assigned to data points in real-time data charts. For more information, see 
Changing Charts Settings, page 5-11.

Show threshold line for 
(Linksets only, 
ReceivedUtilization or 
SendUtilization)

Draws a horizontal line on the chosen utilization chart, indicating the receive 
and send threshold for the chosen link.

If you do not want to draw a threshold line, select None. This is the default 
setting.

Scale to threshold 
(Linksets only, 
ReceivedUtilization or 
SendUtilization)

Scales the chosen utilization chart in order to draw the threshold chosen in the 
Show threshold line for field. To:

• Scale the chart, check this check box.

• Remove the scaling from the chart, uncheck this check box. This is the 
default setting.

The Scale to threshold check box is not available if the Show threshold line 
for field is set to None.

Reset If you scrolled or zoomed the chart, resets the chart to the default view and 
scaling.

Grid On Superimposes a graphic grid on the chart. The grid can make the data easier 
to read.

Grid Off Removes the graphic grid from the chart.

Help Displays online help for the current window.

Field or Button Description
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Interface Details

You use the MWTM to view real-time interface details for the chosen application server process 
association, link, or signaling gateway-mated pair. 

The Statistics Details: Interface Details section contains:

Configuration Information

The Configuration Information subsection in the Statistics Details: Interface Details section for 
application server process associations, links, and signaling gateway mated pairs contains:

Note This section does not appear if the application server process association, link, or signaling gateway 
mated pair has been offloaded to a Service and Application Module for IP () card.

Section Description

Configuration Information Interface type, speed, and MTU. For SCTP links, this section also 
provides the IP address, mask, and physical address.

Status Information Length of time the interface is up, administrative and operational status, 
and status of the line protocol.

Statistics Information Number of bytes and packets that have been received and transmitted on 
the interface.

Errors Information Number of packet errors and discarded packets.

Field Description

Type Type of interface, such as Ethernet.

MTU Size, in bytes, of the largest datagram that can send or receive on the interface.

Speed (Bits/Sec) Estimate, in bits per second, of the interface’s current bandwidth. If the interface 
does not vary in bandwidth; or, if no accurate estimate can be made, this field 
displays the nominal bandwidth.

IP Address (SCTP links only) IP address corresponding to the media-dependent physical 
address. If the interface does not have such an address (for example, a serial line), 
this field displays N/A.

IP Mask (SCTP links only) Subnet mask corresponding to the media-dependent physical 
address. If the interface does not have such an address (for example, a serial line), 
this field displays N/A.

Physical Address (SCTP links only) Address of the interface at the protocol layer immediately 
below the network layer in the protocol stack. If the interface does not have such 
an address (for example, a serial line), this field displays N/A.
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Status Information

The Status Information subsection in the Statistics Details: Interface Details section for application 
server process associations, links, and signaling gateway mated pairs contains:

Statistics Information

The Statistics Information subsection in the Statistics Details: Interface Details section for application 
server process associations, links, and signaling gateway mated pairs contains:

Field Description

Uptime Time the interface is up, in days, hours, minutes, and seconds.

Admin Status State of the interface. Possible values are:

• Up

• Down

• Testing

Operational Status Current operational state of the interface. Possible values are:

• Up

• Down

• Testing

• Unknown

• Dormant

Line Protocol Status Current state of the line protocol. Possible values are:

• Up—Software processes that handle the line protocol consider the line 
to be usable (that is, keepalives are successful).

• Down—Software processes that handle the line protocol consider the 
line to be unusable.

You can use the Line Protocol together with Operational Status to 
troubleshoot interface connection problems. For example, if Operational 
Status is Up, but Line Protocol is Down, the interface has detected a carrier 
on the physical layer, but clocking or framing problems might occur.

Field Description

Bytes In per Sec Number of bytes received on the interface per second, including framing 
characters.

Bytes Out per Sec Number of bytes sent on the interface per second, including framing 
characters.

Packets In per Sec Number of packets delivered per second to a higher-layer protocol.

Packets Out per Sec Total number of packets that higher-level protocols requested to be sent to 
the network per second, including those that were discarded or not sent.
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Errors Information

The Errors Information subsection in the Statistics Details: Interface Details section for application 
server process associations, links, and signaling gateway mated pairs contains:

Poll Settings

To view or change poll settings for the object’s Statistics Details window in the MWTM client interface, 
click Poll Settings in the left pane. The MWTM displays the Poll Settings pane in the right pane.

The Poll Settings pane contains:

Field Description

In Discards Number of inbound packets that were discarded, even though no errors were detected 
to prevent their delivery to a higher-layer protocol. For example, a packet might be 
discarded to free buffer space.

Out Discards Number of outbound packets that were discarded, even though no errors were 
detected to prevent their delivery to a higher-layer protocol. For example, a packet 
might be discarded to free buffer space.

In Errors Number of inbound packets that contained errors that prevented their delivery to a 
higher-layer protocol.

Out Errors Number of outbound packets that were not sent because of errors.

Field Description

Poll Interval (secs) New poll interval for the object’s Statistics Details window, in seconds.

Enter the new poll interval in this field. The valid range is 15 seconds to 
an unlimited number of seconds. The default value is 15 seconds.

Current Poll Interval Current poll interval for the object’s Statistics Details window, in 
seconds.

Number of Polls Received Total number of polls received since polling began for the object’s 
Statistics Details window.

Running Time Total elapsed time since polling began for the object’s Statistics Details 
window.

Last Message Date and time of the last poll for the object’s Statistics Details window.

Poll Counter Mode Displays the current mode for poll counters, and the date and time that 
counters were last reset. Possible modes are:

• Since Reboot—Counters display values aggregated since the last 
reboot of the node, or since the node last reset the counters.

• Since Last Poll—Counters display values aggregated since the last 
poll.

• Since User Reset—Counters display values aggregated since the 
last time they were reset by the user.

Reset Counters Opens the MWTM Reset Counters dialog box, which you use to change 
MWTM poller and counter settings. For more information, see 
Changing Real-Time Poller and Counter Settings, page 5-21.
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Q.752 Measurements

The Statistics Details: Q.752 Measurements section for links contains:

• Error Information, page 8-76

• Inhibited Information, page 8-76

• Retransmitted Information, page 8-76

• Congested Information, page 8-77

Statistics for links associated with the chosen linkset are visible in the left column, and for links 
associated with the adjacent linkset in the right column.

Error Information

The Error Information subsection contains:

Inhibited Information

The Inhibited Information subsection contains:

Retransmitted Information

The Retransmitted Information subsection contains:

Field Description

Link Failure Count Number of times the link was unavailable for signaling.

Alignment Error Count Number of errors detected during link alignment. Link alignment occurs 
at start up, or when trying to bring up a failed link.

Negative ACKs Count Number of errors detected during link acknowledgement. 

Status Indicator Busy Count Number of times the Status Indicator Busy was received.

Field Description

Local Inhibit Onset Number of times a local ITP administrator has inhibited the link (that 
is, set the link to prevent traffic from flowing).

Local Inhibit Duration % Percentage of time the link is locally inhibited since the last reboot of 
the ITP, or since ITP last reset the counters.

Remote Inhibit Onset Number of times a remote ITP administrator has inhibited the link.

Remote Inhibit Duration % Percentage of time the link is remotely inhibited since the last reboot 
of the ITP, or since ITP last reset the counters.

Field Description

Packets Retransmitted per Sec Number of packets that the link transmits, per second.

Bytes Retransmitted per Sec Number of bytes that the link transmits, per second.
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Congested Information

The Congested Information subsection contains:

Local Automatic Change Over 
Count

Number of local automatic changeover events detected.

Local Automatic Change Back 
Count

Number of local automatic changeback events detected.

Field Description

Field or Column Description

Congestion Occurrences Number of times congestion has occurred on the link.

Congestion Duration % Percentage of time the link is congested since the last reboot of the ITP, 
or since ITP last reset the counters.

Congestion Level Level of congestion: 1, 2, or 3.

Packets Lost Number of packets lost by the link as a result of congestion at each level.

Packets Lost per Sec Number of packets per second that the link loses, as a result of 
congestion at each level.

Times At Level With Packet 
Loss

Number of times the link is congested and has lost packets at each level.
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Right-Click Menu

The Statistics Details window for a link in the MWTM client interface provides a right-click menu. To 
see this menu, right-click a link in the navigation tree of the Statistics Details window. The menu 
displays:

SCTP Association Configuration Details

You use the MWTM to view Stream Control Transmission Protocol (SCTP) association configuration 
details for the chosen application server process association, link, or signaling gateway-mated pair.

The Statistics Details: SCTP Assoc. Config Details section contains:

Menu Command Description

Delete Item Deletes the currently chosen link from the MWTM database. The MWTM displays 
the Confirm Deletion dialog box, To:

• Delete the chosen link, click Yes. The MWTM deletes the link from the 
MWTM database and closes the Confirm Deletion dialog box.

• Retain the chosen link, click No. The MWTM retains the link in the MWTM 
database and closes the Confirm Deletion dialog box.

• Prevent the MWTM from displaying the Confirm Deletion dialog box, check 
the Do not show this again check box.

Note If you check the Do not show this again check box, and you later decide 
you want the MWTM to begin displaying the Confirm Deletion dialog box 
again, you must check the Confirm Deletions check box in the General GUI 
settings in the Preferences window. For more information, see the 
description of the Confirm Deletions check box in Startup/Exit Settings, 
page 5-4.

If you have implemented MWTM User-Based Access, this option is available to 
users with authentication level Network Administrator (level 4) and higher.

Ignore Item Ignores the link that you click at the next polling cycle.

If you have implemented MWTM User-Based Access, this option is available to 
users with authentication level Power User (level 2) and higher.

Unignore Item Stops ignoring the chosen link at the next polling cycle.

If you have implemented MWTM User-Based Access, this option is available to 
users with authentication level Power User (level 2) and higher.

Section Description

Configuration Information Status information, length of time the link is up, remote and 
local numbers, and IP address information.

Local IP Address Information Local IP addresses associated with the link and the length 
of time each address is up.
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Configuration Information

The Configuration Information subsection in the Statistics Details: SCTP Assoc. Config Details section 
for application server process associations, SCTP links, and signaling gateway mated pairs contains:

Local IP Address Information

The Local IP Address Information subsection in the Statistics Details: SCTP Assoc. Config Details 
section for application server process associations, SCTP links, and signaling gateway mated pairs 
contains:

Remote IP Address Information Remote IP addresses associated with the link, the length of 
time each address is up, and SCTP retry information.

Transmission Configuration Information The MTU, number of inbound and outbound streams, retry 
timeouts, local and remote receive window sizes, and 
chunk bundling information.

Section Description

Field Description

Status Current status of the SCTP association. Possible values are:

• Closed

• CookieWait

• CookieEchoed

Status (continued) • DeleteTCB

• Established

Status (continued) • ShutdownAckSent

• ShutdownPending

• ShutdownReceived

• ShutdownSent

For detailed information about each status, refer to RFC 2960, Stream Control 
Transmission Protocol.

Uptime Time the link is up, in days, hours, minutes, and seconds.

Remote Port Remote port number for the SCTP association.

Local Port Local port number for the SCTP association.

Primary IP Address Designated primary IP address for the SCTP association.

Effective IP Address IP address that the SCTP association uses.

Field Description

IP Address Local IP addresses associated with the link.

Uptime Time each local IP address associated with the link is up, in days, hours, 
minutes, and seconds.
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Remote IP Address Information

The Remote IP Address Information subsection in the Statistics Details: SCTP Assoc. Config Details 
section for application server process associations, SCTP links, and signaling gateway mated pairs 
contains:

Transmission Configuration Information

The Transmission Configuration Information subsection contains:

Field Description

IP Address Remote IP addresses associated with the link.

Uptime Time each remote IP address associated with the link is up, in days, hours, 
minutes, and seconds.

Retry Timeout (msecs) Current SCTP Retransmission Timeout (T3-rtx timer).

Maximum Retries Maximum allowable number of retransmissions before this IP address is 
considered inactive.

Retries Current retransmission count.

Field Description

MTU Maximum transmission unit (MTU) size that this SCTP association uses. Out 
of the IP addresses that the SCTP association uses, the smallest size that is 
supported.

In Streams Inbound streams as negotiated when the SCTP association was started.

Out Streams Outbound streams as negotiated when the SCTP association was started.

Maximum Retries Maximum number of data retransmissions in the SCTP association context.

Local Receive window 
Size

Current local receive window size for this SCTP association.

Remote Receive 
window Size

Current local send window size for this SCTP association.

Initial Retry Timeout 
(msecs)

Initial timeout value, in milliseconds, that the SCTP implementation permits 
for the retry timeout.

Minimum Retry 
Timeout (msecs)

Minimum timeout value, in milliseconds, that the SCTP implementation 
permits for the retry timeout.

Maximum Retry 
Timeout (msecs)

Maximum timeout value, in milliseconds, that the SCTP implementation 
permits for the retry timeout.

Bundle Chunks Indicates whether the SCTP protocol allows chunks to be bundled into a 
single datagram as follows. Valid values are:

• true (1)—Chunks are bundled.

• false (2)—Chunks are not bundled.

Bundle Timeout 
(msecs)

Time, in milliseconds, to wait to allow data chunks to accumulate so that 
they can be transmitted in the same datagram.
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SCTP Association Statistics Details

You use the MWTM to view Stream Control Transmission Protocol (SCTP) association statistics details 
for the chosen application server process association, link, or signaling gateway-mated pair. 

The Statistics Details: SCTP Assoc. Stats Details section contains:

Remote IP Address Information

The Remote IP Address Information subsection in the Statistics Details: SCTP Assoc. Stats Details 
section for application server process associations, SCTP links, and signaling gateway mated pairs 
contains:

Statistics Information (per sec) Rates

The Statistics Information (per sec) Rates subsection in the Statistics Details: SCTP Assoc. Stats Details 
section for application server process associations, SCTP links, and signaling gateway mated pairs 
contains:

Section Description

Remote IP Address Information IP addresses, round-trip times, failure counts, and 
IP address status and heartbeat.

Statistics Information (per sec) Rates Sent and received counts for packets and chunks.

Field Description

IP Address Remote IP addresses associated with the link.

Smoothed Round Trip 
Time (msecs)

Average, in milliseconds, of all round-trip times between the local and 
remote systems on an IP network.

Failure Count Number of times the remote IP address was marked as failed.

Heartbeat Status Current status of the heartbeat associated with the remote IP address. Valid 
values are Active and Inactive.

IP Status Current status of the remote IP address. Valid values are Active and Inactive.

Field Description

Packets Sent Number of IP datagrams that this SCTP association sends per second.

Packets Received Number of IP datagrams that this SCTP association receives per second.

Control Chunks Sent Number of control chunks that this SCTP association sends per second.

Control Chunks Rec Number of control chunks that this SCTP association receives per 
second.

Ordered Chunks Sent Number of ordered chunks that this SCTP association sends per second.

Ordered Chunks Rec Number of ordered chunks that this SCTP association receives per 
second.

Unordered Chunks Sent Number of unordered chunks that this SCTP association sends per 
second.
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Statistics: Application Servers

You use the MWTM to view statistics for a chosen application server. 

The Statistics Details: Statistics tab contains:

Statistics: Application Server Process Associations

You use the MWTM to view statistics for a chosen application server process association. 

The Statistics Details: Statistics tab contains:

• Packets Per Second Information, page 8-83

• Error Information, page 8-83

• ASP Initialization Counters, page 8-83

• Signaling Congestion Counters, page 8-84

• Destination Counters, page 8-84

Unordered Chunks Rec Number of unordered chunks that this SCTP association receives per 
second.

Retransmitted Chunks Number of chunks that this SCTP association retransmits per second.

Retransmitted Fast Chunks Number of fast chunks that this SCTP association retransmits per 
second.

Field Description

Field Description

Active Duration Total time the application server is in service since the last reboot of 
the ITP, or since ITP last reset the counters.

MTP3 Packet Rate (per sec) Number of MTP3 packets that the application server receives per 
second.

This field initially displays the description Waiting for second 
poll. After two polling cycles, the MWTM populates this field with 
actual calculated rates.

ASP Packet Rate (per sec) Number of application server process packets that the application 
server sends per second.

This field initially displays the description Waiting for second 
poll. After two polling cycles, the MWTM populates this field with 
actual calculated rates.
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Packets Per Second Information

The Packets Per Second Information section in the Statistics Details: Statistics tab for application server 
process associations contains:

Error Information

The Error Information section in the Statistics Details: Statistics tab for application server process 
associations contains:

ASP Initialization Counters

The ASP Initialization Counters section in the Statistics Details: Statistics tab for application server 
process associations contains:

Field Description

Packets From ASP Number of packets that the application server receives per second.

Packets To ASP Number of packets that the application server sends per second.

Packets From MTP3 Number of packets that the MTP3 layer receives per second.

Packets To MTP3 Number of packets that the MTP3 layer sends per second.

Field Description

Errors Received Total number of error (ERR) messages that the application server process 
association receives.

Errors Sent Total number of error (ERR) messages that the application server process 
association sends.

Field Description

Up Messages Received Total number of application server process up (ASPUP) messages 
that the application server process association receives.

Up ACK Messages Sent Total number of application server process up acknowledgement 
(UPACK) messages that the application server process 
association sends.

Down Messages Received Total number of application server process down (ASPDN) 
messages that the application server process receives.

Down ACK Messages Sent Total number of application server process down 
acknowledgement (DOWNACK) messages that the application 
server process association sends.

Activation Messages Received Total number of application server process active messages that 
the application server process association receives.

Activation ACK Messages Sent Total number of application server process active 
acknowledgement messages that the application server process 
association sends.
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Signaling Congestion Counters

The Signaling Congestion Counters section in the Statistics Details: Statistics tab for application server 
process associations contains:

Destination Counters

The Destination Counters section in the Statistics Details: Statistics tab for application server process 
associations contains:

Inactive Messages Received Total number of application server process inactive messages that 
the application server process association receives.

Inactive ACK Messages Sent Total number of application server process inactive 
acknowledgement messages that the application server process 
association sends.

Field Description

Field Description

Level 0 Messages Received Total number of signaling congestion level 0 (SCON0) messages that 
the application server process receives.

Level 1 Messages Received Total number of signaling congestion level 1 (SCON1) messages that 
the application server process receives.

Level 2 Messages Received Total number of signaling congestion level 2 (SCON2) messages that 
the application server process receives.

Level 3 Messages Received Total number of signaling congestion level 3 (SCON3) messages that 
the application server process receives.

Level 0 Messages Sent Total number of signaling congestion level 0 (SCON0) messages that 
the application server process sends.

Level 1 Messages Sent Total number of signaling congestion level 1 (SCON1) messages that 
the application server process sends.

Level 2 Messages Sent Total number of signaling congestion level 2 (SCON2) messages that 
the application server process sends.

Level 3 Messages Sent Total number of signaling congestion level 3 (SCON3) messages that 
the application server process sends.

Field Description

Unavailable Messages 
Received

Total number of destination unavailable (DUNA) messages that the 
application server process association receives.

Unavailable Messages 
Sent

Total number of destination unavailable (DUNA) messages that the 
application server process association sends.

Available Messages 
Received

Total number of destination available (DAVA) messages that the application 
server process association receives.

Available Messages 
Sent

Total number of destination available (DAVA) messages that the application 
server process association sends.
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Statistics: Links and Linksets

You use the MWTM to view statistics for a chosen link or linkset. 

The Statistics Details: Statistics tab contains:

• Packet Information, page 8-85

• Bit Information or Byte Information, page 8-86

• LSSU Information (Links Only), page 8-86

• Utilization Information, page 8-87

• Service Information, page 8-88

Statistics for links associated with the chosen linkset are visible in the left column, and for links 
associated with the adjacent linkset in the right column.

Packet Information

The Packet Information section in the Statistics Details: Statistics tab for links and linksets contains:

User Part Unavailable 
Messages Received

Total number of destination user part unavailable (DUPU) messages that the 
application server process association receives.

User Part Unavailable 
Messages Sent

Total number of destination user part unavailable (DUPU) messages that the 
application server process association sends.

State Audit Messages 
Received

Total number of destination state audit (DAUD) messages that the 
application server process association receives.

State Audit Messages 
Sent

Total number of destination state audit (DAUD) messages that the 
application server process association sends.

Field Description

Field Description

Sent Per Sec Number of packets that the link or linkset sends per second.

This field initially displays the description Waiting for second poll. 
After two polling cycles, the MWTM populates this field with actual 
calculated rates.

Received Per Sec Number of packets that the link or linkset receives per second.

This field initially displays the description Waiting for second poll. 
After two polling cycles, the MWTM populates this field with actual 
calculated rates.

Drops Total number of packets that have been dropped by the link or linkset.

Transmit Queue Depth 
(links only)

Number of packets waiting to be sent on by the link.

Transmit Queue High Depth 
(links only)

Highest level reached by the transmit queue since the last reboot of the 
ITP, or since ITP last reset the averages as a result of bad data.
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Bit Information or Byte Information

The Bit Information section (or Byte Information section, if you unchecked the Show Details in Bits 
Instead of Bytes check box in the Preferences window) in the Statistics Details: Statistics tab for links 
and linksets contains these fields:

LSSU Information (Links Only)

The Links Status Signal Unit (LSSU) section in the Statistics Details: Statistics tab for links contains:

Transmit Queue High Reset 
(links only)

Level at which the link is to reset the transmit queue. If the link is never 
to reset the transmit queue, this field displays Never.

Signal Link Test (links only) Indicates whether test packets are being sent on the link. Valid values 
are:

• true (1)—Test packets are being sent.

• false (2)—Test packets are not being sent.

Field Description

Field Description

Sent Per Sec Number of bits or bytes (as set in the Preferences window) that the link or 
linkset sends per second.

This field initially displays the description Waiting for second poll. After 
two polling cycles, the MWTM populates this field with actual calculated 
rates.

Received Per Sec Number of bits or bytes (as set in the Preferences window) that the link or 
linkset receives per second.

This field initially displays the description Waiting for second poll. 
After two polling cycles, the MWTM populates this field with actual 
calculated rates.

Field Description

LSSU Packets Sent Total number of LSSU packets that the link sends.

LSSU Packets Received Total number of SS7 Message Transfer Part Layer 2 (MTP2) LSSU 
packets that the link receives.
8-86
User Guide for the Cisco Mobile Wireless Transport Manager 6.1

OL-9118-01



 

Chapter 8      Understanding Detailed Object Functions
  Viewing Real-Time Data
Utilization Information

The Utilization Information section in the Statistics Details: Statistics tab for links and linksets contains:

Field Description

Send Plan Capacity Planned capacity of the link or linkset to send, in bits per second. For a link 
or linkset of type:

• Serial or HSL, available bandwidth for the link/linkset.

• SCTPIP (or Mixed for linksets), set on the ITP by using the 
plan-capacity CS7 link or linkset configuration command.

If Send Plan Capacity is not set on the ITP for this link or linkset, this 
field displays the value 0.

• Other, this field always displays the value 0.

% Amount of the link or linkset’s send capacity being used, as a percentage or 
in Erlangs (E) as set in the Preferences window, calculated by using this 
formula:

Send Utilization = (Bits Sent Per Sec)/Planned Capacity

%

(continued)

This field initially displays the description Waiting for second poll. 
After two polling cycles, the MWTM populates this field with actual 
calculated rates. For a link or linkset of type:

• SCTPIP (or Mixed for linksets), if Send Plan Capacity is not set on the 
ITP for this link, or for one or more of the links associated with this 
linkset, this field displays the description Set Plan Capacity on ITP.

• Other, this field always displays the description Set Plan Capacity on 
ITP.

Send Threshold % (links 
only)

Indicates when to generate the MWTM a cItpSpLinkSentUtilChange for the 
link, as a percent of its total send capacity. For example, if Send Plan 
Capacity is 64,000 bits per second, and Send Threshold % is 50, then the 
MWTM generates a cItpSpLinkSentUtilChange notification when the link 
reaches 50% of 64,000, or 32,000 bits per second.

Receive Plan Capacity Planned capacity of the link or linkset to receive, in bits per second. For a 
link or linkset of type:

• Serial or HSL, available bandwidth for the link.

• SCTPIP (or Mixed for linksets), set on the ITP using the plan-capacity 
CS7 link/linkset configuration command.

If Receive Plan Capacity is not set on the ITP for this link or linkset, 
this field displays the value 0.

• Other, this field always displays the value 0.
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Service Information

The Service Information section in the Statistics Details: Statistics tab for links and linksets contains:

Status Details

You use the MWTM to view status details for a chosen link. 

The Statistics Details: Status Details tab contains:

Receive Utilization % Amount of the link or linksets receive capacity being used, as a percentage 
or in Erlangs (E) as set in the Preferences window, calculated by using this 
formula:

Receive Utilization = (Bits Received Per Sec)/Receive Plan Capacity

This field initially displays the description Waiting for second poll. 
After two polling cycles, the MWTM populates this field with actual 
calculated rates. For a link or linkset of type:

• SCTPIP (or Mixed for linksets), if Receive Plan Capacity is not set on 
the ITP for this link, or for one or more of the links associated with this 
linkset, this field displays the description Set Plan Capacity on ITP.

• Other, this field always displays the description Set Plan Capacity on 
ITP.

Receive Threshold % 
(links only)

Indicates when to generate the MWTM a cItpSpLinkRcvdUtilChange for 
the link, as a percent of its total receive capacity. For example, if Receive 
Plan Capacity is 64,000 bits per second, and Receive Threshold % is 50, 
then the MWTM generates a cItpSpLinkRcvdUtilChange notification when 
the link reaches 50% of 64,000, or 32,000 bits per second.

Field Description

Field Description

Duration In Service % Percentage of time the link or linkset is in service since the last reboot of 
the ITP, or since ITP last reset the counters.

Duration Out Of 
Service %

Percentage of time the link or linkset is out of service since the last reboot 
of the ITP, or since ITP last reset the counters.

MTP3 Accounting 
Enabled (linksets only)

Indicates whether the collection of MTP3 accounting statistics is enabled 
for the linkset.

If the linkset is a Virtual linkset, this field displays N/A.

GTT Accounting 
Enabled (linksets only)

Indicates whether the collection of GTT accounting statistics is enabled for 
the linkset.

For Cisco IOS software releases prior to 12.2(4)MB10, this field displays 
Unknown.

If the linkset is a Virtual linkset, this field displays N/A.
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Column Description

Protocol State Details Detailed information about the state of the protocol for this link. Possible 
values are:

• Changeback control (TCBC)—Changeback control is buffering data on 
this link.

• Changeover control (TCOC)—Changeover control is buffering data on 
this link.

• Link availability control (TLAC)—Adjacent Signalling point is 
restarting.

• Link availability control (TLAC)—Emergency changeover is in 
progress on this link.

• Link availability control (TLAC)—Changeback is in progress on this 
link.

• Link availability control (TLAC)—Changeover is in progress on this 
link.

• Link availability control (TLAC)—The last changeover operation 
failed on this link.

• Link availability control (TLAC)—Inhibit command will be retried.

Protocol State Details

(continued)

• Link availability control (TLAC)—Management request in progress for 
this link.

• Link availability control (TLAC)—Signalling point is in the process of 
a restart.

• Signalling routing control (TSRC)—Changeover request is complete.

• Signalling routing control (TSRC)—Adjacent Signalling Point is 
restarting.

• Link availability control (TLAC)—Link is inhibited by a local 
management operation.

• Link availability control (TLAC)—Link is inhibited by a remote 
management operation.

• Link availability control (TLAC)—Link is blocked because of a local 
processor outage.

• Link availability control (TLAC)—Link is blocked because of a remote 
processor outage.
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Link Test Results Indicates the results of the link test. Possible results are:

• No Errors—The link did not detect any errors.

• Undefined OPC (Origination Point Code)—A signaling link test 
message arrived with an undefined OPC. This scenario can occur when a 
serial link connects incorrectly, or when you configure an SCTP link 
incorrectly. This scenario differs from Incorrect OPC because the 
signaling point is unaware of the point code in question. The point code 
is not defined for any linkset on this ITP.

• Incorrect OPC—A signaling link test message arrived with an incorrect 
OPC. This scenario can occur when a serial link connects incorrectly, or 
when you configure an SCTP link incorrectly. This scenario differs from 
Undefined OPC because the signaling point is aware of the point code 
in question, and the point code is defined for a linkset on this ITP, but the 
point code is not correct for the current linkset.

• Undefined SLC (Signaling Link Code)—A signaling link test message 
arrived with an undefined SLC. This scenario can occur when a serial link 
connects incorrectly, or when you configure an SCTP link incorrectly. 
The link connects to the correct linkset, but the linkset does not have a 
definition for the SLC in question.

• Incorrect SLC—A signaling link test message arrived with an incorrect 
SLC. This scenario can occur when a serial link connects incorrectly, or 
when you configure an SCTP link incorrectly. The link connects to the 
correct linkset, but to the wrong link in that linkset. That is, the signaling 
test receives the test packet on the wrong link.

Link Test Results

(continued)

• Incorrect NI (Network Indicator)—A signaling link test message 
arrived with an incorrect NI. This scenario can occur when links connect 
to the correct linkset and link, but the NIs of the two adjacent point codes 
are not the same.

• Bad Pattern—A signaling link test message arrived with an incorrect 
test pattern. This error occurs because the test pattern is corrupt. This 
scenario usually indicates a hardware or configuration issue related to the 
physical format of the data on the links, caused by a variant mismatch or 
incorrect definitions on the physical link.

• Non Adjacent—Received a signaling link test message from a 
nonadjacent node.

• Failed—Unable to run the test, or no response arrived in the specified 
interval.

Column Description
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Link Fail Reason If the link failed the link test, indicates the reason for the failure. Possible 
reasons are:

• None—No additional reason available.

• Changeover in progress—Changeover is in progress. This message 
diverts traffic away from a failed link.

• Management disconnect request—An MTP3 sent a request to stop the 
link.

• Link alignment lost—Link alignment is lost.

A link is in alignment when signal units are received in sequence, and 
with the proper number of octets. The signal unit must be a total length 
of eight-bit multiples. If the signal unit is not of eight-bit multiples, or if 
the signaling information field (SIF) exceeds the 272-octet capacity, the 
signaling unit is considered to be in error. If excessive errors are 
encountered on a link, it is considered to be out of alignment.

For M2PA links, this state reason is generated when the M2PA alignment 
timer T1 expires. This could indicate that the remote link is shutdown, or 
that intermittent IP connectivity problems exist.

• Link connection lost—Link connection is lost.

• Local Disconnect—A request to disconnect the link is received, but the 
link is already disconnected.

• Remote Disconnect—A remote disconnect request is received.

• Signal unit error rate monitor failure—The signal unit error rate 
monitor has failed.

• T1 timeout no FISU received—A T1 timeout no FISU is received. This 
timer avoids message mis-sequencing during changeover.

• T2 timeout no SIO received—A T2 timeout no SIO is received. This 
timer waits for a changeover acknowledgment.

Column Description
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Link Fail Reason

(continued)

• T3 timeout no SIN received—A T3 timeout no SIN is received. This 
timer controls diversion-delay to avoid mis-sequencing on changeback.

• T6 timeout excessive congestion—A T6 timeout excessive congestion is 
received. This timer avoids message mis-sequencing on controlled 
rerouting.

• T7 timeout excessive acknowledgement delay—A T7 timeout 
excessive acknowledgment delay is received. The T7 timer prevents a 
signaling point from waiting too long for a positive or negative 
acknowledgment. Usually, an acknowledgment is sent when a signaling 
point becomes idle and does not have any more traffic to transmit. When 
congestion occurs at a signaling point, or an extreme amount of traffic is 
present, the T7 could possibly time out and force retransmission of 
messages.

• Link proving failure—A link proving failure occurred.

• Abnormal BSN received—An abnormal Backward Sequence Number 
(BSN) is received.

• Abnormal FIB received—An abnormal Forward Indicator Bit (FIB) is 
received.

• Abnormal SIB received—An abnormal Status Indicator Busy (SIB) is 
received.

• Abnormal LSSU received—An abnormal Link Status Signal Unit 
(LSSU) is received.

• Peer not ready—An MTP3 tried to bring up a link that is still cleaning 
up after being stopped. In some cases, the MTP3 does not change over 
after a link failure, so the M2PA or SCTP waits for an event that will not 
occur. When an MTP3 tries to bring up the link again, the previous 
control structures must first be cleaned up. If M2PA gets a start request 
from an MTP3, and the previous structures are still being held, M2PA 
cleans them up and sends a PEER NOT READY to the MTP3 layer. A 
subsequent request to start the link from the MTP3 layer will then cause 
the link to come up.

• Communication lost—M2PA or SCTP has determined that the remote 
end signaling point is no longer reachable. Possible reasons include:

– The maximum number of consecutive retries of a packet is reached.

– In the absence of data, the MWTM failed to receive heartbeat ACKs 
in response to heartbeats, for the maximum number of retries.

• No Listen posted—An MTP3 tried to start a link, but the local-peer port 
associated with the link is not available, probably because of a bad 
configuration.

• Unable to allocate buffer—M2PAor SCTP cannot get buffers for 
sending or receiving packets. Buffer problems can be temporary or 
permanent. Temporary buffer problems will generally clear with little 
side effects. Permanent buffer problems can lead to failed linksets or 
links.

Column Description
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Viewing ITP MTP3 Errors
The ITP MTP3 Errors table displays all MTP3 error information for the chosen ITP node.

If you have implemented MWTM User-Based Access, this option is available to users with 
authentication level System Administrator (level 5).

Note In the MWTM client, the real-time icon  appears in the tab. This icon indicates that polling will 
periodically occur while this window is open. To prevent unnecessary traffic on your network, close this 
window (for example, by clicking a different tab) when you no longer need to view the real-time data.

The MTP3 Errors section displays these columns for the chosen node:

Link Fail Reason

(continued)

• Link card removed—A link card is removed.

• Link card inserted—A link card is inserted.

• False link congestion—A false link congestion indication is received.

• Configuration downloading—The configuration is downloading.

• Locally inhibited—The link is locally inhibited by operator request.

• Locally uninhibited—An operator request locally uninhibited the link.

• Remotely inhibited—The link is remotely inhibited by operator request.

• Remotely uninhibited—The link is remotely uninhibited by operator 
request.

• Locally blocked—The link is blocked locally.

• Locally unblocked—The link is unblocked locally.

• Remotely blocked—The link is remotely blocked.

• Remotely unblocked—The link is remotely unblocked.

Column Description

Column Description

Reset Counters Opens the MWTM Reset Counters dialog box, which you use to change 
MWTM poller and counter settings. For more information, see Changing 
Real-Time Poller and Counter Settings, page 5-21.

Poll Counter Mode Displays the current mode for poll counters, and the date and time that counters 
were last reset. Possible modes are:

• Since Reboot—Counters display values aggregated since the last reboot 
of the ITP, or since ITP last reset the counters.

• Since Last Poll—Counters display values aggregated since the last poll.

• Since User Reset—Counters display values aggregated since the last time 
they were reset by the user.

Poll Interval Poll interval used to collect data for the table.
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Viewing ITP MSU Rates
The ITP MSU Rates table displays all MSU rate information in charts for the chosen ITP node.

Note In the MWTM client, the real-time icon  appears in the tab. This icon indicates that polling will 
periodically occur while this window is open. To prevent unnecessary traffic on your network, close this 
window (for example, by clicking a different tab) when you no longer need to view the real-time data.

Figure 8-4 MSU Rates Tab

The MSU Rates tab contains a Summary sub-tab, showing totals for all MSU rates. Each additional 
sub-tab shows MSU rates for a specific CPU (for example, 0/0 shows CPU 0 located in slot 0). The status 
ball on the sub-tab indicates the current threshold level of the CPU.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first 
polling cycle, the MWTM populates this field with the actual time of the last 
poll.

Count Number of times the indicated MTP3 error type was detected.

Error Description Description of the MTP3 error type.

Column Description
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Right-click Menu

A right-click context menu provides options to modify how the chart appears:

Viewing ITP Non-Stop Operation
Non-Stop Operation (NSO) is an implementation of redundant data elements and software functionality 
that enables networks to approach 99.999% availability. The ITP Non-Stop Operation table displays 
detailed information about all NSO settings associated with the chosen node.

To view the Non-Stop Operation section, in a view in the navigation tree, select an ITP node, then click 
on the Non-Stop Operation tab in the content area. This tab appears only for Cisco 7500 and Cisco 7600 
nodes.

Note In the MWTM client, the real-time icon  appears in the tab. This icon indicates that polling will 
periodically occur while this window is open. To prevent unnecessary traffic on your network, close this 
window (for example, by clicking a different tab) when you no longer need to view the real-time data.

GUI Elements Description

Change Poller Button that opens the Poller Settings dialog box. See Change Poller, page 8-110.

Poll Interval Label that shows the current poll interval in seconds.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first polling 
cycle, the MWTM populates this field with the actual time of the last poll.

MSUs / sec Y-axis label that displays traffic rate in MSUs per second.

Time X-axis label that displays a real-time scale.

Legend Identifies the data series currently showing in the chart. 

• No Data—Data is not available. A vertical bar appears in the chart.

• CPU Threshold Crossed—One or more CPUs have crossed a processing 
threshold.

Menu options Description

Hide > field Hides the currently shown data series.

Show > field Shows the currently shown data series.

Reset Zoom If you have zoomed into a specific area of the chart, resets the zoom. 

Note To zoom into a specific area of the chart, use the left mouse button to drag 
a box around the area.

Grid On Displays a grid on the chart.

Grid Off Removes the grid from the chart.

Shapes On Displays individual data points as shapes on the rate lines and the chart legend.

Shapes Off Removes shapes from the rate lines and the chart legend.
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The Non-Stop Operation table displays these columns for the chosen node:

Column Description

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the 
first polling cycle, the MWTM populates this field with the actual 
time of the last poll.

Configuration: Split Mode Indicates whether redundant units can communicate 
synchronization messages with each other:

• Enabled—Communication is not permitted. The active unit 
does not communicate with the standby unit, and the standby 
unit progression does not occur. This mode can be useful during 
maintenance.

• Disabled—Communication is permitted. The active unit 
communicates with the standby unit, and the standby unit is 
reset to recover.

Configuration: 
Keepalive Threshold

On platforms that support keepalives, this field indicates the number 
of lost keepalives allowed before a failure occurs. If a failure occurs, 
a Switch of Activity (SWACT) notification switches the active unit 
to standby status, and vice versa.

On platforms that do not support keepalives, this field has no 
meaning.

Configuration: 
Keepalive Threshold Min

Minimum acceptable value for the Keepalive Threshold.

Configuration: 
Keepalive Threshold Max

Maximum acceptable value for the Keepalive Threshold.

Configuration: Keepalive Timer 
(msecs)

On platforms that support keepalives, this timer guards against lost 
keepalives. If the RF subsystem does not receive a keepalive before 
this timer expires, a SWACT notification switches the active unit to 
standby status, and vice versa.

On platforms that do not support keepalives, this field has no 
meaning.

Configuration: 
Keepalive Time Min (msecs)

Minimum acceptable value for the Keepalive Timer.

Configuration: 
Keepalive Time Max (msecs)

Maximum acceptable value for the Keepalive Timer.
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Configuration: 
Notification Timer (msecs)

RF notification timer. As the standby unit progresses to the Hot 
Standby state, the active unit sends asynchronous messages to the 
standby unit, which then sends an acknowledgment back to the 
active unit. If the active unit:

• Receives the acknowledgement before this timer expires, the 
standby unit progresses normally.

• Does not receive a acknowledgement before this timer expires, 
a SWACT notification switches the active unit to standby status, 
and vice versa.

Configuration: 
Notification Timer Min (msecs)

Minimum acceptable value for the Notification Timer.

Configuration: 
Notification Timer Max (msecs)

Maximum acceptable value for the Notification Timer.

Configuration: RF Notification Indicates whether RF system notification is enabled or disabled.

Configuration: 
Maintenance Mode

Indicates whether the redundant system is in maintenance mode:

• Enabled—The redundant system is in maintenance mode. The 
active unit does not communicate with the standby unit, and the 
standby unit progression does not occur.

• Disabled—The redundant system is in normal operation mode, 
not maintenance mode. The active unit communicates with the 
standby unit, and the standby unit is reset to recover.

Column Description
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Configuration: 
Redundancy Mode

Redundancy mode configured on this system. Possible values are:

• Cold Standby Redundant—This system is configured for 
redundancy, but the redundant peer unit is not fully initialized 
and cannot retain established calls.

• Dynamic Load Share NonRedundant—This system is not 
configured for redundancy, but it is load-sharing. The 
load-sharing is based on the operational load (that is, it is based 
on the number of calls, or some other factor).

• Static Load Share Redundant—This system is configured for 
redundancy, and it is load-sharing. The load-sharing is based on 
the operational load.

• NonRedundant—This system is not configured for 
redundancy, and it is not load-sharing.

• Static Load Share NonRedundant—This system is not 
configured for redundancy, but it is load-sharing. The 
load-sharing is not based on the operational load.

• Static Load Share Redundant—This system is configured for 
redundancy, and it is load-sharing. The load-sharing is not 
based on the operational load.

• Warm Standby Redundant—This system is configured for 
redundancy, and the redundant peer unit can immediately 
handle new calls, but it cannot retain established calls.

• Hot Standby Redundant—This system is configured for 
redundancy, the redundant peer unit can immediately handle 
new calls, and it can instantaneously retain established calls.

Configuration: 
Redundancy Mode Descr

Additional clarification or description of the Redundancy Mode.

Configuration: 
Oper Redundancy Mode

Operational redundancy mode of this unit. Possible values are:

• Cold Standby Redundant—This unit is configured for 
redundancy, but the redundant peer unit is not fully initialized 
and cannot retain established calls.

• Dynamic Load Share NonRedundant—This unit is not 
configured for redundancy, but it is load-sharing. The 
load-sharing is based on the operational load (that is, it is based 
on the number of calls, or some other factor).

Column Description
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Configuration: 
Oper Redundancy Mode

(continued)

• Static Load Share Redundant—This unit is configured for 
redundancy, and it is load-sharing. The load-sharing is based on 
the operational load.

• NonRedundant—This unit is not configured for redundancy, 
and it is not load-sharing.

• Static Load Share NonRedundant—This unit is not 
configured for redundancy, but it is load-sharing. The 
load-sharing is not based on the operational load.

• Static Load Share Redundant—This unit is configured for 
redundancy, and it is load-sharing. The load-sharing is not 
based on the operational load.

• Warm Standby Redundant—This unit is configured for 
redundancy, and the redundant peer unit can immediately 
handle new calls, but it cannot retain established calls.

• Hot Standby Redundant—This unit is configured for 
redundancy, the redundant peer unit can immediately handle 
new calls, and it can instantaneously retain established calls.

History: Cold Starts Number of system cold starts, including automatic and manual 
SWACTs, since the last system initialization.

History: Available Standby Time Cumulative time that a standby redundant unit is available since the 
last system initialization.

Current Status: Unit ID Unique identifier for this redundant unit.

Current Status: Unit State Current RF status for this unit. Possible values are:

• Active—Active and is processing calls.

• Active Drain—Performing client cleanup.

• Active Extra Load—Active and is processing calls for all 
feature boards in the system.

• Active Fast—Performing call maintenance during a SWACT 
notification.

• Active Handback—Active, is processing calls, and is handing 
off some resources to the other RF unit.

• Active Preconfiguration—Active but has not yet read its 
configuration.

• Active Postconfiguration—Active and is processing its 
configuration.

Column Description
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Current Status: Unit State

(continued)

• Disabled—RF is not currently operating on this unit.

• Hot Standby—Ready to become the active unit.

• Initialization—Establishing necessary system services.

• Negotiation—Discovering and negotiating with its peer unit.

• Cold Standby—Running the client RF notification.

• Cold Standby Bulk—Synchronizing its client data with the 
peer (active) unit.

• Cold Standby Configuring—Synchronizing its configuration 
with the peer (active) unit.

• Cold Standby File System—Synchronizing its file system 
with the “V unit”.

• Unknown—The current RF state of this unit is not known.

Current Status: Peer Unit ID Unique identifier for the peer redundant unit.

Current Status: Peer Unit State Current RF status for this unit’s peer unit. Possible values are:

• Active—Active and is processing calls.

• Active Drain—Performing client cleanup.

• Active Extra Load—Active and is processing calls for all 
feature boards in the system.

• Active Fast—Performing call maintenance during a SWACT 
notification.

• Active Handback—Active, is processing calls, and is handing 
off some resources to the other RF unit.

• Active Preconfiguration—Active but has not yet read its 
configuration.

• Active Postconfiguration—Active and is processing its 
configuration.

• Disabled—RF is not currently operating on the peer unit.

• Hot Standby—Ready to become the active unit.

• Initialization—Establishing necessary system services.

• Negotiation—Discovering and negotiating with this unit.

• Cold Standby—Running the client RF notification.

• Cold Standby Bulk—Synchronizing its client data with this 
(active) unit.

• Cold Standby Configuring—Synchronizing its configuration 
with this (active) unit.

• Cold Standby File System—Synchronizing its file system 
with this (active) unit.

• Unknown—The current RF state of the peer unit is not known.

Column Description
8-100
User Guide for the Cisco Mobile Wireless Transport Manager 6.1

OL-9118-01



 

Chapter 8      Understanding Detailed Object Functions
  Viewing Real-Time Data
Current Status: Primary Mode Indicates whether this unit is the primary or secondary.

The primary unit has a higher priority than the secondary unit. In a 
race situation (for example, during initialization), or in any situation 
in which the units cannot successfully negotiate activity between 
themselves, the primary unit becomes the active unit and the 
secondary unit becomes the standby unit. Only one redundant unit 
can be the primary unit at any given time.

Current Status: Duplex Mode Indicates whether the peer unit is detected:

• Duplex—Detected.

• Simplex—Not detected.

Current Status: 
Manual Switch Inhibit

Indicates whether a manual Switch of Activity (SWACT) is 
allowed:

• Enabled—Not allowed.

• Disabled—Allowed.

Current Status: 
Last Switchover Reason

Reason for the last Switch of Activity (SWACT). Possible values 
are:

• Active Unit Failed—A failure of the active unit triggered an 
automatic SWACT.

• Active Unit Removed—The removal of the active unit 
triggered an automatic SWACT.

• None—No SWACT has occurred.

• Unknown—The reason for the last SWACT is not known.

• Unsupported—The reason code for the last SWACT is not 
supported.

• User Forced—A user forced a manual SWACT, ignoring 
preconditions, warnings, and safety checks.

• User Initiated—A user initiated a safe, manual SWACT.

Current Status: Total System Up 
Time

Date and time when this node was up.

Current Status: Last 
Failover Time

Date and time when the primary redundant unit became the active 
unit. If no failover has occurred, this field displays No Failover 
Has Occurred.

Current Status: 
Standby Available At Time

Date and time when the peer redundant unit entered the Hot Standby 
state. If a failover occurs, this fields displays System 
Initialization for a brief period until the system is back up.

Column Description
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Redundancy Mode Capability: 
Capability Mode and 
Description

List of redundancy modes that the unit can support. Possible values 
are:

• Cold Standby Redundant—This unit is configured for 
redundancy, but the redundant peer unit is not fully initialized 
and cannot retain established calls.

• Dynamic Load Share NonRedundant—This unit is not 
configured for redundancy, but it is load-sharing. The 
load-sharing is based on the operational load (that is, it is based 
on the number of calls, or some other factor).

• Static Load Share Redundant—This unit is configured for 
redundancy, and it is load-sharing. The load-sharing is based on 
the operational load.

• NonRedundant—Redundancy is not configured on this unit, 
and it is not load-sharing.

• Static Load Share NonRedundant—This unit is not 
configured for redundancy, but it is load-sharing. The 
load-sharing is not based on the operational load.

• Static Load Share Redundant—This unit is configured for 
redundancy, and it is load-sharing. The load-sharing is not 
based on the operational load.

• Warm Standby Redundant—This unit is configured for 
redundancy, and the redundant peer unit can immediately 
handle new calls, but it cannot retain established calls.

• Hot Standby Redundant—This unit is configured for 
redundancy, the redundant peer unit can immediately handle 
new calls, and it can instantaneously retain established calls.

The Description column contains additional clarification or 
description of the Capability Mode.

Switchover History: Index Number identifying the entry in the Switchover History table.

Switchover History: Prev. ID Unit ID of the active unit that failed or was removed.

Switchover History: Curr. ID Unit ID of the standby unit that became the new active unit.

Switchover History: Reason Reason for the SWACT. Possible values are:

• Active Unit Failed—A failure of the active unit triggered an 
automatic SWACT.

• Active Unit Removed—The removal of the active unit 
triggered an automatic SWACT.

• None—No SWACT has occurred.

Column Description
8-102
User Guide for the Cisco Mobile Wireless Transport Manager 6.1

OL-9118-01



 

Chapter 8      Understanding Detailed Object Functions
  Viewing Real-Time Data
Viewing TDM Statistics
You can view real-time TDM statistics for T1 and E1 interfaces. To view TDM statistics for one of these 
interfaces, launch the MWTM client or MWTM web interface (http://server name:1774), select the T1 
or E1 interface in the navigation tree (in the Physical folder), then click the TDM Statistics tab.

Note In the MWTM client, the real-time icon  appears in the tab. This icon indicates that polling will 
periodically occur while this window is open. To prevent unnecessary traffic on your network, close this 
window (for example, by clicking a different tab) when you no longer need to view the real-time data.

The TDM Statistics tab contains: 

Line Configuration Pane

The Line Configuration pane contains:

Switchover History: Reason

(continued)

• Unknown—The reason for the last SWACT is not known.

• Unsupported—The reason code for the last SWACT is not 
supported.

• User Forced—A user forced a manual SWACT, ignoring 
preconditions, warnings, and safety checks.

• User Initiated—A user initiated a safe, manual SWACT.

Switchover History: Time Date and time that the SWACT occurred.

Column Description

GUI Element Description

Change Poller Button that opens the Poller Settings dialog box. See Change Poller, 
page 8-110. This button appears only in the MWTM client.

Poll Interval Label that shows the current poll interval in seconds.

Last Poll Label that identifies when the last poll occurred.

Line Configuration Pane that lists the line configuration parameters of the chosen T1 or E1 
interface. See Line Configuration Pane, page 8-103.

Line Status 
Information 1

1. To run basic troubleshooting commands on T1 and E1 interfaces, click the Troubleshooting tab, and select the Layer 2 Cross 
Connection category. See Viewing Troubleshooting, page 8-43.

Pane that provides line status information for the chosen T1 or E1 interface. 
See Line Status Information Pane, page 8-106.

Performance / Error 
Information 1

Pane that provides performance and error information for the chosen T1 or E1 
interface. See Performance and Error Information Pane, page 8-106.
8-103
User Guide for the Cisco Mobile Wireless Transport Manager 6.1

OL-9118-01



 

Chapter 8      Understanding Detailed Object Functions
  Viewing Real-Time Data
Parameter Value

Interface Name Name of the interface (for example, T1 0/0). 

Line Type Indicates the type of DS1 line that implements this circuit. The type of circuit 
affects the number of bits per second that the circuit can reasonably carry, as well 
as the interpretation of the usage and error statistics. Values include:

• ESF—Extended Super Frame DS1.

• D4—AT&T D4 format DS1.

• E1—CCITT recommendation G.704 (Table 4a).

• E1-CRC—CCITT recommendation G.704 (Table 4b).

• E1-MF—G.704 (Table 4a) with TS16 multiframing enabled.

• E1-CRC-MF—G.704 (Table 4b) with TS16 multiframing enabled.

• Other—Line type that is other than those described by this parameter.

Line Code Indicates the type of zero code suppression used on the line, which affects a number 
of its characteristics. Values include:

• JBZS—Jammed Bit Zero Suppression. A technique in which the AT&T 
specification of at least one pulse every 8-bit period is literally implemented 
by forcing a pulse in bit 8 of each channel. Therefore, only seven bits per 
channel, or 1.344 Mbps, is available for data.

• B8ZS—Bipolar with 8 Zeros Substitution. A specified pattern of normal bits 
and bipolar violations replace a sequence of eight zero bits.

• ZBTSI—Zero Byte Time Slot Interchange. A technique applied to a DS1 frame 
to ensure pulse density requirements are met. ANSI clear channels use ZBTSI.

• AMI—Alternate Mark Inversion. A technique in which no zero code 
suppression is present and the line encoding does not directly solve the 
problem.   In this application, the higher layer must provide data which meets 
or exceeds the pulse density requirements. E1 links, with or without CRC, use 
this code or the HDB3 code.

• HDB3—High Density Bipolar of order 3. A line code based on AMI.

• Other—Line code that is other than those described by this parameter.

Send Code Indicates what type of code is sent across the DS1 interface by the device. Values 
include:

• Send No Code—Sending looped or normal data.

• Send Line Code—Sending a request for a line loopback.

• Send Payload Code—Sending a request for a payload loopback.

• Send Reset Code—Sending a loopback termination request.

• Send QRS—Sending a quasi-random signal (QRS) test pattern.

• Send 511 Pattern—Sending a 511 bit fixed test pattern.

• Send 3-in-24 Pattern—Sending a fixed test pattern of 3 bits set in 24.

• Send Other Test Pattern—Sending a test pattern other than those described by 
this parameter.
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Circuit Identifier Contains the transmission vendor's circuit identifier, for the purpose of facilitating 
troubleshooting. 

Loopback Config Identifies the loopback configuration of the DS1 interface. Agents supporting 
read/write access should return badValue in response to a requested loopback state 
that the interface does not support. Values include:

• No Loop—Not in the loopback state. A device that is not capable of 
performing a loopback on the interface always returns this value.

• Payload Loop—The received signal at this interface is looped through the 
device. Typically the received signal is looped back for retransmission after it 
has passed through the device’s framing function.

• Line Loop—The received signal at this interface does not go through the 
device (minimum penetration) but is looped back out.

• Other Loop—Loopbacks that are not defined by this parameter.

Signal Mode Identifies the signal mode of the interface. Values include:

• None—Indicates that no bits are reserved for signaling on this channel.

• Robbed Bit—Indicates that T1 robbed bit signaling is in use.

• Bit Oriented—Indicates that E1 channel associated signaling is in use.

• Message Oriented—Indicates that common channel signaling is in use either 
on channel 16 of an E1 link or channel 24 of a T1.

Clock Source Indicates the source of the transmit clock. Values include:

• Loop Timing—Indicates that the recovered receive clock is used as the 
transmit clock.

• Local Timing—Indicates that a local clock source is used.

• Through Timing—Indicates that a recovered receive clock from another 
interface is used as the transmit clock.

Facilities Data 
Link

Describes the use of the facilities data link, and is the sum of the capabilities:

• ANSI T1 403—Refers to the facilities data link (FDL) exchange recommended 
by ANSI.

• AT&T 54016—Refers to ESF FDL exchanges.

• FDL None—Indicates that the device does not use the FDL.

• Other—Indicates use of a protocol other than those described by this 
parameter.

Parameter Value
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Line Status Information Pane

The Line Status Information pane contains:

Performance and Error Information Pane

The Performance and Error Information pane contains:

Parameter Value

Line Status Indicates the line status of the interface. It contains loopback, failure, received 
alarm, and transmitted alarm information. Values include:

• No Alarm—No alarm is present on the line.

• Receive Far End LOF—Far end loss of frame (LOF). This notification is also 
known as a yellow alarm.

• Transmit Far End LOF—Near end is sending LOF indication.

• Receive AIS—Far end is sending alarm indication signal (AIS).

• Transmit AIS—Near end is sending AIS.

• Loss of Frame—Near end LOF (red alarm).

• Loss of Signal—Near end loss of signal (LOS).

• Loopback State—Near end is looped.

• T16 AIS—E1 T16 alarm indication signal.

• Receive Far End LOMF—Far end is sending T16 loss of multiframe (LOMF).

• Transmit Far End LOMF—Near end is sending T16 LOMF alignment.

• Receive Test Code—Near end is detecting a test code.

• Other Failure—Any line status not defined by this parameter.

Loss of Frame 
Count 1

1. Not available for T1 or E1 controllers for ITP 12.2 releases.

Real-time count for loss of frame.

Loss of Signal 
Count 1

Real-time count for loss of signal.

Remote Alarm 
Indication Count 1

Real-time count for remote alarm indication.

Alarm Indication 
Signal Count 1

Real-time count for alarm indication signal.

Parameter Value

Time Elapsed within 
Interval

The number of minutes and seconds that have elapsed since the beginning of the 
current error-measurement period. 

Line Code 
Violations

The number of line code violations (LCVs) encountered by the interface in the 
current 15-minute interval.

Path Coding 
Violations

The number of path coding violations encountered by the interface in one of the 
previous 96, individual 15-minute, intervals.
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Viewing RAN-O Performance Data

Note The web interface provides historical (not real-time) charts depicting performance information over 
user-specified time ranges. You can use historical statistics for capacity planning and trend analysis. See 
Displaying RAN-O Historical Statistics, page 11-33.

The MWTM client interface provides access to RAN-O real-time performance statistics that you can use 
to troubleshoot problems that occur in real time. The zoom and navigation features quickly enable 
isolating and focusing on a problem area. 

You use real-time charts in the MWTM client to view performance information on shorthaul and 
backhaul interfaces. To view performance data for a shorthaul or backhaul interface, select the interface 
in the navigation tree of the DEFAULT view (or any custom view), then click the Backhaul or Shorthaul 
Performance tab in the right pane. 

Note If the CISCO-IP-RAN-BACKHAUL-MIB on the node is not compliant with the MWTM, the MWTM 
issues the message:

MIB not compliant for reports

Install a version of IOS software on the node that is compatible with the MWTM. For a list of compatible 
IOS software, from the MWTM:

• Web interface, choose Administrative > IPRAN OS README.

• Client interface, choose View > Web > Administrative; then click IPRAN OS README.

Slip Duration The number of slip seconds encountered by the interface in the current 
15-minute interval.

Severely Errored 
Framing Duration

The number of severely errored framing seconds encountered by the interface in 
the current 15-minute interval.

Line Error Duration The number of line errored seconds encountered by the interface in the current 
15-minute interval.

Degraded Duration The number of degraded seconds encountered by the interface in the current 
15-minute interval.

Errored Duration The number of errored seconds encountered by the interface in the current 
15-minute interval.

Bursty Error 
Duration

The number of bursty errored seconds encountered by the interface in the 
current 15-minute interval.

Severely Errored 
Duration

The number of severely errored seconds encountered by the interface in the 
current 15-minute interval.

Unavailable 
Duration

The number of unavailable seconds encountered by a DS1 interface in the 
current 15 minute interval.

Parameter Value
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The Backhaul or Shorthaul Performance tab displays one or more charts depending on whether you 
selected a shorthaul or a backhaul interface. These charts depict send and receive rates of optimized IP 
traffic over time. The charts display the traffic from 0 to the maximum speed on the interface. You can 
set the client preferences to display this data in bits or bytes per second. The default polling interval is 
15 seconds, but you can change the frequency in the Poller Settings dialog box, which you launch by 
clicking the Change Poller button.

The Backhaul or Shorthaul Performance tab also shows total send and receive errors when you select a 
backhaul interface.

This section provides information about:

• Viewing Shorthaul Performance Data, page 8-108

• Viewing Backhaul Performance Data, page 8-111

Viewing Shorthaul Performance Data

Note In the MWTM client, the real-time icon  appears in the tab. This icon indicates that polling will 
periodically occur while this window is open. To prevent unnecessary traffic on your network, close this 
window (for example, by clicking a different tab) when you no longer need to view the real-time data.

The Shorthaul Performance tab displays a single chart that shows:

• The send rate plotted in one color and the receive rate plotted in a different color (Figure 8-5). 

• A vertical band when the congestion mechanism is active (see the Cisco MWR 1941-DC-A Mobile 
Wireless Edge Router Software Configuration Guide for congestion management information). 

• A different colored vertical band when no data exists. 
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Figure 8-5 Shorthaul Performance Tab

Content Pane

The content (right) pane contains: 

GUI Elements Description

Change Poller Button that opens the Poller Settings dialog box. See Change Poller, page 8-110.

Poll Interval Label that shows the current poll interval in seconds.

Bits or Bytes/Sec Y-axis label that displays traffic rate in bits or bytes per second. The default is bits 
per second. The Y axis automatically scales to the interface speed. To change the 
charts to show bytes per second, uncheck the Show Details in Bits instead of Bytes 
check box in the Preferences window (General Display Settings, page 5-4).
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Change Poller

To change the poll interval, click the Change Poller button. The MWTM displays the Poller Settings 
dialog box.

The Poller Settings window displays these labels and buttons for the chosen shorthaul or backhaul 
interface:

Right-click Menu

A right-click context menu provides options to navigate to the backhauls that are associated with the 
chosen shorthaul interface. You can also modify how the chart appears. The right-click menu contains:

Time X-axis label that displays a real-time scale and the server time zone.

Legend Identifies the data series currently showing in the chart. 

• No Data—Data is not available. A vertical bar appears in the chart.

• Congestion Active—Shows when the shorthaul is in a congested state. A 
vertical bar appears in the chart.

Note You can configure the congestion mechanism for low-latency GSM and 
UMTS traffic. Other traffic (for example, SNMP or file transfer) can be 
discarded without entering the congestion mechanism. For detailed 
information about GSM and UMTS congestion management, see the Cisco 
MWR 1941-DC-A Mobile Wireless Edge Router Software Configuration 
Guide.

GUI Elements Description

Label/Button Description

Poll Interval 
(secs)

The poll interval, in seconds, for the chosen node.

To set a new poll interval, click in the Poll Interval (secs) text box and enter a new 
value. The default value is 15 seconds. Valid values are between 5 and 60.

Current Poll 
Interval

Value of the poll interval currently in use.

Number of Polls 
Received

Number of polls received by the chosen node.

Running Time Time in hours, minutes, and seconds that the poller is running.

Change Changes the poll interval from the current setting to the value you have entered in 
the Poll Interval (secs) text box.

Close Closes the Poller Settings window.

Help Displays online help for the current window.

Menu options Description

Goto > backhaul Opens the Backhaul Performance tab for the backhaul interface associated with the 
chosen shorthaul interface.

Show/hide 
right-click menu

Provides options to show or hide one or more parts of a data series. See Right-click 
Menu, page 8-95, for descriptions of the options.
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Viewing Backhaul Performance Data

Note In the MWTM client, the real-time icon  appears in the tab. This icon indicates that polling will 
periodically occur while this window is open. To prevent unnecessary traffic on your network, close this 
window (for example, by clicking a different tab) when you no longer need to view the real-time data.

The Backhaul Performance tab displays multiple charts in a split pane (Figure 8-6). The top pane 
displays send rate statistics, and the bottom pane displays receive rate statistics. You can maximize either 
pane to full screen size by using the split-pane control bar. 

Each pane contains three charts that share the same time domain: 

• Top chart—Displays total GSM traffic, total UMTS traffic, and total traffic (a summation of total 
GSM and total UMTS) in bits or bytes per second (left Y axis). The right Y axis displays the 
backhaul utilization as a percentage of the user bandwidth. You can change the scale of the Y axis 
by changing the User Bandwidth (see Editing Properties for a RAN-O Backhaul, page 6-36). The Y 
axis automatically scales to the User Bandwidth.

The top chart overlays the traffic display on top of threshold ranges (acceptable, warning, and 
overloaded) that are represented by color-coded, horizontal bands.

• Middle chart—Displays the traffic rates in bits or bytes per second for each shorthaul interface that 
is associated with the backhaul interface. 

• Bottom chart—Displays total send-and-receive errors per second over time for all of the shorthaul 
interfaces included in the backhaul interface.
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Figure 8-6 Backhaul Performance Tab

Content Pane

The content (right) pane contains: 

GUI Elements Description

Change Poller Button that opens the Poller Settings dialog box. See Change Poller, page 8-110.

Poll Interval Label that shows the current poll interval in seconds.

SH or BH 
Bits or Bytes/Sec

Left Y-axis label that displays shorthaul (SH) or backhaul (BH) traffic rate in bits 
or bytes per second. The default is bits per second. This label appears for only the 
top and middle charts of both panes. The Y axis automatically scales to the User 
Bandwidth.

To change the charts to show bytes per second, uncheck the Show Details in Bits 
instead of Bytes check box in the Preferences window (General Display Settings, 
page 5-4).
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Right-click Menu

A right-click context menu provides options to navigate to the shorthauls that are associated with the 
chosen backhaul interface. You can also modify how the chart appears. 

The right-click menu contains:

Display Series Dialog Box

The Display Series dialog box allows you to select data series to show or hide. 

% Utilization Y-axis label on the right side of the chart. The right-side axis displays the 
backhaul utilization as a percentage of the User Bandwidth. 

The chart background is color-coded to indicate these thresholds:

• Overloaded—Top portion of chart background

• Warning—Middle portion of chart background

• Acceptable—Bottom portion of chart background

For definitions of these thresholds, see Threshold Information (RAN-O Only), 
page 8-43.

To change threshold settings, including the User Bandwidth, see Editing 
Properties for a RAN-O Backhaul, page 6-36.

Note If the % Utilization exceeds 100%, see Why does my backhaul utilization 
graph show greater than 100% for transmit traffic?, page C-22.

Errors/Sec Y-axis label that displays the total number of errors per second for send and 
receive traffic. This label appears only for the bottom chart of both panes.

Note The same Errors/Sec chart appears in each pane. 

Time X-axis label that displays real-time scales for all the charts in the pane. The chart 
also shows the server time zone.

Split-pane Control Pane sizing feature that separates the top and bottom panes. To fully expand the:

• Bottom pane, click the noninverted triangle on the control bar.

• Top pane, click the inverted triangle on the control bar.

To partially expand a pane, left-click the control bar and drag it up or down.

Legend Color-coded legend to the right of the charts that describes the information that 
appears in all three charts of the pane.

GUI Elements Description

Menu options Description

Goto > shorthaul Opens the Shorthaul Performance tab for the shorthaul interface associated with the 
chosen backhaul interface.

Display Series... Opens the Display Series dialog box, which allows you to select data series to show 
or hide. See Display Series Dialog Box, page 8-113.

Reset Zoom, 
Grid, Shapes

See Right-click Menu, page 8-95, for descriptions of these options.
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The Display Series dialog box contains:

Column or Button Description

Display Column of check boxes that allow you to display (by checking) or hide (by 
unchecking) the data series associated with the chosen backhaul.

The MWTM displays no more than 12 series by default. You can change this setting 
for the MWTM Client Display or the MWTM Web Display:

MWTM Client Display

To change the maximum number of data series that the MWTM client interface 
displays by default, edit the MAX_CHART_SERIES parameter in the client-side 
System.properties file:

• For the Windows client: C:\Program Files\Cisco Systems\MWTM Client
\properties\System.properties

• For Solaris or Linux client: /opt/CSCOsgmClient/System.properties

Caution Depending on the processing power and memory of your client system, 
setting the MAX_CHART_SERIES parameter too high can cause the 
client display to become unresponsive. If the client becomes 
unresponsive, set the MAX_CHART_SERIES to a lower value.

Remember to restart the client to activate the new MAX_CHART_SERIES value.

MWTM Web Display

To change the maximum number of data series that the MWTM web interface 
displays by default, edit the MAX_CHART_SERIES parameter in the server-side 
System.properties file: /opt/CSCOsgm/properties/System.properties.

Caution Depending on the number of shorthauls that you display, setting the 
MAX_CHART_SERIES parameter too high can cause the web display to 
become unresponsive. If the web become unresponsive, set the 
MAX_CHART_SERIES to a lower value.

Remember to restart the server to activate the new MAX_CHART_SERIES value

Series Name Name of the data series to display or hide.

RAN Backhaul The RAN backhaul that is associated with the data series.

This column appears only when the chosen backhaul is a virtual backhaul. For more 
information about virtual backhauls, see Creating Virtual RAN Backhauls, 
page 8-140.

Close Closes the Display Series dialog box.

Help Opens the help system for the Display Series dialog box.
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Viewing RAN-O Error Data

Note The web interface provides historical (not real-time) error information over user-specified time ranges. 
You can use historical statistics for capacity planning and trend analysis. See Displaying RAN-O 
Historical Statistics, page 11-33.

The MWTM client interface provides access to RAN-O real-time error statistics that you can use to 
troubleshoot problems that occur in real time. The zoom and navigation features quickly enable isolating 
and focusing on a problem area. 

You use real-time charts in the MWTM client to troubleshoot errors that occur on shorthaul and backhaul 
interfaces. To view error data for a shorthaul or backhaul interface, select it in the navigation tree of the 
DEFAULT view (or any custom view), and click the Shorthaul or Backhaul Errors tab in the right pane. 

The Shorthaul or Backhaul Errors tab shows errors for the chosen interface.

Note If the CISCO-IP-RAN-BACKHAUL-MIB on the node is not compliant with the MWTM, the MWTM 
issues the message:

MIB not compliant for reports

Install a version of IOS software on the node that is compatible with the MWTM. For a list of compatible 
IOS software, from the MWTM:

• Web interface, choose Administrative > IPRAN OS README.

• Client interface, choose View > Web > Administrative; then click IPRAN OS README.

Viewing Shorthaul Errors

Note In the MWTM client, the real-time icon  appears in the tab. This icon indicates that polling will 
periodically occur while this window is open. To prevent unnecessary traffic on your network, close this 
window (for example, by clicking a different tab) when you no longer need to view the real-time data.

When you select a GSM Abis shorthaul interface in the navigation tree in the DEFAULT view (or any 
custom view), the MWTM displays protocol, missed packet, and miscellaneous errors in the right pane 
(Figure 8-7). When you select a UMTS Iub shorthaul interface, the MWTM displays optimization and 
miscellaneous errors. 

This window also includes a graph that displays the total number of errors per second. The graph has a 
right-click menu with options to similar to those of the right-click menu of the Performance window. 

You can use the split pane control bar to resize or maximize the error tables or the error graph.
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Figure 8-7 Example of Shorthaul Errors for GSM Abis Interface

Content Pane

The content (right) pane contains: 

GUI Elements Description

Change Poller Button that opens the Poller Settings dialog box. See Change Poller, page 8-110.

Reset Counters Opens the Reset Counters dialog box to configure the method of polling. See 
Changing Real-Time Poller and Counter Settings, page 5-21.

Poller Counter 
Mode

Label that displays the polling mode that you configure in the Reset Counters 
dialog box.

Poll Interval Label that shows the current poll interval in seconds.

Optimization 
Failures

Pane that displays optimization failures for the chosen GSM Abis or UMTS Iub 
shorthaul interface. See Protocol Failures, page 8-117. 

Miscellaneous Pane that displays miscellaneous errors on the chosen shorthaul interface. See 
Miscellaneous, page 8-118. 

Note This pane appears for both GSM Abis and UMTS Iub shorthaul interfaces 
but with some differences in the types of errors shown.
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Protocol Failures 

The Protocol Failures pane has a table that contains: 

Missed Packets Pane that displays missed packet errors on the chosen GSM Abis shorthaul 
interface. See Missed Packets, page 8-119. 

Note This pane appears only for GSM Abis shorthaul interfaces.

Split-pane 
Control Bar 

Pane sizing feature that separates the top and bottom panes. To fully expand the:

• Bottom pane, click the noninverted triangle on the control bar.

• Top pane, click the inverted triangle on the control bar.

To partially expand a pane, left-click the control bar and drag it up or down.

Total Errors / 
Second

Chart that displays the total number of errors per second on the shorthaul interface. 
See Total Errors per Second, page 8-120.

GUI Elements Description

GUI Elements Description

Columns Table columns that list:

• Type of error—Type of protocol failure on the GSM Abis or UMTS Iub

• Counts—Number of errors of a particular type

• Rates (per sec)—Error rate for a particular type of error

Total Total number of protocol failures encountered during the compression and 
decompression of the GSM-Abis or UMTS-Iub traffic.

Packet 
Unavailable

The number of times compression failed because a packet was unavailable.

Reconstruction 
Failures

The number of times information in a packet could not be decompressed.

Encapsulation 
Errors

The number of times compression failed because of encapsulation errors.

QoS Drops The number of times compression failed because of quality of service errors or 
traffic load.

Peer Route 
Unavailable

The number of times compression failed because a route to the peer was not 
available.

Interface Down The number of times compression failed because an interface was down.

Congestion 
Drops (GSM 
Abis only)

The number of dropped GSM packets or UMTS cells because of traffic congestion.

Note You can configure the congestion mechanism for low-latency GSM and 
UMTS traffic. Other traffic (for example, SNMP or file transfer) can be 
discarded without entering the congestion mechanism. For detailed 
information about GSM and UMTS congestion management, see the Cisco 
MWR 1941-DC-A Mobile Wireless Edge Router Software Configuration 
Guide.
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Miscellaneous 

The Miscellaneous pane has a table that contains: 

Note The error types in the table apply to UMTS Iub and GSM Abis shorthaul interfaces unless otherwise 
noted.

GUI Elements Description

Columns Table columns that list:

• Type of error—Type of miscellaneous error on the GSM Abis or UMTS Iub 
shorthaul.

• Counts—Number of errors of a particular type.

• Rates (per sec)—Error rate for a particular type of error.

Total Total number of miscellaneous failures encountered during the compression and 
decompression of the GSM-Abis or UMTS-Iub traffic.

Peer Not Ready The count of packets dropped on the backhaul because the peer was not ready.

Peer Not Active 
(GSM Abis only)

The count of packets dropped on the backhaul because the peer was reachable but 
not in an active state.

Invalid Packets The number of backhaul packets that were received and dropped because they 
contained invalid information.

Packet Allocation 
(UMTS Iub only)

The number of times a packet could not be allocated to send data on the UMTS Iub 
shorthaul interface.

Protocol 
Encapsulation 
Errors (UMTS 
Iub only)

The number of times compression failed because of encapsulation errors.

Local PVC 
Unavailable 
(UMTS Iub only)

The number of packets dropped because a local PVC was unavailable.

Remote PVC 
Unavailable 
(UMTS Iub only)

The number of packets dropped because a remote PVC was unavailable.

Backhaul Drops 
(UMTS Iub only)

The number of packets dropped on the backhaul.

Lost Received 
Packets (GSM 
Abis only)

The number of backhaul packets expected to be received but that never arrived.

Lost Sent Packets 
(GSM Abis only)

The number of backhaul packets sent but the peer never received.

Fast Send 
Failures (GSM 
Abis only)

The number of fast send failures on the shorthaul interface.

Transmit Failures 
(GSM Abis only)

The number of packet transmit failures on the shorthaul interface.
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Missed Packets 

The Missed Packets pane appears only for GSM Abis shorthaul interfaces and has a table that contains: 

Interrupt Failures 
(GSM Abis only)

The number of packets lost due to interrupt failures.

Late Arrivals 
(GSM Abis only)

The number of GSM packets that arrived later than the allowed time.

Early Arrivals 
(GSM Abis only)

The number of GSM packets that arrived earlier than the allowed time.

GUI Elements Description

GUI Elements Description

Columns Table columns that list:

• Type of error—Type of missed packet error on the GSM Abis shorthaul 
interface.

• Counts—Number of errors of a particular type.

• Rates (per sec)—Error rate for a particular type of error.

Total Total number of missed packet errors encountered during the compression and 
decompression of the GSM-Abis shorthaul interface.

Late Packets The number of packets missed on the backhaul because they arrived past the 
allowed time frame

Lost Packets The number of packets missed because they were lost on the backhaul

Overruns (GSM 
Abis only)

The number of packets missed due to the jitter buffer running out of available 
space.

Transmit 
Interface Resets 
(GSM Abis only)

The number of transmission interface resets.

Transmit Buffer 
Unavailable 
(GSM Abis only)

The number of times that the system is unable to allocate buffer for transmission.

Reset Event The number of packets missed on the backhaul because of a reset event

Insufficient 
Memory

The number of packets missed on the backhaul for lack of available memory to 
allocate the packet
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Total Errors per Second 

The Total Errors per Second pane displays a chart that contains: 

A right-click menu provides navigational and chart control options. See Right-click Menu, page 8-110.

Viewing Backhaul Errors

Note In the MWTM client, the real-time icon  appears in the tab. This icon indicates that polling will 
periodically occur while this window is open. To prevent unnecessary traffic on your network, close this 
window (for example, by clicking a different tab) when you no longer need to view the real-time data.

When you select a backhaul interface in the navigation tree, the MWTM displays a chart in the right pane 
(Figure 8-8). The charts shows GSM and UMTS errors per second for each shorthaul interface included 
in the backhaul. 

The content (right) pane contains: 

A right-click menu provides navigational and chart control options. See Right-click Menu, page 8-113.

GUI Elements Description

Total Errors/Second 
(shorthaul)

Chart title that lists the chosen shorthaul.

Errors/Sec Y-axis label that displays errors per second for the chosen shorthaul.

Time X-axis label that displays a real-time scale for the chosen shorthaul. The chart 
also displays the server time zone.

GUI Elements Description

Change Poller Button that opens the Poller Settings dialog box. See Change Poller, page 8-110.

Poll Interval Label that shows the current poll interval in seconds.

Last Poll Label that displays the date and time of the last poll.

GSM and UMTS 
Errors/Second

Chart title for GSM and UMTS errors.

Errors/Sec Y-axis label that displays errors per second.

Time X-axis label that displays a real-time scale and the server time zone.

Legend Color-coded legend for the shorthaul interfaces included in the chosen backhaul.
8-120
User Guide for the Cisco Mobile Wireless Transport Manager 6.1

OL-9118-01



 

Chapter 8      Understanding Detailed Object Functions
  Viewing Real-Time Data
Figure 8-8 Example of Backhaul Errors Chart

Viewing PWE3 Statistics
You can view real-time Pseudowire Emulation Edge-to-Edge (PWE3) statistics for cell-site routers that 
have the PWE3 capability. To view real-time PWE3 statistics for one of these nodes, select the node in 
the navigation tree, then click the PWE3 Statistics tab. You can view real-time PWE3 statistics in the 
MWTM client and web interfaces (there are minor differences in layout and appearance).

Note In the MWTM client, the real-time icon  appears in the tab. This icon indicates that polling will 
periodically occur while this window is open. To prevent unnecessary traffic on your network, close this 
window (for example, by clicking a different tab) when you no longer need to view the real-time data.
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The PWE3 Statistics tab contains:

GUI Element Description

Change Poller Button that opens the Poller Settings dialog box. See Change Poller, 
page 8-110.

Reset Counters Button that opens the Reset Counters dialog box to configure the method of 
polling. See Changing Real-Time Poller and Counter Settings, page 5-21.

Poller Counter Mode Label that displays the polling mode that you configure in the Reset 
Counters dialog box.

Poll Interval Label that shows the current poll interval in seconds.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first 
polling cycle, the MWTM populates this field with the actual time of the last 
poll.

ID Table column label that lists the ID of the virtual circuit.

Type Type of service that carries the virtual circuit.

PSN Type Type of packet-switched network (PSN) that carries the virtual circuit. For 
example, MPLS.

Name Name of the virtual circuit.

Description Description of the virtual circuit.

Peer Address IP address of the peer node.

Create Time1 Time when the virtual circuit was created.

Up Time1 Length of time the virtual circuit has been operational.

Admin Status1 The administrative status of the virtual circuit.

Oper Status1 The operational status of the virtual circuit.

Inbound Oper Status1 The operational status of the virtual circuit in the inbound direction.

Outbound Oper Status1 The operational status of the virtual circuit in the outbound direction.

Time Elapsed1 Time in seconds since the beginning of the measurement period.

Valid Intervals1 Number of valid intervals for which data was collected.

Packets Received Rate Number of packets that the virtual circuit received each second from the 
packet-switched network. 

Packets Received Count1 Total number of packets that the virtual circuit received from the 
packet-switched network. 

Bytes Received Rate Number of bytes that the virtual circuit received each second from the 
packet-switched network. 

Bytes Received Count1 Total number of bytes that the virtual circuit received from the 
packet-switched network. 

Packets Sent Rate Number of packets that the virtual circuit forwarded each second to the 
packet-switched network.

Packet Sent Count1 Total number of packets that the virtual circuit forwarded to the 
packet-switched network.
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Viewing ITP Linkset Access Lists
The Linkset Access Lists section displays information about the access lists associated with the chosen 
linkset and its adjacent linkset.

To view the Linkset Access List section, in a view in the navigation tree, select an ITP linkset, then click 
on the Linkset Access Lists tab in the content area.

Note This window polls your network periodically. To prevent unnecessary traffic on your network, close this 
window when you no longer need it.

This window is not available if the linkset is a Virtual linkset.

For each linkset, the Linkset Access Lists section displays these columns:

Viewing Data Specific for ITP Signaling Points
These sections are specific only to ITP signaling points:

• Viewing Route Detail, page 8-124

• Viewing GTT MAP Status, page 8-125

• Viewing GTT Statistics, page 8-126

Bytes Sent Rate Number of bytes that the virtual circuit forwarded each second to the 
packet-switched network.

Bytes Sent Count1 Total number of bytes that the virtual circuit forwarded to the 
packet-switched network.

1. This column is hidden from view by default. To unhide the column, right-click in the column heading area and select the 
column label.

GUI Element Description

Column Description

Poll Interval Used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first polling 
cycle, the MWTM populates this field with the actual time of the last poll.

Linkset Name of the linkset for which access lists appear.

In Inbound access lists for the linkset. If the linkset has no inbound access lists, this 
field displays None.

Out Outbound access lists for the linkset. If the linkset has no outbound access lists, this 
field displays None.

List # Access list number configured on the node and applied to the linkset. ITP uses 
access list numbers 2700 through 2799.

Access List List of commands in the access list.
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• Viewing the MTP3 Event Log, page 8-129

• Viewing MLR Details, page 8-130

Viewing Route Detail
The Route Detail table displays detailed information about routes associated with the chosen signaling 
point, including dynamic and shadow routes. The Route Detail table automatically eliminates duplicate 
data in successive rows.

To view the Route Detail section, in a view in the navigation tree, select an ITP signaling point, then 
click on the Route Detail tab in the content area.

Note This window polls your network periodically. To prevent unnecessary traffic on your network, close this 
window when you no longer need to refer to it.

The Route Detail table displays these columns for the chosen signaling point:

Column Description

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first polling 
cycle, the MWTM populates this field with the actual time of the last poll.

Destination Point 
Code

Destination point code for packets on the chosen signaling point. The destination 
point code is the point code to which a given packet is routed.

Mask Mask length for packets on the chosen signaling point. The mask length is the 
number of significant leading bits in the point code. The mask length is always 
14 for ITU and 24 for ANSI.

Access Status of the destination. Possible values are:

• Accessible

• Inaccessible

• Restricted

• Unknown

Congestion Level Indicates the level of congestion on the route. A route is congested if it has too 
many packets waiting to be sent. This condition could be caused by the failure of 
an element in your network.

Possible values for the Congestion Level field are None, indicating no 
congestion, and 1 to 7, indicating levels of congestion from very light (1) to very 
heavy (7).

Number of Routes Number of routes to the chosen destination route set (Destination Point Code 
plus Mask).

Cost Cost of the route to the destination, relative to other routes. The valid costs range 
from 1 (lowest cost and highest priority) through 9 (highest cost and lowest 
priority).
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Viewing GTT MAP Status
The GTT MAP Status table displays detailed information about all GTT MAPs associated with the 
chosen signaling point. The GTT MAP Detail table automatically eliminates duplicate data in successive 
rows.

To view the GTT MAP Status section, in a view in the navigation tree, select an ITP signaling point, then 
click on the GTT MAP Status tab in the content area.

Note This window polls your network periodically. To prevent unnecessary traffic on your network, close this 
window when you no longer need to refer to it.

The GTT MAP Status table displays these columns for the chosen signaling point:

Destination Linkset Destination linkset associated with the destination point code. The destination 
linkset is also called the output linkset.

QoS Quality of service (QoS) class of the route, as configured by the network 
administrator. Valid QoS classes range from 1 through 7; ALL indicates that the 
route accepts all QoS classes.

Management Status Accessibility of the destination from the adjacent point code at the remote end of 
the signaling point. Possible values are:

• Allowed—Traffic is allowed on the route without restriction.

• Prohibited—Traffic is prohibited on the route.

• Restricted—Traffic is restricted on the route.

• Unknown—Accessibility cannot be determined.

Route Status Status of the route. Possible values are:

• Available

• Restricted

• Unavailable

Column Description

Column Description

Reset Counters Opens the MWTM Reset Counters dialog box, which you use to change MWTM 
poller and counter settings. For more information, see Changing Real-Time 
Poller and Counter Settings, page 5-21.

Poll Counter Mode Displays the current mode for poll counters, and the date and time that counters 
were last reset. Possible modes are:

• Since Reboot—Counters display values aggregated since the last reboot of 
the ITP, or since ITP last reset the counters.

• Since Last Poll—Counters display values aggregated since the last poll.

• Since User Reset—Counters display values aggregated since the last time 
they were reset by the user.

Poll Interval Poll interval used to collect data for the table.
8-125
User Guide for the Cisco Mobile Wireless Transport Manager 6.1

OL-9118-01



 

Chapter 8      Understanding Detailed Object Functions
  Viewing Data Specific for ITP Signaling Points
Viewing GTT Statistics
The GTT Statistics table displays detailed statistical information about all GTTs that are associated with 
the chosen signaling point. The GTT Statistics table automatically eliminates duplicate data in 
successive rows.

To view the GTT Statistics section, in a view in the navigation tree, select an ITP signaling point, then 
click on the GTT Statistics tab in the content area.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first polling 
cycle, the MWTM populates this field with the actual time of the last poll.

Point Code Primary point code for the GTT MAP.

Point Code Status Status of the primary point code. Possible values are:

• Allowed

• Prohibited—Either the point code cannot be reached, or the point code is 
labeled Prohibited by the SCCP protocol.

Congestion Level MTP3 congestion level for the primary point code. Possible values are:

• No congestion—Corresponds to None. The link is not congested.

• Congestion level 1—Corresponds to Low. The link is slightly congested.

• Congestion level 2—Corresponds to High. The link is congested.

• Congestion level 3—Corresponds to Very High. The link is very congested.

Low, High, and Very High correspond roughly to equivalent ANSI, 
China standard, ITU, NTT, and TTC congestion levels.

Point Code 
Congested

Number of times a point code was congested at the GTT MAP.

Point Code 
Unavailable

Number of times a point code was unavailable at the GTT MAP.

SCCP Unavailable Number of times an SCCP was unavailable at the GTT MAP. 

MTP3 Failures Number of times the MTP3 layer failed at the GTT MAP.

Number of 
Subsystems

Number of subsystems for the GTT MAP.

Subsystem Number Primary subsystem number (SSN) for the GTT MAP.

Subsystem Status Status of the primary SSN. Possible values are:

• Allowed

• Prohibited—Either the remote subsystem cannot be reached, or the SCCP 
protocol labels the subsystem Prohibited.

Subsystem 
Unavailable

Number of times a subsystem was unavailable at the GTT MAP.

Subsystem 
Congested

Number of times a subsystem was congested at the GTT MAP.

Column Description
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Note This window polls your network periodically. To prevent unnecessary traffic on your network, close this 
window when you no longer need to refer to it.

The GTT Statistics table displays these columns for the chosen signaling point:

Column Description

Reset Counters Opens the MWTM Reset Counters dialog box, which you use to 
change MWTM poller and counter settings. For more information, 
see Changing Real-Time Poller and Counter Settings, page 5-21.

Poll Counter Mode Displays the current mode for poll counters, and the date and time 
that counters were last reset. Possible modes are:

• Since Reboot—Counters display values aggregated since the 
last reboot of the ITP, or since ITP last reset the counters.

• Since Last Poll—Counters display values aggregated since the 
last poll.

• Since User Reset—Counters display values aggregated since 
the last time they were reset by the user.

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the 
first polling cycle, the MWTM populates this field with the actual 
time of the last poll.

Uptime Time the node is up, in days, hours, minutes, and seconds.

Selector Entries Number of entries in the GTT Selector Table.

GTA Entries Number of entries in the GTT GTA Table.

Application Group Entries Number of entries in the GTT App Group Table.

Addr. Conversion Entries Number of entries in the GTT Address Conversion Table.

Point Code List Entries Number of entries in the GTT CPC List.

GTT Errors: Errors To MTP Number of Error messages (ERRs) sent by GTT to the MTP.

GTT Errors: Errors From MTP Number of Error messages (ERRs) received by GTT from the MTP.

GTT Errors: Translation Error Number of times translation was requested for a combination of 
Translation Type, Numbering Plan, and Nature of Address for 
which no translation exists in the signaling point. Occurs when no 
selector is available for the combination of parameters provided in 
the MSU.

GTT Errors: Unequipped 
Subsystem Error

Number of times GTT could not perform a translation due to an 
unequipped subsystem.

GTT Errors: Q752 Unqualified 
Error

Number of times GTT could not perform a translation due to an 
error type not covered by the other, more specific error types.

GTT Errors: 
Invalid GTT Format

Number of times GTT detected an invalid global title format while 
performing translation.

GTT Errors: Hop Count Error Number of times GTT detected a hop count violation in the MSU.
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GTT Errors: MAP Not Found Number of times a GTT to a point code or subsystem number was 
successful, but the point code or subsystem number was not found 
in the GTT MAP table.

GTT Errors: Counts Number of GTT errors of the specified type since MWTM polling 
began for the linkset, or since the MWTM last reset the averages as 
a result of bad data.

GTT Errors: Rate (per sec) Number of errors that GTT detected per second.

GTT Messages: Total Messages Number of messages that GTT handled from local and remote 
subsystems.

GTT Messages: Local Messages Number of messages that GTT handled from local subsystems only.

GTT Messages: 
Total GTT Messages

Number of messages that GTT handled that require translation.

GTT Messages: 
UDT Messages Sent

Number of unitdata messages (UDTs) that GTT sent.

GTT Messages: 
UDT Messages Received

Number of unitdata messages (UDTs) that GTT received.

GTT Messages: 
UDTS Messages Attempted

Number of unitdata service messages (UDTSs) GTT attempted to 
send.

GTT Messages: 
UDTS Messages Sent

Number of unitdata service messages (UDTSs) that GTT sent.

GTT Messages: 
UDTS Messages Received

Number of unitdata service messages (UDTSs) that GTT received.

GTT Messages: 
XUDT Messages Sent

Number of extended unitdata messages (XUDTs) GTT sent.

GTT Messages: 
XUDT Messages Received

Number of extended unitdata messages (XUDTs) that GTT 
received.

GTT Messages: 
XUDTS Messages Attempted

Number of extended unitdata service messages (XUDTSs) GTT 
attempted to send.

GTT Messages: 
XUDTS Messages Sent

Number of extended unitdata service messages (XUDTSs) that GTT 
sent.

GTT Messages: 
XUDTS Messages Received

Number of extended unitdata service messages (XUDTSs) that GTT 
received.

GTT Messages: 
LUDT Messages Sent

Number of long unitdata messages (LUDTs) that GTT sent.

GTT Messages: 
LUDT Messages Received

Number of long unitdata messages (LUDTs) that GTT received.

GTT Messages: 
LUDTS Messages Sent

Number of long unitdata service messages (LUDTSs) that GTT 
sent.

GTT Messages: 
LUDTS Messages Received

Number of long unitdata service messages (LUDTSs) that GTT 
received.

GTT Messages: 
CR Sent To MTP

Number of Connection Request (CR) message that GTT sent to the 
MTP. This count includes ISDN-UP messages with embedded CRs.

Column Description
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Viewing the MTP3 Event Log
The MTP3 Event Log table displays the most recent MTP3 events associated with the chosen signaling 
point.

To view the MTP3 Event Log section, in a view in the navigation tree, select an ITP signaling point, then 
click on the MTP3 Event Log tab in the content area.

Note This window polls your network periodically. To prevent unnecessary traffic on your network, close this 
window when you no longer need to refer to it.

The MTP3 Event Log table displays these columns for the chosen signaling point:

GTT Messages: 
CR Received From MTP

Number of Connection Request (CR) message that GTT received 
from the MTP.

GTT Messages: 
CREF Sent To MTP

Number of Connection Refusal (CREF) messages that GTT sent to 
the MTP. This count includes ISDN-UP messages with embedded 
CRs.

GTT Messages: 
CREF Received From MTP

Number of Connection Refusal (CREF) messages that GTT 
received from the MTP.

GTT Messages: 
RSR Sent To MTP

Number of Reset Request (RSR) messages that GTT sent to the 
MTP.

GTT Messages: 
RSR Received From MTP

Number of Reset Request (RSR) messages that GTT received from 
the MTP.

GTT Messages: Counts Number of GTT messages of the specified category since MWTM 
polling began for the linkset, or since the MWTM last reset the 
averages as a result of bad data.

GTT Messages: Rate (per sec) Number of errors messages handled by GTT, per second.

Column Description

Column Description

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first polling 
cycle, the MWTM populates this field with the actual time of the last poll.

Logged Events Total number of MTP3 events that have been logged for this signaling point.

Dropped Events Total number of MTP3 events that have been dropped for this signaling point.

Max Events Maximum number of events that the event history can contain. When event history 
table is full, the oldest entries are deleted as new entries are added.

Allowed Events ITP parameter that specifies the absolute maximum for the Max Events field. That 
is, for this node, the Max Events field can range from 0 to the value specified by 
the Allowed Events field.

Index Event number that the ITP assigns.

Message Message text for the event.
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Viewing MLR Details
The MLR Details tab displays the MLR counters, trigger configuration, and trigger results associated 
with the chosen signaling point.

To view the MLR Details section, in a view in the navigation tree, select an ITP signaling point, then 
click on the MLR Details tab in the content area.

Note This window polls your network periodically. To prevent unnecessary traffic on your network, close this 
window when you no longer need to refer to it.

The MLR Details tab displays these columns for the chosen signaling point:

Viewing MLR Counters

The MLR Counters table displays MLR counters associated with the chosen signaling point.

You can resize each column, or sort tables based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the MLR Counters table.

For detailed information on working in tables, see Navigating Table Columns, page 5-24.

Column Description

Reset Counters Opens the MWTM Reset Counters dialog box, which you use to change MWTM 
poller and counter settings. For more information, see Changing Real-Time Poller 
and Counter Settings, page 5-21.

Poll Counter 
Mode

Displays the current mode for poll counters, and the date and time that counters 
were last reset. Possible modes are:

• Since Reboot—Counters display values aggregated since the last reboot of the 
ITP, or since ITP last reset the counters.

• Since Last Poll—Counters display values aggregated since the last poll.

• Since User Reset—Counters display values aggregated since the last time the 
user reset them.

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first polling 
cycle, the MWTM populates this field with the actual time of the last poll.

MLR Counters Displays the MLR Counters table. For more information, see Viewing MLR 
Counters, page 8-130.

MLR Trigger 
Config

Displays the MLR Trigger Configuration table. For more information, see Viewing 
MLR Trigger Config, page 8-132.

MLR Trigger 
Results

Displays the MLR Trigger Results table. For more information, see Viewing MLR 
Trigger Results, page 8-136.
8-130
User Guide for the Cisco Mobile Wireless Transport Manager 6.1

OL-9118-01



 

Chapter 8      Understanding Detailed Object Functions
  Viewing Data Specific for ITP Signaling Points
The MLR Counters table displays these columns for the chosen signaling point:

Column Description

Processed: Routed Total number of packets routed by MLR, and the packet routing rate in 
packets per second.

Processed: MAP SMS-MO Number of MSUs of type GSM-MAP SMS-MO processed by MLR, and 
the GSM-MAP SMS-MO MSU processing rate in packets per second.

Processed: MAP SMS-MT Number of MSUs of type GSM-MAP SMS-MT processed by MLR, and 
the GSM-MAP SMS-MT MSU processing rate in packets per second.

Processed: MAP SRI-SM Number of MSUs of type GSM-MAP SRI-SM processed by MLR, and 
the GSM-MAP SRI-SM MSU processing rate in packets per second.

Processed: MAP AlertSc Number of MSUs of type GSM-MAP AlertSc processed by MLR, and 
the GSM-MAP AlertSc MSU processing rate in packets per second.

Processed: 
ANSI-41 SMD-PP

Number of MSUs of type ANSI-41 SMD-PP processed by MLR, and the 
ANSI-41 SMD-PP MSU processing rate in packets per second.

Processed: 
ANSI-41 SMS Requests

Number of MSUs of type ANSI-41 SMSRequest processed by MLR, 
and the ANSI-41 SMSRequest MSU processing rate in packets per 
second.

Processed: 
ANSI-41 SMS Notifys

Number of MSUs of type ANSI-41 SMSNotify processed by MLR, and 
the ANSI-41 SMSNotify MSU processing rate in packets per second.

Aborts: Total Aborted Total number of MSUs aborted by MLR, and the MSU abort rate in 
packets per second.

Aborts: No Resources Number of MSUs aborted by MLR because of a shortage of resources, 
and the No Resources MSU abort rate in packets per second.

Aborts: Results Blocked Number of MSUs aborted by MLR with a result of block, and the 
Results Blocked MSU abort rate in packets per second.

Aborts: GTI Mismatches Number of MSUs aborted by MLR because of mismatched GTIs, and 
the GTI Mismatches MSU abort rate in packets per second.

Aborts: Address Conversion 
Failures

Number of MSUs aborted by MLR because of a failed GTA address 
conversion, and the Address Conversion Failures MSU abort rate in 
packets per second.

Aborts: Destination 
Unavailables

Number of MSUs aborted by MLR because the destination was 
unavailable, and the Destination Unavailables MSU abort rate in packets 
per second.

Aborts: No Server Aborteds Number of MSUs aborted by MLR because no server was available, and 
the No Server Aborteds MSU abort rate in packets per second.

Continues: Total Continued Total number of MSUs returned to SCCP by MLR with a result of 
continue, and the MSU return rate in packets per second.

Continues: Failed Triggers Number of MSUs returned to SCCP by MLR because of no trigger 
match, and the Failed Triggers MSU return rate in packets per second.

Continues: 
Result Continueds

Number of MSUs returned to SCCP by MLR with a result of 
continue, and the Result Continueds MSU return rate in packets per 
second.

Continues: Result GTTs Number of MSUs returned to SCCP by MLR with a result of GTT, and 
the Result GTTs MSU return rate in packets per second.
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Viewing MLR Trigger Config

The MLR Trigger Config table displays the MLR trigger configuration associated with the chosen 
signaling point, divided into these subtables:

• Triggers, page 8-132

• SubTriggers, page 8-133

• Ruleset, page 8-134

• Rules, page 8-134

• Addresses, page 8-135

• Results, page 8-135

Triggers

The Triggers subtable displays MLR trigger information associated with the chosen signaling point.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Triggers subtable except Set Name, Start Date, End Date, 
and Status.

For detailed information on working in tables, see Navigating Table Columns, page 5-24.

The Triggers subtable displays these columns for the chosen signaling point:

Continues: Unsupported 
SCCP Msg Types

Number of MSUs returned to SCCP by MLR because of unsupported 
message types, and the Unsupported SCCP Msg Types MSU return rate 
in packets per second.

Continues: Unsupported 
Segmented SCCP Msgs

Number of MSUs returned to SCCP by MLR because of unsupported 
segments, and the Unsupported Segmented SCCP Msg MSU return rate 
in packets per second.

Continues: 
Unsupported Messages

Number of MSUs returned to SCCP by MLR because of parse failures, 
and the Unsupported Messages MSU return rate in packets per second.

Continues: Parse Errors Number of MSUs returned to SCCP by MLR because of parse errors, 
and the Parse Errors MSU return rate in packets per second.

Continues: No Results Number of MSUs returned to SCCP by MLR with no results, and the No 
Results MSU return rate in packets per second.

Continues: 
No Server Continueds

Number of MSUs returned to SCCP by MLR because no server was 
available, and the No Server Continueds MSU return rate in packets per 
second.

Column Description

Column Description

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the trigger.

Index Index number associated with the trigger.

SubTriggers Number of subtriggers associated with the chosen trigger.
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SubTriggers

The SubTriggers subtable displays MLR subtrigger information associated with the chosen signaling 
point and trigger.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the SubTriggers subtable.

For detailed information on working in tables, see Navigating Table Columns, page 5-24.

The SubTriggers subtable displays these columns for the chosen signaling point:

Start Date Date and time on which this trigger should begin filtering traffic.

If no Start Date is configured, this field displays N/A.

End Date Date and time on which this trigger should stop filtering traffic.

If no End Date is configured, this field displays N/A.

Status Current status of the trigger. Possible values are:

• Active—A corresponding GTT table entry for the trigger or, if this is an 
MTP3 trigger, an available route to the appropriate point code exists.

• Inactive—No corresponding GTT table entry or available route to the 
appropriate point code for the trigger. The trigger will never match and a 
configuration error is likely.

Action Action taken by the trigger.

Prematches Preliminary count of trigger matches.

Prematch Rate Number of Prematches per second for the trigger.

Matches Number of trigger matches with result Action Performed.

Match Rate Number of Matches per second for the trigger.

Parameters Parameters that control the behavior of the trigger.

Column Description

Column Description

Trigger
(in subtable heading)

Set name of the parent trigger with which the chosen subtrigger is associated.

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the subtrigger.

Index Index number associated with the subtrigger.

Action Action taken by the subtrigger.

Matches Number of subtrigger matches with result Action Performed.

Match Rate Number of Matches per second for the subtrigger.

Parameters Parameters that control the behavior of the subtrigger.
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Ruleset

The Ruleset subtable displays MLR ruleset information associated with the chosen signaling point and 
trigger or subtrigger.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Ruleset subtable except Start Date and End Date.

For detailed information on working in tables, see Navigating Table Columns, page 5-24.

The Ruleset subtable displays these columns for the chosen signaling point:

Rules

The Rules subtable displays MLR rules information associated with the chosen signaling point and 
ruleset.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Rules subtable except Set Name.

For detailed information on working in tables, see Navigating Table Columns, page 5-24.

The Rules subtable displays these columns for the chosen signaling point:

Column Description

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the ruleset.

Start Date Starting date and time for this ruleset to become active.

End Date Ending date and time for this ruleset to become active.

Segmented Indicates whether this ruleset should process segmented messages.

Protocol Default protocol for rules in this ruleset.

Search Type Search type that this ruleset should perform.

Column Description

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the rule.

Index Index number associated with the rule.

Operation Type Types of messages on which this rule matches.

Protocol Protocol used for matching by this rule.

Matches Number of rule matches with result Action Performed.

Match Rate Number of Matches per second for the rule.

Rule Parameters Parameters that control the behavior of the rule.

Result Parameters Parameters that control the behavior of the result associated with this rule.
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Addresses

The Addresses subtable displays MLR address information associated with the chosen signaling point 
and rule.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Addresses subtable except Set Name.

For detailed information on working in tables, see Navigating Table Columns, page 5-24.

The Addresses subtable displays these columns for the chosen signaling point:

Results

The Results subtable displays MLR results information associated with the chosen signaling point and 
rule or address.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Results subtable except Index.

For detailed information on working in tables, see Navigating Table Columns, page 5-24.

The Results subtable displays these columns for the chosen signaling point:

Column Description

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the address.

Address Type Type of address. The MWTM 6.1 supports these types of addresses:

• bch—Binary-coded hexadecimal

• gsmDa—Groupe Special Mobile (GSM) 7-bit default alphabet

Address Digits Address digits to be matched.

Exact Match Indicates whether an exact match to the Address Digits is required.

Matches Number of address matches with result Action Performed.

Match Rate Number of Matches per second for the address.

Result Parameters Parameters that control the behavior of the result associated with this 
address.

Column Description

Ruleset
(in subtable heading)

Ruleset associated with the results.

No Server Available 
Action
(in subtable heading)

Default behavior if no result is available. Possible actions are:

• Discard—Discard the packet without forwarding it.

• Resume—Return the unmodified packet to the higher level protocols for 
default routing.

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the results.
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Viewing MLR Trigger Results

The MLR Trigger Results table displays the MLR results associated with the chosen signaling point. You 
can use this subtable to determine which triggers, subtriggers, rules, and addresses are causing a 
particular result to execute.

The MLR Trigger Results table contains:

• Results, page 8-136

• Addresses, page 8-137

• Rules, page 8-137

• Ruleset, page 8-138

• SubTriggers, page 8-138

• Triggers, page 8-139

Results

The Results subtable displays all MLR results information associated with the chosen signaling point.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Results subtable except Index.

For detailed information on working in tables, see Navigating Table Columns, page 5-24.

The Results subtable displays these columns for the chosen signaling point:

Index Index number associated with the results.

Type Type of result. Possible values are:

• PC—Point code

• ASName—Application server name

Result Destination point code or name of the result.

Weight Weight for this result in its set of results.

Count Number of times this result is encountered.

Count Rate Number of times per second this result is encountered.

Column Description

Column Description

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the results.

Index Index number associated with the results.

Type Type of result. Possible values are:

• PC—Point code

• ASName—Application server name

Result Destination point code or name of the result.

Weight Weight for this result in its set of results.
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Addresses

The Addresses subtable displays MLR address information associated with the chosen result.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Addresses subtable except Set Name.

For detailed information on working in tables, see Navigating Table Columns, page 5-24.

The Addresses subtable displays these columns for the chosen signaling point:

Rules

The Rules subtable displays MLR rules information associated with the chosen result.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Rules subtable except Set Name.

For detailed information on working in tables, see Navigating Table Columns, page 5-24.

The Rules subtable displays these columns for the chosen signaling point:

Count Number of times this result is encountered.

Count Rate Number of times per second this result is encountered.

Column Description

Column Description

ResultSet
(in subtable heading)

Set of results associated with the addresses.

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the address.

Address Type Type of address. The MWTM 6.1 supports these types of addresses:

• bch—Binary-coded hexadecimal

• gsmDa—Groupe Special Mobile (GSM) 7-bit default alphabet

Address Digits Address digits to be matched.

Exact Match Indicates whether an exact match to the Address Digits is required.

Matches Number of address matches with result Action Performed.

Match Rate Number of Matches per second for the address.

Result Parameters Parameters that control the behavior of the result associated with this 
address.

Column Description

ResultSet
(in subtable heading)

Set of results associated with the rules.

Entries
(in subtable heading)

Total number of entries in the subtable.
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Ruleset

The Ruleset subtable displays MLR ruleset information associated with the chosen result.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Ruleset subtable except Start Date and End Date.

For detailed information on working in tables, see Navigating Table Columns, page 5-24.

The Ruleset subtable displays these columns for the chosen signaling point:

SubTriggers

The SubTriggers subtable displays MLR subtrigger information associated with the chosen result.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the SubTriggers subtable.

For detailed information on working in tables, see Navigating Table Columns, page 5-24.

Set Name Set name associated with the rule.

Index Index number associated with the rule.

Operation Type Types of messages on which this rule matches.

Protocol Protocol used for matching by this rule.

Matches Number of rule matches with result Action Performed.

Match Rate Number of Matches per second for the rule.

Rule Parameters Parameters that control the behavior of the rule.

Result Parameters Parameters that control the behavior of the result associated with this rule.

Column Description

Column Description

Rule Number
(in subtable heading)

Index number of the rule with which this ruleset is associated.

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the ruleset.

Start Date Starting date and time for this ruleset to become active.

End Date Ending date and time for this ruleset to become active.

Segmented Indicates whether this ruleset should process segmented messages.

Protocol Default protocol for rules in this ruleset.

Search Type Search type that this ruleset should perform.
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The SubTriggers subtable displays these columns for the chosen signaling point:

Triggers

The Triggers subtable displays MLR trigger information associated with the chosen result.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Triggers subtable except Set Name, Start Date, End Date, 
and Status.

For detailed information on working in tables, see Navigating Table Columns, page 5-24.

The Triggers subtable displays these columns for the chosen signaling point:

Column Description

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the subtrigger.

Index Index number associated with the subtrigger.

Action Action taken by the subtrigger.

Matches Number of subtrigger matches with result Action Performed.

Match Rate Number of Matches per second for the subtrigger.

Parameters Parameters that control the behavior of the subtrigger.

Column Description

Ruleset
(in subtable heading)

Ruleset with which this trigger is associated.

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the trigger.

Index Index number associated with the trigger.

SubTriggers Number of subtriggers associated with the chosen trigger.

Start Date Date and time on which this trigger should begin filtering traffic.

If no Start Date is configured, this field displays N/A.

End Date Date and time on which this trigger should stop filtering traffic.

If no End Date is configured, this field displays N/A.

Status Current status of the trigger. Possible values are:

• Active—Either there is a corresponding GTT table entry for the trigger 
or, if this is an MTP3 trigger, there is an available route to the 
appropriate point code.

• Inactive—There is no corresponding GTT table entry or available route 
to the appropriate point code for the trigger. The trigger will never match 
and a configuration error is likely.

Action Action that the trigger takes.
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Viewing RAN Shorthauls
To view RAN shorthauls that are associated with a RAN-O backhaul, select the backhaul object in the 
navigation tree in the left pane, and click the RAN Shorthauls tab in the right pane. The right pane 
displays a tabular list of RAN shorthauls that are associated with the chosen backhaul.

To view descriptions of the columns of the RAN shorthauls table, see RAN Shorthauls Table, page 6-27.

Creating Virtual RAN Backhauls
You use the MWTM to create a virtual RAN backhaul by grouping real backhauls. A virtual backhaul is 
useful if you have configured several RAN backhauls for the same interface. To view the utilization for 
that interface, create a virtual RAN backhaul that contains all the real backhauls that you have configured 
for the interface.

Note When creating virtual RAN backhauls, observe the following restrictions:

• You cannot add a real backhaul to more than one virtual backhaul.

• To add a real backhaul to a virtual backhaul, you must first enable report polling on the node that is 
associated with the real backhaul. If you add a real backhaul to a virtual backhaul, and then disable 
report polling on the associated node, historical reporting for the virtual backhaul will not work! To 
restore historical reporting for the virtual backhaul, you must enable report polling on the associated 
node or remove the real backhaul from the virtual backhaul. To enable report polling on a node, you 
must access the node by using its command line interface.

To create a virtual RAN backhaul, right-click a RAN backhaul, then choose Create Virtual RAN 
Backhaul. The MWTM displays the Virtual RAN Backhaul Editor.

The Virtual RAN Backhaul Editor contains:

Prematches Preliminary count of trigger matches.

Prematch Rate Number of Prematches per second for the trigger.

Matches Number of trigger matches with result Action Performed.

Match Rate Number of Matches per second for the trigger.

Parameters Parameters that control the behavior of the trigger.

Column Description

Field or Button Description

Name Name of the virtual RAN backhaul.

Available 
Backhauls

Pane that contains the Available Backhauls table, which contains these columns:

• Name—Name of the RAN backhaul

• Node—Node to which the RAN backhaul belongs
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To create a virtual RAN backhaul:

Step 1 Enable report polling on the nodes associated with the backhauls that you plan to add to the virtual 
backhaul.

Step 2 Right-click a backhaul in the RAN Backhauls table or in a view in the navigation tree.

Step 3 Choose Create Virtual RAN Backhaul in the right-click menu.

The Virtual RAN Backhaul Editor appears.

Step 4 In the Available Backhauls pane, choose a backhaul from the table.

Step 5 Click Add to add the chosen backhaul to the Included Backhauls table.

Step 6 Repeat Step 5 for each additional backhaul you want to include in the virtual backhaul.

Step 7 To remove a backhaul from the Included Backhauls table, choose a backhaul from the table and click 
Remove.

Step 8 In the Name field at the top of the dialog box, enter a name for the virtual backhaul.

Step 9 Click Save to create the virtual RAN backhaul and close the dialog box.

Included Backhauls Pane that contains the Included Backhauls table, which contains these columns:

• Name—Name of the RAN backhaul

• Node—Node to which the RAN backhaul belongs

Add Adds the chosen backhaul to the Included Backhauls table.

Remove Removes the chosen backhaul from the Included Backhauls table.

Save Saves the virtual RAN backhaul and closes the Virtual RAN Backhaul Editor.

Cancel Cancels the current operation and closes the Virtual RAN Backhaul Editor.

Help Opens the Help window for this feature.

Field or Button Description
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